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ΠΡΟΛΟΓΟ΢ 

 

 

Σα ηειεπηαία ρξφληα ην Internet (Γηαδίθηπν) αιιά θαη ε αξζξνγξαθία θαη ε 

βηβιηνγξαθία πνπ ην αθνξνχλ έρνπλ γίλεη κέξνο ηεο θαζεκεξηλήο δσήο καο. Πνιινί 

απφ εζάο ίζσο θαη λα έρεηε βαξεζεί λα αθνχηε γηα ππνινγηζηέο, e-mail, ειεθηξνληθφ 

εκπφξην, ζειίδεο web, newsgroups θαη Internet providers. 

Όζν φκσο θη αλ έρεηε θνπξαζηεί απφ ηε ζπλερή ζπδήηεζε γηα ην Internet θαη ηηο 

δπλαηφηεηεο ηνπ, ζηελ πξαγκαηηθφηεηα θαηαλνείηε πιήξσο ην ζφξπβν πνπ έρεη 

δεκηνπξγεζεί γχξσ απφ απηφ. Δμάιινπ ην Internet είλαη εθ ησλ πξαγκάησλ κνλαδηθφ, 

φληαο έλα ακθίδξνκν κέζν ππφ ηε κνξθή δηθηχνπ ππνινγηζηψλ πνπ δίλεη ηε 

δπλαηφηεηα ζε εθαηνκκχξηα αλζξψπνπο αλά ηνλ θφζκν λα επηθνηλσλνχλ ζε 

πξαγκαηηθφ ρξφλν. 
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Μέπορ Α’ 
 

1. ΔΙ΢ΑΓΩΓΗ 

 

1.1 Ιζηοπική Αναδπομή ζηο INTERNET 

 

Αο μεθηλήζνπκε αληίζηξνθα, κε αθεηεξία ην παξφλ, πξνθεηκέλνπ λα εθηηκήζνπκε 

ηελ ηξηαληάρξνλε πνξεία ηνπ κεγαιχηεξνπ δηθηχνπ επηθνηλσλίαο κέζσ ειεθηξνληθνχ 

ππνινγηζηή ζηνλ θφζκν. 

Όζνλ αθνξά θαηαξρήλ ηνλ αξηζκφ ησλ ρξεζηψλ ηνπ Γηαδηθηχνπ, νη πνιπάξηζκεο 

έξεπλεο ζρεηηθά κε ην ζπγθεθξηκέλν ζέκα παξνπζηάδνπλ ζρεδφλ πάληα αληηθξνπφκελα 

απνηειέζκαηα. Αιιά ε ζπληξηπηηθή πιεηνλφηεηα ησλ εξεπλεηψλ ζπγθιίλεη ζηελ άπνςε 

φηη ν αξηζκφο ησλ ρξεζηψλ ζα θηάζεη ηηο εθαηνληάδεο εθαηνκκπξίσλ ζηηο αξρέο ηνπ 

21νπ αηψλα. Ο ξπζκφο απηήο ηεο απμεηηθήο ηάζεο θηάλεη ην 10% ην κήλα, ελψ ην 

εκπνξηθφ θνκκάηη ηνπ Internet αλαπηχζζεηαη κε ξπζκνχο ηεο ηάμεο ηνπ 60% αλά 

ηξίκελν. 

Δίλαη πνιχ ελδηαθέξνλ ην γεγνλφο φηη θαη ζηε ρψξα καο, φπνπ ζέκαηα 

πιηθνηερληθήο ππνδνκήο θαη θφζηνπο θαζηζηνχλ ηελ πξφζβαζε ζην Internet αξθεηά 

δχζθνιε, νη ζρεηηθνί αξηζκνί παξνπζηάδνπλ παξφκνηεο ηάζεηο. Ο αξηζκφο ησλ Διιήλσλ 

πνπ έρνπλ πξφζβαζε ζην Γηαδίθηπν εθηηκάηαη ζηνπο 250 ρηιηάδεο (πεξίπνπ 2% ηνπ 

ζπλνιηθνχ πιεζπζκνχ). Παξά ην γεγνλφο φηη απηή ε αλαινγία κνηάδεη αξθεηά κηθξή, 

ραξαθηεξίδεηαη απφ ζπλερή απμεηηθή ηάζε. 

Ζ κέζε ειηθία ησλ Διιήλσλ ρξεζηψλ, 36 έηε, είλαη αξθεηά κηθξή ζε ζχγθξηζε κε 

απηή ησλ ρξεζηψλ άιισλ ρσξψλ, κε εμαίξεζε ηηο Ζλσκέλεο Πνιηηείεο, φπνπ ην 40% 

είλαη κεηαμχ 12 θαη 17 εηψλ. ΢ρεδφλ νη κηζνί απφ ην ζπλνιηθφ αξηζκφ ησλ Διιήλσλ 

ρξεζηψλ έρνπλ πξφζβαζε ζην Internet κέζσ ηεο ηδηφηεηαο ηνπο σο θνηηεηέο, εξεπλεηέο 

ή παλεπηζηεκηαθνί. Όπσο ζα δείηε ζηε ζπλέρεηα, ε ζρέζε ηνπ Γηαδηθηχνπ κε ηελ 

παλεπηζηεκηαθή θνηλφηεηα ππήξμε αλέθαζελ ηζρπξή, απφ ηα πξψηα θηφιαο ρξφληα ηεο 

ιεηηνπξγίαο ηνπ. Δηδηθφηεξα φζνλ αθνξά ηελ ειιεληθή πξαγκαηηθφηεηα, ηα 

παλεπηζηεκηαθά ηδξχκαηα ή θαη εξεπλεηηθά θέληξα παξέρνπλ ζην ρξήζηε ηε 

δπλαηφηεηα δσξεάλ πξφζβαζεο κέζσ κεραλεκάησλ πνπ αλαβαζκίδνληαη ζρεηηθά 

ζπρλά, ζε επίπεδν ηφζν hardware φζν θαη software. Tν γεγνλφο απηφ δηθαηνινγεί ην 

αμηνζεκείσην πνζνζηφ ησλ ρξεζηψλ πνπ έρνπλ θάπνηα ζρέζε κε ηελ παλεπηζηεκηαθή 
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θνηλφηεηα, αλ ιεθζεί ππφςε θαη ην φηη, ζχκθσλα κε ζηνηρεία ηνπ πεξηνδηθνχ «Forbes», 

ε Διιάδα είλαη ε ηέηαξηε πην αθξηβή ρψξα φζνλ αθνξά ην θφζηνο ζχλδεζεο. 

Όζνλ αθνξά ηηο ειιεληθέο εηαηξείεο πνπ παξέρνπλ ππεξεζίεο ζχλδεζεο (Internet 

service providers), απηή ηε ζηηγκή ιεηηνπξγνχλ 14, ελψ ην 80% ησλ ρξεζηψλ έρεη 

πξφζβαζε κέζσ ησλ ηξηψλ πξψησλ (FORTHnet, OTEnet θαη Hellas On Line ή HOL). 

΢χκθσλα κε ηελ εηήζηα έξεπλα ηνπ NETLetter γηα ην 2005 ζρεηηθά κε ην ειιεληθφ 

domain (.gr domain survey), o αξηζκφο ησλ κνλαδηθψλ δηεπζχλζεσλ IP (IP addresses) 

αλέξρεηαη ζηηο 194.210, ζε ζρέζε κε ηηο 160.411 πνπ πξνέθπςαλ απφ ηελ αληίζηνηρε 

έξεπλα ηνπ 2003. 

Χο εθ ηνχηνπ, αληηιακβάλεηαη θαλείο φηη ην Internet είλαη επί ηνπ παξφληνο κία απφ 

ηηο ηαρχηεξα αλαπηπζζφκελεο αγνξέο ζηελ Διιάδα. ΢εκεησηένλ, δε, φηη κέρξη ην ηέινο 

ηνπ 2008 αλακέλεηαη φηη ν αξηζκφο ησλ ρξεζηψλ ζα θηάζεη ηνπο 405.000. 

Ζ πηζαλφηεηα εμάπισζεο ηνπ Γηαδηθηχνπ ζε κηα ρψξα πνπ νξηνζεηεί ηα λνηηφηεξα 

ζχλνξα ηεο επξσπατθήο επείξνπ κάιινλ έκνηαδε κε ζελάξην επηζηεκνληθήο θαληαζίαο 

ζαξάληα ρξφληα πξηλ. Σφηε, ην 1969, ην Internet έθαλε ηα πξψηα ηνπ βήκαηα ζηηο 

Ζλσκέλεο Πνιηηείεο, ζην πιαίζην κηαο εθ δηακέηξνπ αληίζεηεο ινγηθήο απφ απηή πνπ 

ην ραξαθηεξίδεη ζηηο κέξεο καο. Αξθεί λα ζθεθηείηε φηη ηέζζεξα ρξφληα κεηά, ην 1973, 

ππήξραλ κφλν 25 ππνινγηζηέο ζην Γηαδίθηπν, ζε ζρέζε κε ηα 44.000 δίθηπα 

ππνινγηζηψλ πνπ απνηεινχζαλ ην Internet ζηα κέζα ηεο δεθαεηίαο ηνπ '90. 

Ζ ζχιιεςε ηεο ηδέαο ελφο δηθηχνπ επηθνηλσλίαο πνπ ζα επέηξεπε ηε κεηαθνξά 

δεδνκέλσλ κέζσ ειεθηξνληθψλ ππνινγηζηψλ εληνπίδεηαη ζηα ηέιε ηεο δεθαεηίαο ηνπ 

'50 ζηηο Ζλσκέλεο Πνιηηείεο. Σν 1957 ε εθηφμεπζε ηνπ πξψηνπ ηερλεηνχ δνξπθφξνπ 

Sputnik ζην δηάζηεκα απφ ηελ ηφηε Δ΢΢Γ άλνηγε ηηο πχιεο ηνπ δηαζηήκαηνο θαη 

ζεκαηνδνηνχζε ηελ αξρή κηαο πεξηπεηεηψδνπο, αληαγσληζηηθήο θνχξζαο γηα ηελ 

θαηάθηεζε ηνπ δηαζηήκαηνο κεηαμχ ησλ δχν ππεξδπλάκεσλ. Σαπηφρξνλα φκσο 

ελέηεηλε ην ιεγφκελν Φπρξφ Πφιεκν θαη νδήγεζε ζε ζεηξά ηερλνινγηθψλ επηηεπγκάησλ 

πνπ άιιαμαλ ηελ πνξεία ηεο αλζξψπηλεο ηζηνξίαο. Ζ εθηφμεπζε ηνπ Sputnik 

πξαγκαηνπνηήζεθε κέζσ βαιιηζηηθνχ δηεπεηξσηηθνχ ππξαχινπ, πνπ ζρεδηάζηεθε 

εηδηθά γηα ην ζπγθεθξηκέλν ζθνπφ θαη απνηέιεζε ζαχκα ηεο ππξαπινηερληθήο γηα ηα 

δεδνκέλα ηεο επνρήο. Ζ πξφνδνο ησλ ΢νβηεηηθψλ ζην ζπγθεθξηκέλν ηνκέα ζνξχβεζε 

ην Τπνπξγείν Δζληθήο Ακχλεο ησλ ΖΠΑ. Αο κελ μερλάκε φηη θαηά ηε ζπγθεθξηκέλε 

πεξίνδν νη ιανί θαη νη θπβεξλήζεηο θαη ησλ δχν ρσξψλ δνχζαλ θάησ απφ ην κφληκν 

θφβν κηαο πηζαλήο επίζεζεο πξνεξρφκελεο απφ ηελ «άιιε πιεπξά» - επίζεζε πνπ 
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αδηακθηζβήηεηα, ζχκθσλα κε ηελ ηφηε επηθξαηνχζα άπνςε, ζα νδεγνχζε ζε ππξεληθή 

θαηαζηξνθή. 

Σφηε ζπλειήθζε θαη ε ηδέα ελφο επηθνηλσληαθνχ ζπζηήκαηνο κέζσ ειεθηξνληθνχ 

ππνινγηζηή, πνπ ζε πεξίπησζε ππξεληθήο θαηαζηξνθήο ζα επέηξεπε ηε κεηαθνξά 

δεδνκέλσλ ζε παθέηα κέζα απφ ελαιιαθηηθά «δξνκνιφγηα» (εάλ θάπνην ζεκείν ηνπ 

δηθηχνπ θαηαζηξεθφηαλ). ΢ε νπνηνδήπνηε ζεκείν ηνπ δηθηχνπ ηα παθέηα ζα 

κπνξνχζαλ λα ζπλελσζνχλ θαη ην ζχλνιν ησλ πιεξνθνξηψλ λα αλαθηεζεί απφ ηνλ 

ηειηθφ παξαιήπηε. 

Σν πξψην δίθηπν ηέηνηνπ είδνπο, ην ARPANET, ηέζεθε ζε εθαξκνγή ην 1969. 

Αξρηθά ήηαλ αλνηθηφ κφλν ζε εξεπλεηηθά θέληξα πνπ ζπλεξγάδνληαλ κε ην Τπνπξγείν 

Δζληθήο Ακχλεο, φκσο ε επηζηεκνληθή θνηλφηεηα αληηιήθζεθε γξήγνξα ηηο 

δπλαηφηεηεο ηνπ θαη ε ρξήζε ηνπ επεθηάζεθε ζε φινπο ηνπο ηνκείο αληαιιαγήο 

δεδνκέλσλ (απφ επηζηεκνληθή γλψζε κέρξη απιή θνπβεληνχια – chat). 

΢ηαδηαθά επηζηήκνλεο φισλ ησλ εηδηθνηήησλ απέθηεζαλ πξφζβαζε ζην δίθηπν, 

έηζη απηφ ην 1983 δηαρσξίζηεθε ζε ARPANET (ιεηηνπξγνχζε γηα θαζαξά 

επηζηεκνληθνχο ζθνπνχο) θαη MILNET (γηα ζθνπνχο πνπ ζρεηίδνληαλ άκεζα κε 

ζηξαηησηηθέο εθαξκνγέο). ΢χληνκα δεκηνπξγήζεθαλ άιια δχν δίθηπα γηα 

επηζηεκνληθνχο ζθνπνχο, ηα CSNET θαη ΒΗΣΝΔΣ. Καη' απηφ ηνλ ηξφπν δηακνξθψζεθε 

έλα δίθηπν δηθηχσλ, ην ARPA-INTERNET, πνπ αξγφηεξα κεηνλνκάζηεθε ζε 

INTERNET. 

Οη δπλαηφηεηεο ηνπ Γηαδηθηχνπ απμήζεθαλ θαη βειηηψζεθαλ ζηαδηαθά κε ηε 

δεκηνπξγία ηνπ UNIX (1969), ηελ ελζσκάησζε ζε απηφ ηνπ πξσηνθφιινπ TCP / IP 

(1983), ηελ εθεχξεζε ηνπ modem (1978), ηε δεκηνπξγία ηνπ Usenet (1979), θ.ά. 

΢ε απηφ ην ζεκείν ζα πξέπεη ιίγν λα ζηαζνχκε ζηελ εηξσλεία πνπ ζπλνδεχεη ην 

Internet θαη ηε θηινζνθία ηνπ ήδε απφ ηε γέλεζε ηνπ. Όπσο πξναλαθέξζεθε, ε 

πξσηαξρηθή ινγηθή δεκηνπξγίαο ελφο computer - based δηθηχνπ επηθνηλσλίαο ήηαλ 

κάιινλ ε πξφζεζε «ηηζάζεπζεο» ηεο πιεξνθνξίαο παξά ειεχζεξεο δηαθίλεζεο ηεο. 

Δμάιινπ ην ARPANET, ν πξφγνλνο ηνπ Internet, επηλνήζεθε θαη εθαξκφζηεθε απφ ην 

Τπνπξγείν Δζληθήο Ακχλεο ησλ ΖΠΑ ζην πιαίζην κηαο ζηξαηνθξαηηθήο ινγηθήο θαη 

ζε κηα ρξνληθή πεξίνδν φπνπ ν Φπρξφο Πφιεκνο κεηαμχ ησλ δχν ππεξδπλάκεσλ 

νινέλα εληεηλφηαλ κέζσ ησλ ηερλνινγηθψλ επηηεπγκάησλ θάζε πιεπξάο. 

Παξάιιεια φκσο νη ρξήζηεο ηνπ ARPANET - αξθεηνί εθ ησλ νπνίσλ, φληαο αθφκε 

θνηηεηέο, εθεχξαλ θαη αλέπηπμαλ πνιιέο απφ ηηο παξακέηξνπο ηνπ ζε επίπεδν software 

θαη hardware - αλαγλψξηζαλ ζε απηφ κηα κνλαδηθή επθαηξία ειεχζεξεο αληαιιαγήο 
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ηδεψλ θαη πιεξνθνξηψλ. Μέζσ ελφο δηθηχνπ επηθνηλσλίαο πνπ δεκηνπξγήζεθε απφ 

θπβεξλεηηθνχο παξάγνληεο γηα ζηξαηησηηθνχο ζθνπνχο εθθξάζηεθαλ νπζηαζηηθά 

βαζηθέο ζέζεηο ησλ θηλεκάησλ ηεο δεθαεηίαο ηνπ '60, πνπ ζρεηίδνληαλ άκεζα κε ην 

θηιειεπζεξηζκφ θαη ηηο αληηιήςεηο πεξί «νπηνπηθήο θνηλσλίαο». Αθφκε θαη ζηηο κέξεο 

καο θαη παξά ηηο αιιεπάιιειεο πξνζπάζεηεο γηα ινγνθξηζία ή πεξηνξηζκφ ηνπ 

Γηαδηθηχνπ, παξακέλεη ην κφλν κέζν επηθνηλσλίαο φπνπ ν θαζέλαο κπνξεί λα εθθξάζεη 

ειεχζεξα ηηο απφςεηο ηνπ θαη λα αληηδξάζεη άκεζα ζηηο πιεξνθνξίεο πνπ δέρεηαη. 

΢ηηο αξρέο ηεο δεθαεηίαο ηνπ '90 ν επηρεηξεκαηηθφο θφζκνο είρε ήδε 

ζπλεηδεηνπνηήζεη ηε δπλακηθή ηνπ Internet σο εκπνξηθνχ εξγαιείνπ. Δίλαη 

ραξαθηεξηζηηθφ φηη, ελψ ην 1991 ππήξραλ πεξίπνπ 9.000 εκπνξηθά domains (ή 

ππνδίθηπα), ην 1994 είραλ απμεζεί ζε 21.700. 

Παξάιιεια δεκηνπξγήζεθε ν world wide web (WWW - «παγθφζκηνο ηζηφο»), έλα 

δίθηπν δηθηχσλ κέζα ζην Internet, θαζψο θαη ηα πξψηα εξγαιεία αλαδήηεζεο, πνπ 

ζαθέζηαηα δηεπθφιπλαλ ηελ επηθνηλσλία κεηαμχ επηρεηξήζεσλ, νξγαληζκψλ θαη 

αηφκσλ. Αθξηβψο απηή ε ζπλχπαξμε δηαθνξεηηθψλ πνιηηηζκηθψλ πξαγκαηηθνηήησλ θαη 

κνξθψλ νξγάλσζεο πξνζδίδεη ζην Internet ηε κνλαδηθή ηνπ ηαπηφηεηα. Παξάιιεια 

φκσο απνηειεί ηε κεγάιε πξφθιεζε γηα φζνπο επηζπκνχλ λα δξαζηεξηνπνηεζνχλ 

εκπνξηθά ζε απηφ. Όπσο ραξαθηεξηζηηθά ζρνιηάδεη ν Castells: «ε εκπνξνπνίεζε ηνπ 

θπβεξλνρψξνπ ζα είλαη πιεζηέζηεξε ηεο ηζηνξηθήο εκπεηξίαο ησλ εκπνξηθψλ δξφκσλ, 

πνπ μεπεδνχλ κέζα απφ κηα νινδψληαλε αζηηθή θνπιηνχξα, παξά ησλ εκπνξηθψλ 

θέληξσλ, πνπ εθηείλνληαη ζε αληαξά, αλψλπκα πξνάζηηα». Μηα λέα κνξθή εκπνξίνπ, ην 

ειεθηξνληθφ, απαζρνιεί φιν θαη πεξηζζφηεξνπο επηζηήκνλεο αιιά θαη δηνξαηηθνχο 

επηρεηξεκαηίεο πνπ δηαβιέπνπλ ηελ πξννπηηθή ηνπ. Σν θχξην ραξαθηεξηζηηθφ ηνπ δελ 

είλαη άιιν παξά αθξηβψο απηφο ν επηθνηλσληαθφο ραξαθηήξαο ηνπ: ε δηαδξαζηηθφηεηα, 

πνπ ζηε ζπγθεθξηκέλε πεξίπησζε παξαπέκπεη ζε ζνξπβψδε, πνιπζχρλαζην εκπνξηθφ 

δξφκν. 
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2.ΗΛΔΚΣΡΟΝΙΚΟ ΔΜΠΟΡΙΟ 

 

Χο ειεθηξνληθφ εκπφξην (e-commerce) ζα κπνξνχζακε λα νξίζνπκε: «έλα ζχλνιν 

επηρεηξεκαηηθψλ ζηξαηεγηθψλ πνπ κπνξνχλ λα ππνζηεξίμνπλ ζπγθεθξηκέλνπο ηνκείο 

επηρεηξεκαηηθήο δξαζηεξηφηεηαο θαη ζπγθεθξηκέλεο επηρεηξεκαηηθέο πξαθηηθέο, νη 

νπνίεο επηηξέπνπλ, κέζσ ηεο ρξήζεο λέσλ ηερλνινγηψλ, ηε δηεθπεξαίσζε εκπνξηθψλ 

δηαδηθαζηψλ κε ειεθηξνληθά κέζα. Σν εχξνο απηψλ ησλ ειεθηξνληθψλ εκπνξηθψλ 

δηαδηθαζηψλ είλαη αληίζηνηρν κε εθείλν ησλ αλαινγηθψλ θαη αθνξά πιήζνο 

δξαζηεξηνηήησλ (εκπνξία αγαζψλ θαη ππεξεζηψλ, αγνξαπσιεζία κεηνρψλ, 

πξαγκαηνπνίεζε δεκνπξαζηψλ, θ.ά.). 

 

 

2.1 ΒΑ΢ΙΚΔ΢ ΑΡΥΔ΢ 

 

Ζ αλάγθε γηα Ζιεθηξνληθφ Δκπφξην πξνθχπηεη απφ ηελ απαίηεζε ησλ 

επηρεηξήζεσλ θαη ησλ θπβεξλήζεσλ γηα θαιχηεξε ρξήζε ηεο ηερλνινγίαο ησλ 

ππνινγηζηψλ θαη ησλ ηειεπηθνηλσληψλ ψζηε λα βειηησζνχλ νη ζρέζεηο ακθίδξνκεο 

επηθνηλσλίαο κε ηνπο πειάηεο/πνιίηεο/θαηαλαισηέο, νη επηρεηξεκαηηθέο δηεξγαζίεο θαη 

ε αληαιιαγή πιεξνθνξηψλ ελδνεπηρεηξεζηαθά, αιιά θαη θπξίσο κεηαμχ ησλ 

επηρεηξήζεσλ. Πάλησο ε νπζηαζηηθή επηδίσμε θάζε επηρείξεζεο ζηνλ έληνλα 

αληαγσληζηηθφ επηρεηξεκαηηθφ ζηίβν ηεο επνρήο καο είλαη ε εμαζθάιηζε ζηξαηεγηθνχ 

πιενλεθηήκαηνο. Ζ ηερλνινγία θαη εηδηθφηεξα ην Ζιεθηξνληθφ Δκπφξην παξέρεη 

επέιηθηεο θαη νινθιεξσκέλεο ιχζεηο ηνπνζέηεζεο ησλ επηρεηξήζεσλ ζηηο επηζπκεηέο 

αγνξέο (target markets) παξεκβαίλνληαο επεξγεηηθά ζε θάζε ζηάδην ηεο αιπζίδαο αμίαο 

ηνπο (value chain). 

Έλαο απιφο νξηζκφο γηα ην Ζιεθηξνληθφ Δκπφξην είλαη φηη «απνηειεί θάζε κνξθή 

επηρεηξεκαηηθήο ζπλαιιαγήο θαη επηθνηλσλίαο πνπ γίλεηαη κε ειεθηξνληθά κέζα». 

Έλαο ηέηνηνο απιντθφο νξηζκφο φκσο, παξφιν πνπ ηερληθά κπνξεί λα είλαη αθξηβήο, δελ 

κπνξεί λα ζπιιάβεη ην βαζηθφ πλεχκα ηνπ Ζιεθηξνληθνχ Δκπνξίνπ πνπ δελ είλαη 

απιψο ε ρξήζε ειεθηξνληθψλ κέζσλ γηα επηθνηλσλία, αιιά νη δπλαηφηεηεο γηα 

επαλαθαζνξηζκφ ηνπ ηξφπνπ κε ηνλ νπνίν γίλεηαη ην εκπφξην, ν νπνίνο γίλεηαη γηα 

πξψηε θνξά εθηθηφο κε ηε ρξήζε λέσλ ηερλνινγηψλ απφ ηηο ζχγρξνλεο επηρεηξήζεηο. 
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Έηζη, ην Ζιεθηξνληθφ Δκπφξην ζα κπνξνχζε λα νξηζηεί σο έλα ζχλνιν 

επηρεηξεκαηηθψλ ζηξαηεγηθψλ πνπ κπνξνχλ λα ππνζηεξίμνπλ ζπγθεθξηκέλνπο ηνκείο 

επηρεηξεκαηηθήο δξαζηεξηφηεηαο θαη ζπγθεθξηκέλεο επηρεηξεκαηηθέο πξαθηηθέο νη 

νπνίεο επηηξέπνπλ, κέζσ ηεο ρξήζεο λέσλ ηερλνινγηψλ, ηε δηεθπεξαίσζε εκπνξηθψλ 

δηαδηθαζηψλ κε ειεθηξνληθά κέζα. 

Σν Ζιεθηξνληθφ Δκπφξην πξνζθέξεη ηε δπλαηφηεηα εθηέιεζεο πξάμεσλ γηα ηελ 

αληαιιαγή πξντφλησλ ή ππεξεζηψλ κεηαμχ δχν ή πεξηζζφηεξσλ κεξψλ κε ρξήζε 

ειεθηξνληθψλ ππνινγηζηψλ θαη δηθηχσλ ππνινγηζηψλ. Βαζίδεηαη ζηελ ειεθηξνληθή 

επεμεξγαζία θαη κεηάδνζε δεδνκέλσλ, ήρνπ θαη εηθφλσλ βίληεν. Ζ έλλνηα ηνπ 

Ζιεθηξνληθνχ Δκπνξίνπ πεξηιακβάλεη πνιιέο δηαθνξεηηθέο δξαζηεξηφηεηεο φπσο: 

 

> ειεθηξνληθή εκπνξία αγαζψλ θαη ππεξεζηψλ, 

> παξάδνζε ςεθηαθνχ πεξηερνκέλνπ (άυισλ αγαζψλ), 

> ειεθηξνληθή αγνξαπσιεζία κεηνρψλ, 

> ειεθηξνληθή έθδνζε θνξησηηθψλ, 

> εκπνξηθέο δεκνπξαζίεο, 

> ζπιινγηθέο εξγαζίεο ζρεδίαζεο θαη ηερληθψλ κειεηψλ, 

> ελεκέξσζε απφ πεγέο ζε απεπζείαο ζχλδεζε, 

> θξαηηθέο πξνκήζεηεο, 

> πσιήζεηο απεπζείαο ζηνλ θαηαλαισηή θαη κεηαγνξαζηηθή εμππεξέηεζε. 

Οη εθαξκνγέο ειεθηξνληθνχ εκπνξίνπ αθνξνχλ ηφζν πξντφληα (π.ρ. θαηαλαισηηθά 

αγαζά) φζν θαη ππεξεζίεο (π.ρ. ππεξεζίεο πιεξνθφξεζεο, ρξεκαηνπηζησηηθέο θαη 

λνκηθέο ππεξεζίεο), παξαδνζηαθέο δξαζηεξηφηεηεο (π.ρ. ηαηξηθή πεξίζαιςε, 

εθπαίδεπζε) θαη λέεο δξαζηεξηφηεηεο (π.ρ. εηθνληθά πνιπθαηαζηήκαηα). 

Οη ηερλνινγίεο πνπ ρξεζηκνπνηνχληαη γηα ηηο εθαξκνγέο ηνπ ειεθηξνληθνχ εκπνξίνπ 

ζπκπεξηιακβάλνπλ φιεο ηηο κνξθέο ειεθηξνληθψλ κελπκάησλ, ειεθηξνληθήο  

αληαιιαγήο  δεδνκέλσλ (Electronic Data Interchange, EDI), ειεθηξνληθήο κεηαθνξάο 

θεθαιαίσλ (Electronic Funds Transfer, EFT), ειεθηξνληθνχ ηαρπδξνκείνπ (Electronic 

Mail, E-mail), ειεθηξνληθψλ θαηαιφγσλ, ππεξεζηψλ ειεθηξνληθνχ πίλαθα 

αλαθνηλψζεσλ (Bulletin Board Services - BBS), θνηλψλ βάζεσλ δεδνκέλσλ θαη 

νδεγψλ, ζπζηεκάησλ ζπλερηδφκελεο αγνξάο θαη ππνζηήξημεο γηα φιν ηνλ θχθιν δσήο 

ησλ πξντφλησλ, ειεθηξνληθψλ εηδήζεσλ θαη ππεξεζηψλ πιεξνθφξεζεο, ειεθηξνληθήο 
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κηζζνδνζίαο, ειεθηξνληθψλ εληχπσλ, πξφζβαζεο ζε απεπζείαο ζχλδεζε ζε ππεξεζίεο 

κέζσ ηνπ Internet, θαζψο θαη θάζε άιιε κνξθή ειεθηξνληθήο κεηάδνζεο δεδνκέλσλ 

γηα εκπνξηθνχο ζθνπνχο. 

 

Πίλαθαο 1.1: Σχπνη δξαζηεξηνηήησλ Ζ.Δ. 

Σν Ζιεθηξνληθφ Δκπφξην φπσο παξνπζηάδεηαη ζπλνπηηθά ζηνλ πίλαθα 1.1. 

θαιχπηεη θπξίσο δχν ηχπνπο δξαζηεξηνηήησλ: ην Έκκεζν Ζιεθηξνληθφ 

Δκπφξην (ειεθηξνληθή παξαγγειία πιηθψλ αγαζψλ ηα νπνία εμαθνινπζνχλ λα 

παξαδίδνληαη κε παξαδνζηαθνχο ηξφπνπο φπσο ηαρπδξνκηθά ή κέζσ ηδησηηθψλ 

ππεξεζηψλ δηαλνκήο) θαη ην Άκεζν Ζιεθηξνληθφ Δκπφξην (ηειεκαηηθή 

παξαγγειία, πιεξσκή θαη παξάδνζε άυισλ αγαζψλ θαη ππεξεζηψλ, φπσο 

ινγηζκηθφ ππνινγηζηψλ, ςπραγσγηθφ πεξηερφκελν ή ππεξεζίεο πιεξνθφξεζεο 

ζε παγθφζκηα θιίκαθα). 

Σφζν ην άκεζν φζν θαη ην έκκεζν Ζιεθηξνληθφ Δκπφξην πξνζθέξνπλ 

ζπγθεθξηκέλεο δπλαηφηεηεο φπσο παξνπζηάδνληαη ζπλνπηηθά ζηνλ πίλαθα 1.1. Οη 

εηαηξείεο ζπλήζσο θάλνπλ ρξήζε θαη ησλ δχν ηχπσλ δξαζηεξηνηήησλ Ζιεθηξνληθνχ 

Δκπνξίνπ, (π.ρ. πνπιψληαο ινγηζκηθφ ζε απεπζείαο ζχλδεζε, θαζψο θαη κε ηνλ 

θιαζζηθφ ηξφπν πψιεζεο "απφ ην ξάθη"). Σν έκκεζν Ζιεθηξνληθφ Δκπφξην φκσο 

εμαξηάηαη απφ νξηζκέλνπο εμσηεξηθνχο παξάγνληεο, φπσο απφ ηελ 

απνηειεζκαηηθφηεηα ηνπ ζπζηήκαηνο κεηαθνξψλ. Σν άκεζν Ζιεθηξνληθφ Δκπφξην 

Έμμεζο Η. Δ. Άμεζο Η. Δ. 

■ Ζιεθηξνληθή παξαγγειία 

πξντφλησλ. 

■ Ζιεθηξνληθή παξαγγειία  

πξντφλησλ. 

■     Σα Αγαζά παξαδίδνληαη κε 

παξαδνζηαθνχο ηξφπνπο (π.ρ.  

ηαρπδξνκείν, ηδησηηθέο 

ππεξεζίεο  δηαλνκήο). 

■  Πιεξσκή θαη παξάδνζε 

άυισλ  αγαζψλ θαη ππεξεζηψλ 

(π.ρ. ινγηζκηθφ, ςπραγσγηθφ 

πεξηερφκελν). 

■   Δμαξηάηαη απφ εμσηεξηθνχο  

παξάγνληεο (π.ρ. 

απνηειεζκαηηθφηεηα  

ζπζηήκαηνο κεηαθνξψλ). 

■  Τπνζηήξημε ειεθηξνληθψλ 

εκπνξηθψλ ζπλαιιαγψλ ζε 

παγθφζκην επίπεδν. 
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παξέρεη δπλαηφηεηα πξαγκαηνπνίεζεο απξφζθνπησλ ειεθηξνληθψλ ζπλαιιαγψλ 

απφ άθξε ζε άθξε, πέξα απφ γεσγξαθηθά ζχλνξα θαη κε ηνλ ηξφπν απηφ, 

εθκεηαιιεχεηαη φιεο ηηο τ δπλαηφηεηεο ησλ παγθφζκησλ ειεθηξνληθψλ αγνξψλ. 

2.2 Ιζηοπική Αναδπομή ζηο Ηλεκηπονικό Δμπόπιο. 

 

Ζ εκθάληζε θαηά ηε δεθαεηία ηνπ 1970 ηεο Ζιεθηξνληθήο Μεηαθνξάο Κεθαιαίσλ 

(EFT) κεηαμχ ηξαπεδψλ, κέζσ αζθαιψλ ηδησηηθψλ δηθηχσλ, άιιαμε ηελ εηθφλα ησλ 

ρξεκαηνπηζησηηθψλ αγνξψλ. Ζ Ζιεθηξνληθή Μεηαθνξά Κεθαιαίσλ βειηηψλεη ηηο 

ειεθηξνληθέο πιεξσκέο κε ηελ απνζηνιή πιεξνθνξηψλ κε ειεθηξνληθά κέζα. ΢ήκεξα, 

ππάξρνπλ πνιιέο παξαιιαγέο ηεο EFT, κεηαμχ ησλ νπνίσλ νη ζπλεζέζηεξεο είλαη νη 

ρξεσζηηθέο θάξηεο θαη νη άκεζεο θαηαζέζεηο ζηνπο ηξαπεδηθνχο ινγαξηαζκνχο ησλ 

εξγαδνκέλσλ. Κάζε κέξα πεξίπνπ 4 ηξηο. δνιάξηα αιιάδνπλ ρέξηα κε EFT κέζσ 

δηθηχσλ πνπ ζπλδένπλ ηξάπεδεο, απηνκαηνπνηεκέλα γξαθεία ζπκςεθηζκνχ θαη 

επηρεηξήζεηο. Σν ππνπξγείν Οηθνλνκηθψλ ησλ ΖΠΑ εθηηκά φηη ην 1995 ην 55% ηνπ 

ζπλφινπ ησλ πιεξσκψλ ηεο νκνζπνλδηαθήο θπβέξλεζεο πξαγκαηνπνηήζεθε κε EFT. 

΢ηηο αξρέο ηεο δεθαεηίαο ηνπ 1980, ην Ζιεθηξνληθφ Δκπφξην δηαδφζεθε κεηαμχ  

ησλ επηρεηξήζεσλ αξρηθά σο ηερλνινγία ειεθηξνληθήο κεηάδνζεο κελπκάησλ: 

Ζιεθηξνληθή Αληαιιαγή Γεδνκέλσλ (EDI) θαη Ζιεθηξνληθφ Σαρπδξνκείν (Δ-mail). 

Με ηηο ηερλνινγίεο ηεο Ζιεθηξνληθήο Αληαιιαγήο Γεδνκέλσλ εθζπγρξνλίζηεθαλ νη 

δηαδηθαζίεο ησλ επηρεηξήζεσλ θαζφζνλ κεηψζεθαλ ηα έγγξαθα ζε ραξηί θαη απμήζεθε 

ε απηνκαηνπνίεζε. Οη ηερλνινγίεο EDI εμειίρζεθαλ ζε αλαπφζπαζην ηκήκα ηεο ξνήο 

ηεο εξγαζίαο ή ησλ ζπλεξγαδφκελσλ ζπζηεκάησλ ππνινγηζηψλ, ζπλδπάδνληαο 

ππάξρνπζεο κε ειεθηξνληθέο κεζφδνπο κε ειεθηξνληθά κέζα γηα ηε βειηίσζε ηεο 

απνηειεζκαηηθφηεηαο ησλ επηρεηξεκαηηθψλ δηαδηθαζηψλ. Ζ Ζιεθηξνληθή Αληαιιαγή 

Γεδνκέλσλ επηηξέπεη ζηηο επηρεηξήζεηο λα ζηέιλνπλ θαη λα ιακβάλνπλ έγγξαθα 

εξγαζίαο (φπσο παξαγγειίεο αγνξψλ) ζε ηππνπνηεκέλε ειεθηξνληθή κνξθή κε ηελ 

ειάρηζηε δπλαηή αλζξψπηλε παξέκβαζε. 

Με ηελ πάξνδν ησλ εηψλ, ε ειεθηξνληθή αληαιιαγή δεδνκέλσλ εληάρζεθε ζηα 

εζσηεξηθά ζπζηήκαηα πιεξνθνξηψλ θαη ζηηο θαζεκεξηλέο πξαθηηθέο ησλ επηρεηξήζεσλ 

θαη απνδείρζεθε ηδηαίηεξα επηηπρήο ζε νξηζκέλνπο ηνκείο, φπσο ζηελ δηαρείξηζε 
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θαηεγνξηψλ πξντφλησλ (category management) γηα είδε παληνπσιείνπ ζην ιηαληθφ 

εκπφξην. 

Ζ εμέιημε ηνπ δηαδηθηχνπ (Internet) ζηα ηέιε ηεο δεθαεηίαο ηνπ 1980 έδσζε ηε 

δπλαηφηεηα λα αλαπηπρζνχλ ξηδηθά δηαθνξεηηθέο κνξθέο ειεθηξνληθνχ εκπνξίνπ, φπσο 

ππεξεζίεο ζε απεπζείαο ζχλδεζε, θαζψο θαη λέεο κνξθέο καδηθψλ θνηλσληθψλ επαθψλ 

θαη δηάδνζεο γλψζεσλ. Δθηφο απφ ηε δηαζεζηκφηεηα θαη ην ρακειφ θφζηνο δηθηχσλ, 

βαζηθφο παξάγσλ γηα ηελ πξνψζεζε ηεο επξείαο ρξήζεο ηνπ απφ ηηο επηρεηξήζεηο είλαη 

ε χπαξμε θαηάιιεισλ ππνδνκψλ "απφ άθξε ζε άθξε" θαη εθαξκνγψλ πνπ 

ππνζηεξίδνπλ ηηο δηαδηθαζίεο κε νινθιεξσκέλν ηξφπν. 

Ο παγθφζκηνο ηζηφο (World Wide Web) ζηε δεθαεηία ηνπ 1990 αληηκεηψπηζε κε 

απνθαζηζηηθφ ηξφπν ζέκαηα δεκνζίεπζεο θαη δηάδνζεο πιεξνθνξηψλ. Ο ηζηφο θαζηζηά 

ην Ζιεθηξνληθφ Δκπφξην έλα θζελφηεξν κέζν γηα ηελ εθηέιεζε ησλ επηρεηξεκαηηθψλ 

δξαζηεξηνηήησλ (νηθνλνκίεο θιίκαθαο) θαη επηηξέπεη ηε κεγαιχηεξε δηαθνξνπνίεζε 

ησλ δξαζηεξηνηήησλ (νηθνλνκίεο θάζκαηνο). Οη πεξηνξηζκέλεο απαηηήζεηο εηζφδνπ 

(έλαο πξνζσπηθφο ππνινγηζηήο, έλαο απνδηακνξθσηήο - modem θαη ινγαξηαζκφο 

Internet) επηηξέπνπλ ζηηο κηθξέο επηρεηξήζεηο λα εηζέιζνπλ ζηνλ ηνκέα απηφ κε 

ηερλνινγηθέο βάζεηο πνπ δελ  δηαθέξνπλ απφ εθείλεο ησλ κεγάισλ επηρεηξήζεσλ. 

 

2.3. Σα ΢ςζηαηικά ηος Ηλεκηπονικού Δμποπίος 

Πξνθεηκέλνπ λα γίλνπλ θαηαλνεηά φζα αθνινπζνχλ ζηα επφκελα θεθάιαηα, ζα 

γίλεη κηα ζχληνκε αλαθνξά ζηηο δηάθνξεο κνξθέο ηνπ Ζ.Δ., ζηνπο ηχπνπο πξντφλησλ 

θαη ζηηο επηρεηξεκαηηθέο δηαδηθαζίεο πνπ ιακβάλνπλ ρψξα ζηνλ εκπνξηθφ θχθιν. 

 

 

2.3.1. Οι Δμπλεκόμενοι Δηαίποι 

Όπσο θαίλεηαη ζην ζρήκα 1.1 ζε έλα πεξηβάιινλ Ζιεθηξνληθνχ Δκπνξίνπ κπνξεί 

λα ζπκκεηάζρνπλ επηρεηξήζεηο, δεκφζηνη νξγαληζκνί θαη θαηαλαισηέο. ΢ηα πιαίζηα 
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απηά, νη εθαξκνγέο ηνπ Ζιεθηξνληθνχ Δκπνξίνπ κπνξνχλ λα δηαρσξηζηνχλ ζηηο 

αθφινπζεο ηέζζεξηο θαηεγνξίεο: 

 Γημόζιορ θοπέαρ ππορ επισείπηζη. Ζ θαηεγνξία εθαξκνγψλ επηρείξεζε 

πξνο Γεκφζηνπο Οξγαληζκνχο θαιχπηεη θάζε κνξθή ειεθηξνληθήο 

επηθνηλσλίαο κεηαμχ ηδησηηθψλ εηαηξηψλ θαη ησλ αξκνδίσλ αξρψλ, ηφζν γηα 

ηε δηεθπεξαίσζε θνξνινγηθψλ ή άιισλ ππνρξεψζεσλ, φζν θαη γηα ηελ 

απηνκαηνπνίεζε ηεο δηαδηθαζίαο ησλ δεκνζίσλ πξνκεζεηψλ. Οη 

ζπλαιιαγέο ησλ επηρεηξήζεσλ κε ηνπο δεκφζηνπο θνξείο αθνξνχλ ζπλήζσο 

ηέζζεξηο πεξηπηψζεηο: 

■ Φνξνινγία, 

■ εηζαγσγέο-εμαγσγέο κέζσ ηεισλείσλ, 

■ δεκφζηεο πξνκήζεηεο, 

■ πξνεγκέλεο ειεθηξνληθέο ππεξεζίεο (π.ρ. ειεθηξνληθή πιεξνθφξεζε, έθδνζε 

βεβαηψζεσλ-πηζηνπνηεηηθψλ θ.ι.π.). 

 

 

΢ε πξνεγκέλεο ρψξεο ηνπ εμσηεξηθνχ φπσο νη ΖΠΑ, ν Καλαδάο, ε ΢ηγθαπνχξε 

θ.ι.π. έρεη αλαπηπρζεί πιεζψξα εθαξκνγψλ ηεο κνξθήο απηήο, επηηπγράλνληαο κείσζε 

ησλ ιεηηνπξγηθψλ εμφδσλ, θαιχηεξεο ππεξεζίεο, απνηειεζκαηηθφηεξν έιεγρν ησλ 

εζφδσλ θαη δηαθαλή δεκφζηα δηνίθεζε. ΢χληνκα ζα ηεζνχλ ζε ιεηηνπξγία θαη ζηε 

ρψξα καο παξφκνηεο εθαξκνγέο φπσο γηα παξάδεηγκα ε ειεθηξνληθή ππνβνιή θαη 

δηεθπεξαίσζε ησλ δειψζεσλ ηνπ ΦΠΑ. 
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 Γημόζιορ θοπέαρ ππορ πολίηερ-καηαναλωηέρ. ΢ηηο πεξηζζφηεξεο 

εθαξκνγέο ηεο κνξθήο απηήο, νη πνιίηεο-θνξνινγνχκελνη ζπλαιιάζζνληαη 

κε ηνπο δεκφζηνπο νξγαληζκνχο ρξεζηκνπνηψληαο εθαξκνγέο ειεθηξνληθνχ 

εκπνξίνπ είηε γηα λα νινθιεξψζνπλ ηηο θνξνινγηθέο ηνπο ππνρξεψζεηο, είηε 

γηα λα πξνκεζεπηνχλ κε ηα απαξαίηεηα πηζηνπνηεηηθά ή βεβαηψζεηο είηε 

αθφκε γηα λα εμαζθαιίζνπλ ηηο απαξαίηεηεο πιεξνθνξίεο πνπ ρξεηάδνληαη. 

 

 

 Δπισείπηζη ππορ επισείπηζη. Οη εθαξκνγέο ηεο κνξθήο απηήο ζηνρεχνπλ 

ζηελ απινπνίεζε ησλ δηαδηθαζηψλ ησλ επηρεηξήζεσλ, ζηνλ έιεγρν θαη ηε 

κείσζε ηνπ απνζέκαηνο, ζηελ απηνκαηνπνηεκέλε αληηθαηάζηαζε ησλ 

πξντφλησλ θ.α. Απαξαίηεηε πξνυπφζεζε γηα ηελ επηηπρία ησλ εθαξκνγψλ 

ηεο θαηεγνξίαο απηήο είλαη ε ζπλεξγαζία θαη ν ζπληνληζκφο ησλ 

επηρεηξήζεσλ. Έλα παξάδεηγκα εθαξκνγήο Ζιεθηξνληθνχ Δκπνξίνπ κεηαμχ 

επηρεηξήζεσλ   είλαη   ε    ρξήζε    ηειεπηθνηλσληαθψλ    δηθηχσλ   γηα   λα 
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δηεθπεξαησζνχλ ειεθηξνληθά θαίξηεο ιεηηνπξγίεο, φπσο ε παξαγγειηνδνζία 

θαη ε ηηκνιφγεζε. 

 

 

 Δπισείπηζη ππορ καηαναλωηή. Ζ θαηεγνξία εθαξκνγψλ επηρείξεζε πξνο 

θαηαλαισηή παξνπζηάδεη απμαλφκελε ρξήζε ζε δηεζλέο επίπεδν, ιφγσ ηεο 

επξείαο ρξήζεο ησλ δπλαηνηήησλ ηνπ Internet, ην νπνίν ελδείθλπηαη γηα ηελ 

απνηειεζκαηηθή πξνψζεζε πξντφλησλ θαη ππεξεζηψλ ζε κεγάιν εχξνο 

πηζαλψλ πειαηψλ. Οη επηρεηξήζεηο εθκεηαιιεπφκελεο ηα ζηξαηεγηθά νθέιε 

πνπ πξνζθέξεη ην ειεθηξνληθφ εκπφξην θαη εηδηθφηεξα ε παγθνζκηνπνίεζε 

ηεο αγνξάο κέζσ ηεο νηθνλνκίαο ηνπ δηαδηθηχνπ, δεκηνπξγνχλ θαηλνηνκηθά 

πξντφληα θαη ππεξεζίεο θαη ηα πξνσζνχλ ζηνπο θαηαλαισηέο. Έηζη έρεη 

αλαπηπρζεί κηα αηειείσηε ζεηξά εθαξκνγψλ πνπ πεξηιακβάλεη κεηαμχ 

άιισλ θαη ηα αθφινπζα  

 

 

 ππνζηήξημε πειαηψλ, 

 ειεθηξνληθή δεκνζηνγξαθία (εθεκεξίδεο, πεξηνδηθά), 

 ειεθηξνληθή   δηαλνκή   πξντφλησλ   (π.ρ.   πιεξνθνξίεο,   εθεκεξίδεο, 

κνπζηθή), 

 δηαθήκηζε , 

 ειεθηξνληθά θαηαζηήκαηα - ειεθηξνληθέο αγνξέο, 

 ειεθηξνληθέο πιεξσκέο, 

 ειεθηξνληθέο ηξάπεδεο θ.α. 

 

 

2.4. Δπιλογέρ Καηαναλωηών  

 

Σν ειεθηξνληθφ εκπφξην ζε φιεο ηηο κνξθέο ηνπ βξίζθεη πξφζθνξν έδαθνο ιφγσ 

ησλ αιιαγψλ πνπ ραξαθηεξίδνπλ ηε ζχγρξνλε επηρεηξεκαηηθή ιεηηνπξγία. Οη αιιαγέο 

απηέο ιακβάλνπλ ρψξα ζε επίπεδν ηφζν επξχηεξσλ νηθνλνκηθψλ ζπλζεθψλ φζν θαη 

ζπκπεξηθνξάο ησλ θαηαλαισηψλ (consumer behaviour): 
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o Σν απνδεθηφ ρξνληθφ δηάζηεκα κεηαμχ εθδήισζεο ησλ αλαγθψλ ηνπ 

θαηαλαισηή θαη ηθαλνπνίεζεο ηνπο έρεη κεησζεί ζεκαληηθά. Οη 

θαηαλαισηέο θιίλνπλ ζαθψο πξνο ηελ επηρείξεζε πνπ είλαη ζε ζέζε λα 

παξέρεη ην κηθξφηεξν δπλαηφ δηάζηεκα παξάδνζεο. Ζ αιιαγή απηή ζηελ 

θαηαλαισηηθή ζπκπεξηθνξά ζρεηίδεηαη άκεζα κε ηνπο γξήγνξνπο ξπζκνχο 

ηεο ζχγρξνλεο δσήο, πνπ δελ αθήλνπλ πνιιά ρξνληθά πεξηζψξηα γηα 

αλακνλή ζε έλα αλαινγηθφ θαηάζηεκα. 

 

o Ζ «θαηαλαισηηθή πίζηε» (customer loyalty), πνπ αλέθαζελ απνηεινχζε ηελ 

αζθαιή Βάζε γηα νηθνλνκηθή επηβίσζε αιιά θαη πξνβιέςηκα έζνδα ηεο 

επηρείξεζεο, έρεη κεησζεί ζεκαληηθά. Σν γεγνλφο απηφ νθείιεηαη ζε 

πνιπάξηζκνπο ιφγνπο, εθ ησλ νπνίσλ νη πην ζεκαληηθνί είλαη ε κεγάιε 

πνηθηιία ελαιιαθηηθψλ πξντφλησλ θαη ππεξεζηψλ, νη απμεκέλεο απαηηήζεηο 

ησλ θαηαλαισηψλ, ε έιιεηςε ρξφλνπ, θιπ. Οη επηρεηξήζεηο πξέπεη λα 

επελδχζνπλ ζε δεκηνπξγηθνχο ηξφπνπο δηαηήξεζεο ηεο θαηαλαισηηθήο 

πίζηεο - θη απηφ ζεκαίλεη, βέβαηα, φηη ε ζηξαηεγηθή ηνπο δε ζα πξέπεη λα 

πεξηνξίδεηαη πιένλ ζηελ ηηκή ηνπ πξντφληνο σο αληαγσληζηηθνχ 

πιενλεθηήκαηνο. Αληίζεηα, είλαη αλαγθαίν λα επελδχζνπλ ζηνλ ηνκέα ηεο 

εμππεξέηεζεο πειαηψλ (customer service) θαη ζηελ αλάπηπμε ησλ 

ζηνηρείσλ εθείλσλ πνπ ζα πξνζδψζνπλ ζην πξντφλ ηνπο ηζρπξφ 

δηαθνξνπνηφ πιενλέθηεκα. 

 

o Σα δχν παξαπάλσ ζηνηρεία (customer service θαη δηαθνξνπνηφ 

πιενλεθηήκα) είλαη απφ ηνπο πιένλ παξακειεκέλνπο άμνλεο ζην πιαίζην 

ηεο επηρεηξεζηαθήο ζηξαηεγηθήο. Πξνθεηκέλνπ λα δηαηεξεζνχλ νη ηηκέο ησλ 

πξντφλησλ ηνπο ζηαζεξέο, νη παξαγσγνί εηαηξείεο κεηψλνπλ ζπλερψο ην 

θνκκάηη εθείλν ηνπ πξνυπνινγηζκνχ ηνπο πνπ αθνξά ηε βειηίσζε ηεο 

πνηφηεηαο ηνπ ίδηνπ ηνπ πξντφληνο αιιά θαη ηεο πνηφηεηαο εμππεξέηεζεο 

ησλ πειαηψλ. Χο εθ ηνχηνπ, ε ζπλνιηθή νπζηαζηηθή αμία ηνπ πξντφληνο ή 

ηεο ππεξεζίαο κεηψλεηαη ζπλερψο, αζρέησο αλ ε ηηκή ηνπο παξακέλεη ζε 

ζηαζεξά επίπεδα. 

 

o Έλαο απφ ηνπο βαζηθνχο ιφγνπο γηα ηνπο νπνίνπο ηα ATM (automated teller 

machines) ζεκείσζαλ ηφζν κεγάιε επηηπρία απφ ηηο πξψηεο θηφιαο κέξεο 
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εθαξκνγήο ηνπο ζηηο ηξαπεδηθέο ζπλαιιαγέο ήηαλ γηαηί παξέρνπλ 

πιεξνθνξία ζε 24σξε βάζε. Ο θαηαλαισηήο ζεσξεί πιένλ απηνλφεην ην 

δηθαίσκα ηνπ ζε νπνηαδήπνηε πιεξνθνξία αθνξά ηελ επηρείξεζε. Σν θαηά 

πφζν ε πξφζβαζε ηνπ ζε απηήλ είλαη εθηθηή απνηειεί ζήκεξα έλαλ απφ 

ηνπο βαζηθνχο παξάγνληεο πνπ επεξεάδνπλ ηελ ηειηθή ηνπ απφθαζε 

ζρεηηθά κε ηελ επηινγή πξντφλησλ. 

 

o Σέινο, νη λέεο ηερλνινγίεο πξνζθέξνπλ ηε δπλαηφηεηα αλάπηπμεο ελφο 

νιφηεια παξάδνμνπ αιιά θαη απφιπηα εθαξκφζηκνπ πβξηδηθνχ ηξφπνπ 

παξαγσγήο ηελ «επί παξαγγειία καδηθή». ΢ηελ αλαινγηθή βηνκεραληθή 

νηθνλνκία κπνξνχλ λα εληνπηζηνχλ δχν κέζνδνη παξαγσγήο: ρακεινχ 

θφζηνπο (ηππνπνηεκέλα αγαζά, π.ρ. ζηπιφ) θαη πςεινχ θφζηνπο (επί 

παξαγγειία πξντφληα, φπσο ελδχκαηα πςειήο ξαπηηθήο). Οη επηρεηξήζεηο 

πνπ δξαζηεξηνπνηνχληαη ζην Internet έρνπλ ηε δπλαηφηεηα λα ιακβάλνπλ 

παξαγγειία πνπ είλαη «θνκκέλεο θαη ξακκέλεο» ζηα κέηξα ηνπ θαηαλαισηή 

αιιά λα ηηο επεμεξγάδνληαη θαη λα ηηο δηεθπεξαηψλνπλ ζε καδηθφ επίπεδν. 

 

2.4.1. Πλεονεκηήμαηα ηος Ηλεκηπονικού Δμποπίος. 

 

Σν ειεθηξνληθφ εκπφξην πξνζθέξεη ηε δπλαηφηεηα άκεζεο αληηκεηψπηζεο ηνπ 

αληαγσληζκνχ θαη ηεο ηαρείαο ηθαλνπνίεζεο ησλ αλαγθψλ ηνπ θαηαλαισηή. Καηά ηνλ 

Ghosh, ηα ζεκαληηθφηεξα πιενλεθηήκαηα ησλ ειεθηξνληθψλ εκπνξηθψλ δηαδηθαζηψλ 

κπνξνχλ λα ζπλνςηζηνχλ ζηα εμήο: 

 

o Σν ειεθηξνληθφ θαηάζηεκα ιεηηνπξγεί ζε 24σξε βάζε, 7 κέξεο ηελ εβδνκάδα 

(θαη' απηφ ηνλ ηξφπν επηηπγράλεηαη ε κέγηζηε δπλαηή πξνζέιθπζε πειαηψλ). 

 

o Αξθεί κεησκέλνο αξηζκφο πξνζσπηθνχ, θαζψο δελ πθίζηαηαη αλάγθε 

πξνζσπηθήο παξνπζίαο γηα ηε ιήςε ησλ παξαγγειηψλ θαη ηελ επεμεξγαζία ησλ 

πιεξσκψλ (κεησκέλν θφζηνο θαη νηθνλνκία ρξφλνπ). 
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o Οη παξαγγειίεο κπνξνχλ λα γίλνπλ αληηθείκελα επεμεξγαζίαο online ζε 

πξαγκαηηθφ ρξφλν ή offline νκαδνπνηεκέλεο (επνκέλσο ε επηρείξεζε κπνξεί λα 

επηιέμεη ηελ πην ζπκθέξνπζα ελαιιαθηηθή). 

o Σέινο, εθφζνλ νη πξαθηηθέο ειεθηξνληθνχ εκπνξίνπ δελ πεξηνξίδνληαη 

γεσγξαθηθά, νη επηρεηξήζεηο πνπ ιεηηνπξγνχλ ζε ηνπηθφ επίπεδν έρνπλ ηε 

δπλαηφηεηα λα αληαγσληζηνχλ εζληθέο θαη πνιπεζληθέο επηρεηξήζεηο 

(δπλαηφηεηα πνπ δε ζα είραλ ζην πιαίζην ηεο αλαινγηθήο ιεηηνπξγίαο ηνπο). 

 

2.4.2. Σα Μειονεκηήμαηα ηος Ηλεκηπονικού Δμποπίος. 

 

Παξά ηα ζεκαληηθά πιενλεθηήκαηα ηεο ε εκπνξηθή δξαζηεξηνπνίεζε ζην Internet 

δελ είλαη θαηά θαλέλα ηξφπν «ηδαληθή». Όπσο θάζε επηρεηξεκαηηθή θίλεζε θαη 

πξσηνβνπιία, εκπεξηέρεη κεγάιν Βαζκφ ξίζθνπ θαη παξνπζηάδεη ζεκαληηθά 

κεηνλεθηήκαηα, ηα νπνία πξέπεη νπσζδήπνηε λα ιεθζνχλ ππφςε: 

 

o Σν πξψην κεηνλέθηεκα νπνηαζδήπνηε κνξθήο εκπνξηθήο δξαζηεξηφηεηαο ζην 

Internet ζρεηίδεηαη κε ηνπο πηζαλνχο επελδπηέο. Παξά ην γεγνλφο φηη ε αμία ηνπ 

Γηαδηθηχνπ σο επηρεηξεκαηηθνχ εξγαιείνπ έρεη αδηακθηζβήηεηα αλαγλσξηζηεί, 

ε πιεηνλφηεηα ησλ ειεθηξνληθψλ επηρεηξήζεσλ παξνπζηάδεη νηθνλνκηθφ 

έιιεηκκα. ΢χκθσλα κε ζρεηηθή έξεπλα πνπ πξαγκαηνπνηήζεθε ην 2001 ζε 

δείγκα 1.100 ειεθηξνληθψλ επηρεηξήζεσλ, κφλν πνζνζηφ ηεο ηάμεο ηνπ 31% 

εκθάληδε θέξδε. Δπνκέλσο, είλαη πνιχ πηζαλφ ζηαδηαθά λα κεησζεί ην 

επελδπηηθφ ελδηαθέξνλ γηα ηηο ειεθηξνληθέο επηρεηξήζεηο, εθφζνλ απηέο δελ 

είλαη επηθεξδείο., 

 

o Δπηπιένλ ππάξρεη ην ελδερφκελν κείσζεο ηνπ ελδηαθέξνληνο ησλ δηαθεκηζηψλ. 

Λφγσ ηεο ίδηαο ηεο θχζεο ηνπ Γηαδηθηχνπ θαη ησλ ηερληθψλ ραξαθηεξηζηηθψλ 

ηνπ, είλαη πνιχ δχζθνιν λα ζπγθεληξσζνχλ αμηφπηζηα δεδνκέλα ζρεηηθά κε ην 

πξνθίι ησλ ρξεζηψλ ηνπ θαη ηνπο επηζθέπηεο θάζε ζειίδαο web. Χο γλσζηφλ, 

ην θίλεηξν θαη ν θαζνξηζηηθφο παξάγνληαο γηα ηνπο δηαθεκηζηέο είλαη αθξηβψο 

απηνί νη αξηζκνί πνπ ζθηαγξαθνχλ ηε δπλακηθή θαη ηα ηδηαίηεξα 

ραξαθηεξηζηηθά ηνπ θνηλνχ κηαο ζειίδαο web. 
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o Έλα απφ ηα πιένλ ζεκαληηθά δεηήκαηα πνπ ζρεηίδνληαη κε ηελ ειεθηξνληθή 

εκπνξηθή δξαζηεξηφηεηα είλαη απηφ ηεο αζθάιεηαο. Δίλαη ραξαθηεξηζηηθφ φηη 

πνζνζηφ 21% φζσλ εκκέλνπλ ζηνλ παξαδνζηαθφ ηξφπν αγνξψλ «θνβνχληαη ηνπο 

ράθεξ, ελψ 13% δελ ζέινπλ λα απνθαιχςνπλ πξνζσπηθά ηνπο ζηνηρεία. Σα ζέκαηα 

αζθαιείαο ζην Internet ππήξμαλ αλέθαζελ απφ ηα πην αθαλζψδε θαη είλαη απφ ηνπο 

κεγαιχηεξνπο αλαζηαιηηθνχο παξάγνληεο ζηελ αλάπηπμε ηνπ ειεθηξνληθνχ 

εκπνξίνπ. Ζ εμαζθάιηζε ησλ απαξαίηεησλ παξακέηξσλ αζθαιείαο γηα έλα 

ειεθηξνληθφ θαηάζηεκα απαηηεί πξνζεθηηθφ ζρεδηαζκφ, ρξφλν θαη ρξήκα, θαη είλαη 

θξίζηκνο παξάγνληαο γηα ηε δηαηήξεζε ηεο εκπηζηνζχλεο ηνπ θαηαλαισηή. 

 

 

2.4.3. ΢ςμπεπάζμαηα 

 

Γηαπηζηψλεηαη, φηη ην ειεθηξνληθφ εκπφξην παξνπζηάδεη ζεκαληηθά πιενλεθηήκαηα 

ζην επξχηεξν πιαίζην ηεο επηρεηξεζηαθήο ζηξαηεγηθήο αιιά ηαπηφρξνλα απαηηεί 

πξνζεθηηθφ ζρεδηαζκφ θαη ζπλεηδεηνπνίεζε ηνπ κεγάινπ βαζκνχ ξίζθνπ πνπ ην 

ραξαθηεξίδεη. 

Παξ’ φι’ απηά, νη κειινληηθέο πξννπηηθέο ηνπ εκθαλίδνληαη κάιινλ επνίσλεο. 

΢χκθσλα κε ζρεηηθή έξεπλα ηεο Jupiter Communications
 
γηα ην 2008, ππάξρνπλ 90 

εθαηνκκχξηα θαηαλαισηέο ζε παγθφζκην επίπεδν πνπ πξαγκαηνπνηνχλ ειεθηξνληθέο 

αγνξέο, ελψ ν ζπλνιηθφο ηδίξνο ησλ πσιήζεσλ κέζσ ηνπ Γηαδηθηχνπ γηα ηελ ίδηα 

ρξνληά αλέξρεηαη ζε πεξίπνπ 1 δηζεθαηνκκχξην επξψ, κε ηελ πξννπηηθή λα αγγίμεη ηα  

3 δηζεθαηνκκχξηα ην έηνο 2009. Απφ απηά πξνέξρνληαη, πάληα γηα ην 2007: 

 

• 313,65 εθαηνκκχξηα απφ ηε δξαζηεξηφηεηα ησλ online ηαμηδησηηθψλ 

πξαθηνξείσλ (εηζηηήξηα, θξαηήζεηο, θιπ.) 

• 272,4 απφ ην ρψξν ηνλ ειεθηξνληθψλ ππνινγηζηψλ (hardware) 

• 40,5 απφ ηηο αγνξέο ηξνθίκσλ online 

• 32,85 απφ αγνξέο δψξσλ θαη ινπινπδηψλ 

• 32,4 απφ ην ρψξν ηνπ βηβιίνπ 

•  25,95 κφλν απφ ηηο αγνξέο software online 

• 19,05 απφ εηζηηήξηα ζπλαπιηψλ ή/θαη άιισλ ζεακάησλ 

• 12,15 απφ ηελ αγνξά CD 
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• 10,65 απφ αγνξέο ξνχρσλ. 

• 240,4 απφ άιιεο επηρεηξήζεηο  

 

Δπίζεο, είλαη ραξαθηεξηζηηθφ φηη, αλ θαη νη επξσπατθέο επηρεηξήζεηο παξνπζηάδνπλ 

έλα δηάζηεκα θαζπζηέξεζεο πεξίπνπ δχν εηψλ
29

φζνλ αθνξά ηελ πηνζέηεζε ησλ λέσλ 

ηερλνινγηψλ ζε ζρέζε κε ηηο αληίζηνηρεο ακεξηθαληθέο, ν ζπλνιηθφο ηδίξνο ηνπ 

επξσπατθνχ ειεθηξνληθνχ ιηαληθνχ εκπνξίνπ αλακέλεηαη λα αγγίμεη ηα 4,65 

δηζεθαηνκκχξηα δνιάξηα κέρξη ην 2002
30

. 

Ηδηαίηεξν ελδηαθέξνλ παξνπζηάδεη θαη ην γεγνλφο φηη, ελψ ζχκθσλα κε εθηηκήζεηο
 
 

ε ζπλνιηθή αμία ησλ αγαζψλ θαη ππεξεζηψλ πνπ δηαθηλνχληαη ειεθηξνληθά ζηηο 

Ζλσκέλεο Πνιηηείεο ζα θηάζεη κέρξη ην 2009 ην πνζφ ησλ 750 δηζεθαηνκκπξίσλ 

δνιαξίσλ, κφλν 240 δηζεθαηνκκχξηα απφ απηά ζα πξνέξρνληαη απφ αγνξέο 

θαηαλαισηψλ. Ο ηνκέαο ζπλαιιαγψλ ζε επίπεδν business-to-business εκθαλίδεη 

ηδηαίηεξε αλάπηπμε ζηηο Ζλσκέλεο Πνιηηείεο, ζχκθσλα θαη κε επίζεκα ζηνηρεία απφ 

ηελ έξεπλα «The Emerging Digital Economy», πνπ δηεμήρζε απφ ην ακεξηθαληθφ 

Τπνπξγείν Δκπνξίνπ: «ro εκπφξην ζην Internet αλαπηχζζεηαη κε ηαρχηεξνπο ξπζκνχο 

κεηαμχ επηρεηξήζεσλ -ρξεζηκνπνηείηαη γηα ην ζπληνληζκφ κεηαμχ ησλ εηαηξεηψλ θαη 

ησλ πξνκεζεπηψλ ηνπο, γηα ηηο εηαηξηθέο αλάγθεο ζε επίπεδν logistics πνπ αθνξνχλ 

ζηε ζρέζε ηνπο κε ηηο κεηαθνξηθέο εηαηξείεο πνπ απνζεθεχνπλ θαη δηαθηλνχλ ηα 

πξντφληα ηνπο, γηα ηελ επηθνηλσλία ηνπο κε ρνλδξεκπφξνπο θαη ιηαλέκπνξνπο θαη, 

ηέινο, γηα ηελ εμππεξέηεζε ησλ πειαηψλ, ηηο δηαδηθαζίεο ζπληήξεζεο θαη ηνπο 

ηειηθνχο πειάηεο ηεο επηρείξεζεο». 

 

Οη πξναλαθεξζέληεο αξηζκνί κνηάδνπλ κάιινλ εμσπξαγκαηηθνί γηα ηα ειιεληθά 

δεδνκέλα. Σν ειεθηξνληθφ εκπφξην ζηελ Διιάδα βξίζθεηαη αθφκε ζε βξεθηθφ ζηάδην 

θαη σο εθ ηνχηνπ ηα ζηνηρεία πνπ ην αθνξνχλ είλαη ειάρηζηα. Οη ειιεληθέο 

επηρεηξήζεηο κφιηο έρνπλ αξρίζεη λα ζπλεηδεηνπνηνχλ ηελ αμία ηνπ Internet σο 

ζηξαηεγηθνχ εξγαιείνπ. ΢χκθσλα κε ζηνηρεία γηα ην 2006, θαηαγξαθηήθαλ πεξίπνπ 

4450 ειιεληθέο εηαηξείεο πνπ δηαηεξνχλ ζειίδα web. Σα sites ηνπο θαιχπηνπλ θπξίσο 

αλάγθεο πιεξνθφξεζεο ηνπ θνηλνχ θαη δηαλνκήο, ελψ ε επηθνηλσληαθή δπλακηθή ηνπο 

θαη ηα ζηνηρεία πνπ ζρεηίδνληαη κε δηαδξαζηηθφηεηα βξίζθνληαη αθφκε ζε εκβξπαθφ 

ζηάδην. Ζ δηαπίζησζε απηή είλαη πνιχ ζεκαληηθή, αλ ιάβνπκε ππφςε φηη ην 

απνηειεζκαηηθφ customer service ζην Internet απαηηεί πάλσ απ' φια ηζρπξφ 

επηθνηλσληαθφ ππφβαζξν. 
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.2.4.4 Δπιπηώζειρ ηος Ηλεκηπονικού Δμποπίος ζηιρ Δπισειπήζειρ 

 

Σν Ζιεθηξνληθφ Δκπφξην κπνξεί λα απνηειέζεη ζεκαληηθφ φπιν γηα ηηο 

επηρεηξήζεηο πνπ επηζπκνχλ (ή είλαη ππνρξεσκέλεο απφ ηηο ζπλζήθεο ηεο αγνξάο) λα 

πξνβνχλ ζε αιιαγέο ζηνλ ηξφπν ιεηηνπξγίαο ηνπο πξνθεηκέλνπ λα επηβηψζνπλ θαη λα 

αλαπηπρζνχλ ζηηο ζπλζήθεο ηνπ ζχγρξνλνπ αληαγσληζκνχ. Σν Ζ.Δ. κπνξεί λα 

βνεζήζεη κηα επηρείξεζε λα κεηαβάιιεη νινθιεξσηηθά ηε δνκή ηεο, πεξλψληαο απφ 

πνιιά επίπεδα ηεξαξρίαο ζε πην "νξηδφληηεο" δνκέο θαη ζπζθίγγνληαο ηηο ζρέζεηο ηεο κε 

ηνπο πειάηεο θαη πξνκεζεπηέο ηεο. 

 

2.4.4.1 Ανηιμεηώπιζη ηηρ Ππόκληζηρ ηος Ηλεκηπονικού Δμποπίος 

 

΢ην ζεκείν απηφ ζα πξέπεη λα ηνληζηεί γηα αθφκε κηα θνξά φηη ην Ζ.Δ. είλαη 

ηαπηηζκέλν κε ηε ρξήζε ηερλνινγίαο γηα ππνζηήξημε επηρεηξεκαηηθψλ αιιαγψλ. Οη 

επηρεηξήζεηο πνπ αληηκεησπίδνπλ ην Ζ.Δ. απιψο ζαλ έλα ηξφπν απηνκαηνπνίεζεο θαη 

επηηάρπλζεο ηνπ ππάξρνληνο ηξφπνπ ιεηηνπξγίαο ηνπο δελ κπνξνχλ ζηηο πεξηζζφηεξεο 

πεξηπηψζεηο λα απνθνκίζνπλ ηδηαίηεξα νθέιε απφ απηφ. Αληίζεηα, ε πιήξεο 

εθκεηάιιεπζε ησλ δπλαηνηήησλ θαη επθαηξηψλ πνπ πξνζθέξεη ε ρξήζε κεζφδσλ Ζ.Δ. 

ζηελ Κνηλσλία ησλ Πιεξνθνξηψλ, επέξρεηαη κφλν φηαλ ε ηερλνινγία ζπλδπάδεηαη κε 

(θαη ππνζηεξίδεη) ηνλ αλαζρεδηαζκφ ησλ επηρεηξεκαηηθψλ δηαδηθαζηψλ πξνο ηελ 

θαηεχζπλζε ηεο επίηεπμεο ζπγθεθξηκέλσλ επηρεηξεκαηηθψλ ζηφρσλ. Έηζη νη 

επηρεηξήζεηο ζα πξέπεη λα επηθεληξψζνπλ ηελ πξνζνρή ηνπο ζηα παξαθάησ δεηήκαηα: 

 

 

 ΢ηπαηηγική εκμεηάλλεςζη. Βαζηθφο άμνλαο θαη ζεκείν αλαθνξάο ηνπ 

Ζιεθηξνληθνχ   Δκπνξίνπ   είλαη   ε   ππνζηήξημε   ησλ   επηρεηξήζεσλ   

ζηελ πξνζπάζεηα ηνπο λα ζρεδηάζνπλ θαη λα εθαξκφζνπλ ζηξαηεγηθέο 

θηλήζεηο ηέηνηεο πνπ ζα ηνπο εμαζθαιίζνπλ αληαγσληζηηθά πιενλεθηήκαηα 

ζηελ αγνξά πνπ θηλνχληαη. Έηζη, ην Ζιεθηξνληθφ Δκπφξην δελ αλαθέξεηαη 

απιά ζηε  ρξήζε ηερλνινγίαο γηα  απηνκαηνπνίεζε   θάπνησλ  

επηρεηξεκαηηθψλ δηαδηθαζηψλ, αιιά   ζηε   ζηξαηεγηθή   εθκεηάιιεπζε   ηεο   

γηα   επίηεπμε επηρεηξεκαηηθψλ ζηφρσλ. 
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 Δπικένηπωζη     ζε     ηομείρ     επισειπημαηικήρ     δπαζηηπιόηηηαρ.     

Σν Ζιεθηξνληθφ Δκπφξην κπνξεί λα πξνζθέξεη ζεκαληηθά νθέιε ζε 

πνιινχο ηνκείο δξαζηεξηνπνίεζεο κηαο επηρείξεζεο θαη ζε πνιιά ζηάδηα 

ηεο ζπλνιηθήο ιεηηνπξγίαο ηεο. Έηζη γηα παξάδεηγκα, θιαζζηθέο εθαξκνγέο 

Ζ.Δ. είλαη ε ζχλαςε εκπνξηθήο ζρέζεο (δηαπξαγκάηεπζε ζπκθσληψλ), ε 

πξνψζεζε πξντφλησλ (marketing, δηαθήκηζε, πσιήζεηο), ε παξάδνζε 

πξντφλησλ, ν θχθινο ηεο πξνζθνξάο/παξαγγειηνδνζίαο/ηηκνιφγεζεο, νη 

πιεξσκέο, θ.α. 

 

 Σπόπορ ςιοθέηηζηρ. ΢ηελ πξάμε ην Ζ.Δ. απαηηεί κηα ζεηξά επελδχζεσλ 

απφ ηηο επηρεηξήζεηο. Πέξα απφ ηηο πξνθαλείο επελδχζεηο (πιηθφ, ινγηζκηθφ,  

ηειεπηθνηλσληαθφο εμνπιηζκφο), ην Ζ.Δ. απαηηεί δέζκεπζε αλζξψπηλσλ 

πφξσλ, εθπαίδεπζε, θαηνρή ηερλνγλσζίαο θαη άιια έκκεζα θφζηε πνπ 

αλαθέξνληαη ζηελ αλάπηπμε θαηάιιειεο "θνπιηνχξαο" ζηελ επηρείξεζε, 

ζηνλ αλαζρεδηαζκφ επηρεηξεκαηηθψλ πξαθηηθψλ, θ.α. ΢ηελ πξάμε, ην 

θφζηνο πηνζέηεζεο Ζ.Δ. κπνξεί λα είλαη πξαγκαηηθά πνιχ κηθξφ γηα κηα 

αξρηθή εθαξκνγή θαη απμάλεηαη φζν κεγαιψλεη ην κέγεζνο ηεο επηρείξεζεο, 

νη ηνκείο δξαζηεξηφηεηαο ζηνπο νπνίνπο ζα εθαξκνζηεί, θ.α. Γεληθά, νη 

επηρεηξήζεηο πνπ είλαη εμνηθεησκέλεο κε ηελ εθαξκνγή λέσλ ηερλνινγηψλ 

δελ αληηκεησπίδνπλ ζπλήζσο ην θφζηνο επέλδπζεο ζαλ αλαζρεηηθφ 

παξάγνληα. 

 

 ΢ςνδςαζμόρ ηεσνολογιών. Σν Ζ.Δ. δελ απνηειεί ηερλνινγία απφ κφλν ηνπ. 

Γελ έγηλε δειαδή θάπνηα κεκνλσκέλε ηερλνινγηθή επαλάζηαζε πνπ λα 

θαηέζηεζε δπλαηφ ην Ζ.Δ. Αληίζεηα ην Ζ.Δ. απνηειεί κηα νινθιεξσκέλε 

θαη εκπεξηζηαησκέλε πξνζπάζεηα ζπλδπαζκνχ λέσλ ηερλνινγηψλ κε 

απψηεξν ζθνπφ ηελ εμππεξέηεζε ησλ επηρεηξήζεσλ. Έηζη, ην Ζ.Δ. 

ζπλδπάδεη ηερλνινγίεο δηθηχσλ ππνινγηζηψλ θαη ηερλνινγίεο 

πιεξνθνξηαθψλ ζπζηεκάησλ, βάζεσλ δεδνκέλσλ, δηεπεηρεξηζηαθψλ Π.΢. 

θ.ιπ. κε ηέηνην ηξφπν πνπ ε ρξήζε ηνπο λα είλαη εθηθηή αιιά θαη απνδνηηθή 

γηα ηηο επηρεηξήζεηο. 
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2.4.4.2 Αξιολόγηζη ηηρ Διζαγωγήρ ηος Ηλεκηπονικού Δμποπίος. 

 

Όζν είλαη αιήζεηα φηη ην Ζιεθηξνληθφ Δκπφξην κπνξεί λα είλαη έλα πνιχηηκν 

εξγαιείν ζηα ρέξηα κηαο επηρείξεζεο, άιιν ηφζν επίζεο αιεζεχεη ην γεγνλφο φηη ε 

ρξήζε ηνπ δελ κπνξεί λα πξνζδψζεη ηα ίδηα νθέιε ζε θάζε είδνο θαη ηχπν επηρείξεζεο. 

Δπηπιένλ ην Ζ.Δ. κπνξεί λα επεξεάζεη ηε ιεηηνπξγία θαη ηε δνκή κηαο επηρείξεζεο 

θαζψο επίζεο λα κεηαβάιεη ηνλ ηξφπν εξγαζίαο θαη λα αλαδηακνξθψζεη ην ξφιν ησλ 

εξγαδνκέλσλ. Έηζη είλαη απαξαίηεην γηα ηηο επηρεηξήζεηο, πξνηνχ δεζκεχζνπλ πφξνπο 

ζε νπνηαδήπνηε πξνζπάζεηα, λα αμηνινγήζνπλ πξνζεθηηθά ηα αθφινπζα: 

 

 κπνξεί ε ρξήζε ηνπ Ζιεθηξνληθνχ Δκπνξίνπ λα βνεζήζεη ηελ επηρείξεζε 

λα πεηχρεη θαιχηεξα ηνπο ζηφρνπο ηεο; 

 ζε πνηνπο ηνκείο ηεο επηρεηξεκαηηθήο ιεηηνπξγίαο είλαη πξνζθνξφηεξν λα 

ρξεζηκνπνηεζνχλ ηερλνινγίεο θαη πξαθηηθέο Ζιεθηξνληθνχ Δκπνξίνπ; 

 πνηνο ζπλδπαζκφο ηερλνινγηψλ κπνξεί λα επηθέξεη ηα θαιχηεξα 

απνηειέζκαηα κε ην κηθξφηεξν δπλαηφ θφζηνο επέλδπζεο θαη ην ειάρηζην 

ξίζθν; 

 ηη είδνπο θαη ηη έθηαζεο νξγαλσηηθέο αιιαγέο ζα απαηηήζεη ε εθαξκνγή ηνπ 

Ζιεθηξνληθνχ Δκπνξίνπ κέζα ζε κηα επηρείξεζε; 

 πψο κπνξεί ην Ζιεθηξνληθφ Δκπφξην λα κεηαβάιιεη ηηο ζρέζεηο κηαο 

επηρείξεζεο κε ηνπο επηρεηξεκαηηθνχο ηεο εηαίξνπο; 

 πφζν ζα ηξνπνπνηεζεί ν ηξφπνο εξγαζίαο ησλ ππαιιήισλ ηεο επηρείξεζεο 

θαη ηη αλαθαηαηάμεηο ζα επηθέξεη ην Ζ.Δ. ζηε δνκή θαη ηελ ηεξαξρία ηεο 

εηαηξείαο θαζψο επίζεο θαη ζηηο ζρέζεηο ησλ εξγαδνκέλσλ κε ηελ 

επηρείξεζε. 

 

 

Απηφ πνπ ζίγνπξα απαηηείηαη είλαη κηα επηρείξεζε λα κπνξεί λα αμηνινγήζεη ζσζηά 

ηηο επθαηξίεο θαη ηνπο θηλδχλνπο πνπ κπνξεί λα ζπλεπάγεηαη ε πηνζέηεζε ηνπ 

Ζιεθηξνληθνχ Δκπνξίνπ,  αιιά θαη λα επηιέμεη ηε  ζσζηή ζηξαηεγηθή θαη ην πιάλν 

εθαξκνγήο ηνπ. Κάηη ηέηνην φκσο είλαη εμαηξεηηθά δχζθνιν γηα ηνπο εμήο ιφγνπο: 
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 Σν Ζιεθηξνληθφ Δκπφξην είλαη κηα ζρεηηθά θαηλνχξηα έλλνηα θαη γηα ην 

ιφγν απηφ δελ ππάξρεη αθφκε δηαζέζηκε ζε επξεία βάζε πξαθηηθή 

εκπεηξία πνπ ζα βνεζνχζε ζηελ αμηνιφγεζε θαη αζθαιή εμαγσγή 

ζπκπεξαζκάησλ. Έηζη, ν πεηξακαηηζκφο θαη ε επηρεηξεκαηηθή 

δηαίζζεζε είλαη ηηο πεξηζζφηεξεο θνξέο νη βαζηθφηεξνη κεραληζκνί 

πηνζέηεζεο ηνπ Ζιεθηξνληθνχ Δκπνξίνπ. 

 Ζ αμηνιφγεζε ησλ επθαηξηψλ, ησλ δπλαηνηήησλ αιιά θαη ησλ θηλδχλσλ 

πνπ ζπλεπάγεηαη ε πηνζέηεζε κεζφδσλ Ζιεθηξνληθνχ Δκπνξίνπ είλαη 

εμαηξεηηθά δπζρεξήο γηαηί εμαξηάηαη απφ κηα πιεζψξα παξαγφλησλ 

φπσο ην είδνο επηρεηξεκαηηθήο δξαζηεξηφηεηαο, ην κέγεζνο ηεο 

επηρείξεζεο, ν βαζκφο εμνηθείσζεο ηεο κε ηε ρξήζε λέσλ ηερλνινγηψλ 

θαη κνληέξλσλ κεζφδσλ δηνίθεζεο, ε γεληθφηεξε ζηξαηεγηθή θαη ζέζε 

ηεο ζηελ αγνξά, θαη πνιινί άιινη. 

 

 

 

 

2.4.5 Νέερ Δπισειπημαηικέρ και Οπγανωζιακέρ Μοπθέρ 

 

Οη νξγαλσηηθέο αιιαγέο πνπ ζα επηβάιεη ην ειεθηξνληθφ εκπφξην πξνβιέπεηαη φηη 

ζα αλαπηπρζνχλ ζε 4 βαζηθέο θαηεπζχλζεηο: 

 

 αιιαγέο ζηηο βαζηθέο ιεηηνπξγίεο θαη δηαδηθαζίεο εληφο ηεο επηρείξεζεο, 

 αιιαγέο ζηηο εξγαζηαθέο ξπζκίζεηο, 

 δηαξζξσηηθέο αιιαγέο ζηνπο ηνκείο ηνπ θιάδνπ θαη 

 αιιαγέο πνπ αθνξνχλ ηα πξντφληα πνπ δηαηίζεληαη κέζσ ησλ λέσλ 

εκπνξηθψλ δηαχισλ πξνψζεζεο θαη δηαλνκήο. 

 

 

Ζ επηρείξεζε εθείλε πνπ αλαπηχζζεηαη ζηνλ ηνκέα ηνπ ειεθηξνληθνχ εκπνξίνπ ζα 

αληηκεησπίζεη αλαπφθεπθηα αιιαγέο ησλ βαζηθψλ ηεο ιεηηνπξγηψλ. Ζ δηάζεζε ζηελ 

αγνξά θαη ε πξνψζεζε ησλ πξντφλησλ, νη πσιήζεηο θαη νη αγνξέο θαη ε δηαρείξηζε ησλ 
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ζρέζεσλ κε πειάηεο θαη πξνκεζεπηέο απνηεινχλ ηνπο ηνκείο εθείλνπο πνπ ζα 

επεξεαζηνχλ πεξηζζφηεξν απφ ηηο λέεο πξαθηηθέο ησλ επηρεηξήζεσλ. 

Ζ επίδξαζε ηνπ ειεθηξνληθνχ εκπνξίνπ ζηνλ ηξφπν παξαγγειίαο θαη παξάδνζεο 

ησλ αγαζψλ ζέηεη εξσηήκαηα γηα ην ξφιν ησλ κεζαδφλησλ ζηελ αιπζίδα αμηψλ ηνπ 

εκπνξίνπ. Έλα πηζαλφ ζελάξην είλαη ε εμαθάληζε απφ ηελ αιπζίδα αμηψλ θάζε 

κεζνιάβεζεο ιηαλέκπνξνπ. Δίλαη επίζεο πηζαλφ ν παξαγσγφο λα πξνηηκήζεη ηελ 

άκεζε επαθή κε ηνλ θαηαλαισηή. Ζ απάληεζε ησλ ιηαλέκπνξσλ ζηα ζελάξηα ηνπ 

ειεθηξνληθνχ εκπνξίνπ πνπ ηνπο απνθιείνπλ απφ ηελ αιπζίδα αμηψλ κπνξεί λα 

ζπλίζηαηαη ζηελ εδξαίσζε ηεο ζέζεο ηνπο σο πξσηνγελνχο δηαχινπ γηα ηελ πξφζβαζε 

ζηνπο θαηαλαισηέο. Ζ ζπλέρηζε ηεο χπαξμεο ηνπο ζα εμαξηεζεί απφ ηνλ ηξφπν κε ηνλ 

νπνίν ζα εθκεηαιιεπζνχλ ηηο ζε βάζνο γλψζεηο πνπ θαηέρνπλ ζε ζπγθεθξηκέλα 

δεηήκαηα εκπνξηθψλ δηαδηθαζηψλ (γλψζε ηκεκάησλ ηεο αγνξάο, ζπγθξηηηθψλ 

ραξαθηεξηζηηθψλ ησλ πξντφλησλ, εηδηθψλ ραξαθηεξηζηηθψλ γλσξηζκάησλ ησλ 

θαηαλαισηψλ) ψζηε λα κεηαηξέςνπλ ηηο γλψζεηο απηέο ζε ππεξεζίεο πιεξνθνξηψλ 

κέζσ ειεθηξνληθψλ κέζσλ. Δθφζνλ πξνβνχλ ζηηο θαηάιιειεο ελέξγεηεο εδξαίσζεο 

ηεο ζέζεο ηνπο, ηα άηνκα απηά ζα εμειηρζνχλ ζηνπο κεζάδνληεο ηνπ θπβεξλνρψξνπ 

ζηελ επνρή ηνπ Internet. 

Δθ πξψηεο φςεσο, νη Μηθξνκεζαίεο Δπηρεηξήζεηο (ΜΜΔ) είλαη επάισηεο ζηελ 

αχμεζε ηνπ ειεθηξνληθνχ εκπνξίνπ επεηδή, ζε κηα νινέλα πεξηζζφηεξν επαίζζεηε σο 

πξνο ηελ ηηκή θαηαλαισηηθή αγνξά, ε δπλαηφηεηα ηνπο γηα απνηειεζκαηηθή 

ζπγθξάηεζε ηνπ εζσηεξηθνχ ηερληθν-νξγαλσηηθνχ θφζηνπο έλαληη  ησλ  κεγαιχηεξσλ   

επηρεηξήζεσλ  είλαη   ζεκαληηθά   ρακειφηεξε.   Σν γεγνλφο απηφ κεηψλεη ηηο 

δπλαηφηεηεο ηνπο γηα πεξηνξηζκφ ησλ εζσηεξηθψλ δαπαλψλ, θαηάζηαζε πνπ νδεγεί ζε 

πςειφηεξεο ηηκέο πξντφλησλ. Χζηφζν, νη ΜΜΔ έρνπλ δηάθνξνπο ηξφπνπο γηα λα 

αληαπνθξηζνχλ ζηελ πξφθιεζε απηή. Οη επηρεηξήζεηο απηέο ρξεηάδεηαη λα εμεηάζνπλ 

ηηο δπλαηφηεηεο ζχζηαζεο ζπκκαρηψλ θαη εηδίθεπζεο (niche marketing), πξνθεηκέλνπ 

λα απμήζνπλ ηελ αληαγσληζηηθφηεηα   ηνπο   έλαληη   ησλ   κεγάισλ   επηρεηξήζεσλ.   

Μηα   άιιε ζηξαηεγηθή  επηινγή   είλαη ε   δηείζδπζε  ηνπο  ζε   αγνξέο  

απνκαθξπζκέλσλ γεσγξαθηθψλ πεξηνρψλ. Σέινο, πξέπεη λα είλαη πξφζπκεο λα 

πηνζεηνχλ λέεο ηερλνινγίεο. 

Όζνλ αθνξά ζηηο ζηξαηεγηθέο πξντφλησλ, ε αγνξά ηνπ ειεθηξνληθνχ εκπνξίνπ 

ραξαθηεξίδεηαη απφ θαηαζηήκαηα πνπ εηδηθεχνληαη ζηελ παξνρή παθέησλ "πξντφλησλ-

εμππεξέηεζεο" (δειαδή πσιήζεηο ζε ζπλδπαζκφ κε ππεξεζίεο ζπληήξεζεο, 

πζηεξνγελείο πσιήζεηο, παξάδνζε, ζπζθεπαζία) θαη βαζίδνληαη ζε πξντφληα κε 
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ραξαθηεξηζηηθά θαη πνηφηεηα πνπ είλαη ζε ζέζε λα αληηκεησπίζνπλ ηνλ παγθφζκην 

αληαγσληζκφ. 

Κάζε κνξθή ηνπ ειεθηξνληθνχ εκπνξίνπ κέζσ ηνπ Internet είλαη, εμ νξηζκνχ, 

γεσγξαθηθά αλεμάξηεηε. Σν γεγνλφο απηφ ζε ζπλδπαζκφ κε ηερλνινγηθέο θαηλνηνκίεο, 

φπσο είλαη ηα αζθαιή ζπζηήκαηα ειεθηξνληθψλ πιεξσκψλ θαη ην ειεθηξνληθφ ρξήκα 

πνπ επηηξέπνπλ ηελ πιήξε νινθιήξσζε ελφο θχθινπ ειεθηξνληθψλ πσιήζεσλ, 

ζπκβάιιεη ζηελ πηνζέηεζε κεζφδσλ ηειε-εξγαζίαο. Ζ ηειε-εξγαζία θαη ην 

ειεθηξνληθφ εκπφξην ζπγθιίλνπλ απφ ηελ άπνςε ησλ βαζηθψλ ηερλνινγηθψλ πιαηζίσλ 

πνπ ρξεζηκνπνηνχλ. Μεηαμχ ησλ εξγαζηψλ πνπ    κπνξνχλ    λα    εθηειεζηνχλ    απφ    

απφζηαζε     ζπγθαηαιέγνληαη    νη δξαζηεξηφηεηεο πξνψζεζεο πξντφλησλ, ε 

παξαθνινχζεζε ηνπ αληαγσληζκνχ ζην δίθηπν, ε αλάπηπμε θαη ε ζπληήξεζε ησλ 

ηερλνινγηθψλ ππνδνκψλ ηνπ ειεθηξνληθνχ εκπνξίνπ θαη θπξίσο νη δξαζηεξηφηεηεο 

δηαλνκήο. 

Σα νξγαλσηηθά, ρσξηθά θαη ηερληθά φξηα ησλ επηρεηξήζεσλ επεθηείλνληαη θαη ζε 

νξηζκέλεο πεξηπηψζεηο θαηαξγνχληαη, ελψ νη δνκέο ηεο ηεξαξρίαο κεηαζρεκαηίδνληαη 

κε ηελ εηζαγσγή ηνπ ειεθηξνληθνχ εκπνξίνπ. 

 

2.4.6 Δπιπηώζειρ ζηην Δπγαζία και ηην Απαζσόληζη 

 

Οη εξγαδφκελνη, αθελφο, ρξεηάδεηαη λα βειηηψζνπλ ηηο ηθαλφηεηεο, ηηο γλψζεηο θαη 

ηα πξνζφληα ηνπο. Αθεηέξνπ, έρνπλ ηε δπλαηφηεηα λα αλαπηχμνπλ ηηο επζχλεο, ηελ 

πξνζσπηθφηεηα θαη ηηο επηδφζεηο ηνπο. Ζ επίηεπμε λέσλ επηρεηξεκαηηθψλ δνκψλ 

ζπλεπάγεηαη αιιαγή ησλ ξφισλ θαη ηεο ζπκπεξηθνξάο-σο εθ ηνχηνπ ρξεηάδεηαη λα 

πηνζεηεζνχλ δηαθξηηά πξφηππα ηππηθψλ πξνζφλησλ θαη ππνθίλεζεο. Οη γλψζεηο φζνλ 

αθνξά ηα θίλεηξα ηεο αλζξψπηλεο ζπκπεξηθνξάο, ηελ ηθαλνπνίεζε απφ ηελ εξγαζία, 

θαζψο θαη ηε ζχλδεζε κεηαμχ ησλ εξγαζηαθψλ ξπζκίζεσλ θαη ησλ επηδφζεσλ ησλ 

εξγαδνκέλσλ, ζα απνηειέζνπλ νπζηαζηηθά θξηηήξηα γηα ηελ επηηπρή έληαμε θαη ηελ 

θαζνδήγεζε ηνπ αλζξψπηλνπ δπλακηθνχ ζηελ επνρή ηνπ ειεθηξνληθνχ εκπνξίνπ. Ζ 

εξγαζία κε νπζηαζηηθφ πεξηερφκελν, ην ζαθέο εξγαζηαθφ πεξηβάιινλ, ε ηαρεία 

αλαηξνθνδφηεζε ησλ απνηειεζκάησλ ηεο εξγαζίαο, θαζψο θαη ε επαξθήο εηδίθεπζε, ε 

απηνλνκία θαη ε ππεπζπλφηεηα παξέρνπλ ζην άηνκν ηε δπλαηφηεηα απηνπξαγκάησζεο 

θαη απμάλνπλ ηελ πξνζπκία ηνπ λα βειηηψζεη ηηο επηδφζεηο ηνπ. Έλα ηέηνην εξγαζηαθφ 
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πιαίζην παξέρεη ζηνπο εξγαδφκελνπο θαη ηελ απαξαίηεηε ππνθίλεζε λα δεζκεπηνχλ 

πξνζσπηθά ζηελ θαηεχζπλζε επίηεπμεο ησλ επηρεηξεκαηηθψλ ζηφρσλ. 

Σν ειεθηξνληθφ εκπφξην ζεκαίλεη γηα ηνπο ππαιιήινπο ζηαζεξή αχμεζε ησλ 

επηπέδσλ ησλ δεμηνηήησλ επεηδή θαηαξγεί επαλαιακβαλφκελεο θαη κνλφηνλεο εξγαζίεο 

θαη παξέρεη πνιχ πινπζηφηεξε βάζε πιεξνθνξηψλ γηα ηελ εθηέιεζε ηεο εξγαζίαο. ΢ε 

γεληθέο γξακκέο, νη λέεο ξπζκίζεηο θαζεθφλησλ ησλ εξγαδνκέλσλ ζε πεξηβάιινλ 

ειεθηξνληθνχ εκπνξίνπ αλακέλεηαη φηη ζα εζηηάδνληαη ζε ηξία είδε δξαζηεξηνηήησλ: 

 

 

 δηαρείξηζε   ηεο   πξνψζεζεο   θαη   ηεο   εκπνξίαο   ησλ   πξντφλησλ   

θαη παξαθνινχζεζε ησλ αληαγσληζηψλ, 

 δηαρείξηζε ηεο επηθνηλσλίαο κεηαμχ ηεο επηρείξεζεο θαη ησλ πειαηψλ 

θαη πξνκεζεπηψλ ηεο, θαη 

 δηαρείξηζε ησλ ππνδνκψλ ηεο ηερλνινγίαο ησλ πιεξνθνξηψλ θαη ησλ 

επηθνηλσληψλ. Έηζη ε ειεθηξνληθή πξνψζεζε πξντφλησλ, ηδίσο κέζσ 

ηνπ Internet, ζα δεκηνπξγήζεη έλα λέν είδνο ζέζεο, ηνπ ππεπζχλνπ 

πξνψζεζεο πξντφλησλ ζηνλ παγθφζκην ηζηφ (web promoter). Οη 

δπλαηφηεηεο πνπ πξνζθέξνληαη γηα ειεθηξνληθέο πσιήζεηο ζα 

παξνηξχλνπλ νξηζκέλα κέιε ηνπ ππάξρνληνο πξνζσπηθνχ λα 

αζρνιεζνχλ κε ηηο ειεθηξνληθέο πσιήζεηο. Ζ εξγαζία ηνπ ππεπζχλνπ 

ινγηζηεξίνπ ζην εκπφξην ζα αιιάμεη ζεκαληηθά, δεδνκέλνπ φηη ην 

ειεθηξνληθφ εκπφξην ηξνπνπνηεί ηελ αληαιιαγή πιεξνθνξηψλ θαη ηε 

δηαρείξηζε ησλ πιεξσκψλ πνπ έρνπλ θαηαβιεζεί ή πνπ έρνπλ ιεθζεί. 

 

 

Δθηηκάηαη φηη ν κειινληηθφο ρψξνο εξγαζίαο ζα είλαη πνιχ δηαθνξεηηθφο απφ ην 

ζεκεξηλφ, ηφζν απφ άπνςε γεσγξαθηθήο ζέζεο φζν θαη απφ άπνςε ιεηηνπξγηψλ. Ζ 

επέθηαζε ηνπ ειεθηξνληθνχ εκπνξίνπ ζα απαηηήζεη εχθακπηεο ξπζκίζεηο εξγαζίαο 

ιφγσ ηεο αλάγθεο γηα εμππεξέηεζε ησλ πειαηψλ ζε 24σξε βάζε, ηεο εμάιεηςεο 

νξηζκέλσλ ζέζεσλ εξγαζίαο, ηεο αλαθαηαλνκήο ησλ ππαιιήισλ θαη ηεο απνζχλδεζεο 

νξηζκέλσλ ζέζεσλ εξγαζίαο απφ ηε γεσγξαθηθή ζέζε ηεο επηρείξεζεο. Σα παθέηα 

ακνηβψλ ζηνλ ηνκέα ηνπ εκπνξίνπ ζα αλαδηακνξθσζνχλ κέζσ ηνπ ειεθηξνληθνχ 

εκπνξίνπ ιφγσ ησλ απαηηήζεσλ γηα λέα είδε ππαιιήισλ κε αλψηεξα θαη εηδηθεπκέλα 
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πξνζφληα. Αλακέλεηαη φηη νη εξγνδφηεο ζα πξνζθέξνπλ πςειφηεξεο ακνηβέο γηα 

ππαιιήινπο κε γλψζεηο ζηνλ ηνκέα ηεο ηερλνινγηθήο ππνδνκήο ηνπ ειεθηξνληθνχ 

εκπνξίνπ, θαζψο επίζεο ζηνπο ηνκείο ηεο ηερληθννξγαλσηηθήο ππνζηήξημεο ησλ 

ηερληθψλ πψιεζεο θαη πξνψζεζεο γηα ζπγθεθξηκέλν πξντφλ θαη ηνκέα ηεο αγνξάο. 

Ζ ηάζε γηα αλαβάζκηζε ησλ δεμηνηήησλ ηνπ εξγαηηθνχ δπλακηθνχ είλαη κε 

αλαζηξέςηκε. ΢ην κέιινλ, ε εξγαζία ζα νξγαλψλεηαη κε βάζε ηα απνηειέζκαηα θαη 

φρη ηα πξνθαζνξηζκέλα θαζήθνληα θαη ξφινπο, ελψ ε ηειε-εξγαζία ζα απνθηήζεη 

κεγάιε ζεκαζία. Καηά ζπλέπεηα, ε απηφ-ππνθίλεζε (self-motivation), ε απηνλνκία 

θαζεθφλησλ, ε ηθαλφηεηα εξγαζίαο κε γλψκνλα ηα απνηειέζκαηα θαη φρη ηελ 

πεξηγξαθή ησλ εξγαζηαθψλ θαζεθφλησλ, θαζψο θαη ν απμεκέλνο επαγγεικαηηζκφο ζα 

απνηειέζνπλ ηνπο βαζηθνχο παξάγνληεο γηα ηα άηνκα πνπ ζα απαζρνιεζνχλ ζην 

κέιινλ ζηνλ ηνκέα ηνπ εκπνξίνπ. Οη εξγαδφκελνη ζην εκπφξην πξέπεη λα εμειηρζνχλ ζε 

"ζθεπηφκελνπο εξγαδνκέλνπο" νη νπνίνη ζα είλαη αλνηθηνί ζηηο καζεζηαθέο απαηηήζεηο 

ηνπ αληηθεηκέλνπ ηεο εξγαζίαο. Ζ δηα βίνπ εθπαίδεπζε έρεη νπζηαζηηθή ζεκαζία γηα 

ηελ ηθαλφηεηα ησλ εξγαδνκέλσλ λα πξνζαξκφδνληαη ζηηο αιιαγέο ηεο εξγαζίαο ηνπο. 

Σέινο, ε δηθηχσζε ησλ δξαζηεξηνηήησλ ελζαξξχλεη ηελ "εηθνληθή θηλεηηθφηεηα" 

ηνπ αλζξψπηλνπ δπλακηθνχ θαη πξνσζεί ηελ παγθνζκηνπνίεζε ηεο αγνξάο εξγαζίαο. 

΢ην πιαίζην απηφ, ε δηαζπλνξηαθή εξγαζία ζα έρεη ζεκαληηθφ αληίθηππν ζηελ 

εξγαζηαθή λνκνζεζία. Θα ρξεηαζηνχλ ζίγνπξα θαλνληζηηθέο δηαηάμεηο ζρεηηθά κε ηε 

δηαζπλνξηαθή εξγαζία. 
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3. ΜΑΡΚΔΣΙΝΓΚ Η ΑΡΥΗ ΣΟΤ ΚΔΡΓΟΤ΢ - ΣΜΗΜΑΣΟΠΟΙΗ΢Η 

ΑΓΟΡΑ΢ 

  

 

 

Ζ ηκεκαηνπνίεζε ηεο αγνξάο ζα κπνξνχζε λα νξηζηεί σο «ε δηαδηθαζία 

δηαρσξηζκνχ κηαο αγνξάο ζε δηαθξηηά ππνζχλνια θαηαλαισηψλ κε θνηλέο αλάγθεο ή 

ραξαθηεξηζηηθά θαη επηινγήο ελφο ή πεξηζζφηεξσλ ππνζπλφισλ, ζηα νπνία ζα 

εθαξκνζηεί ζπγθεθξηκέλν κείγκα κάξθεηηλγθ (marketing mix). Ο φξνο marketing mix 

αλαθέξεηαη ζε ηέζζεξα ζεη απνθάζεσλ, ηα νπνία έρνπλ επηθξαηήζεη ζηελ νξνινγία 

κάξθεηηλγθ σο ηα 4P: Α)Οη απνθάζεηο πνπ ζρεηίδνληαη κε ην πξντφλ (product 

decisions), δειαδή κε ην ζρεδηαζκφ, ην ζρήκα, ην ρξψκα, ηε ζπζθεπαζία, ην 

ζπκβνιηζκφ, θιπ., Β)Οη απνθάζεηο πνπ ζρεηίδνληαη κε ηελ ηηκή (pricing decisions), 

δειαδή κε ηελ ηηκνιφγεζε, ηελ πηζαλή έθπησζε, θιπ., Γ)Οη απνθάζεηο πνπ 

ζρεηίδνληαη κε ηνλ ηφπν πψιεζεο θαη ηε δηαλνκή (place or distribution decisions), 

δειαδή ηελ επηινγή θαλαιηψλ δηαλνκήο θαη ιηαλέκπνξσλ, θαη Γ) Οη απνθάζεηο πνπ 

ζρεηίδνληαη κε ηελ πξνψζεζε (promotion decisions), δειαδή κε ηε δηαθήκηζε, ηελ 

πξνζσπηθή πψιεζε, θιπ. 

Ζ ζπλνιηθή αληίιεςε ηνπ marketing mix θπξηάξρεζε - θαη αθφκα θπξηαξρεί - ζηηο 

ζηξαηεγηθέο κάξθεηηλγθ αλά ηνλ θφζκν απφ ην 1960, φηαλ δηαηππψζεθαλ νη βαζηθέο 

αξρέο ηεο ζηελ αλσηέξσ κνξθή ηνπο απφ ηνλ J. McCarthy5. Παξ' φι' απηά, έγηλε 

αληηιεπηφ ήδε απφ ηα ηέιε ηεο δεθαεηίαο ηνπ '50 φηη ε ζπγθεθξηκέλε επηρεηξεζηαθή 

ιεηηνπξγία έπξεπε λα πξνζαξκφδεηαη πεξηζζφηεξν ζηηο αλάγθεο ησλ θαηαλαισηψλ θαη 

λα απνθηά κεγαιχηεξε επειημία θαζψο νη αγνξέο απνκαδηθνπνηνχληαλ. 

Σελ ίδηα πεξίνδν γλσζηνί ζεσξεηηθνί ηνπ κάξθεηηλγθ, φπσο ν Alderson, έθαλαλ 

ιφγν γηα «έληνλα δηαθξηηή εηεξνγέλεηα ησλ αγνξψλ» φζνλ αθνξά θαηαλαισηέο θαη 

παξαγσγνχο, ελψ ην 1960 ν Levitt κε ην πεξίθεκν άξζξν ηνπ «Marketing Myopia» 

ήηαλ απφ ηνπο πξψηνπο πνπ ηφληζαλ φηη νη επηρεηξήζεηο ζα πξέπεη λα επηθεληξψλνπλ 

πξσηίζησο ζηηο αλάγθεο θαη ηηο πξνζδνθίεο ησλ πειαηψλ ηνπο θαη αλάινγα λα 

πξνζαξκφδνπλ ηα ραξαθηεξηζηηθά ησλ πξντφλησλ ηνπο. Ζ ζηξαηεγηθή απηή, 

ηζρπξίζηεθε ν Levitt, είλαη πνιχ πην απνηειεζκαηηθή απφ ην λα πξνζπαζνχλ νη 

παξαγσγνί εηαηξείεο λα πείζνπλ ηνπο θαηαλαισηέο γηα ηελ αλαγθαηφηεηα ήδε 

ιαλζαξηζκέλσλ πξντφλησλ. 
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Ζ ζηξαηεγηθή ηεο ηκεκαηνπνίεζεο βαζίδεηαη αθξηβψο ζην επηρείξεκα ηνπ 

Alderson: ζην φηη, δειαδή, νη αλάγθεο ησλ θαηαλαισηψλ θαη ν ηξφπνο δσήο ηνπο 

δηαθνξνπνηνχληαη ζε πνιχ κεγάιν βαζκφ. Παξά ην γεγνλφο φηη ε δηαδηθαζία 

παξαθνινχζεζεο ησλ αιιαγψλ πνπ αθνξνχλ ηηο πξνζδνθίεο ησλ θαηαλαισηψλ 

ζπλήζσο είλαη εμαηξεηηθά πεξίπινθε, εληνχηνηο είλαη απαξαίηεηε πξνθεηκέλνπ λα 

γίλνπλ θαηαλνεηέο νη αλάινγεο αιιαγέο ζηε δήηεζε8, πάληα ζε επίπεδν αγνξάο. Ζ 

ζπλεηδεηνπνίεζε θαη ε γλψζε απηψλ ησλ αιιαγψλ είλαη ην πξψην ζηάδην γηα ηε 

δηακφξθσζε κηαο ζηξαηεγηθήο πξνζαλαηνιηζκέλεο πξνο ηνλ θαηαλαισηή. 

Σαπηφρξνλα, φκσο, είλαη ην βαζηθφ εξγαιείν γηα ηελ «απνθάιπςε» niche markets, ηελ 

απνηειεζκαηηθή αληηκεηψπηζε ηνπο θαη ηελ απφθηεζε πιενλεθηηθήο ζέζεο ζε ζρέζε κε 

ηνλ αληαγσληζκφ. Οη ζηξαηεγηθέο niche marketing κπνξνχλ λα ρξεζηκνπνηεζνχλ 

πξνθεηκέλνπ λα δηαηεξεζεί απηή ε ζέζε αθφκε πεξηζζφηεξν ζην πιαίζην ιεηηνπξγίαο 

ζε κηα αγνξά φπσο νη ζχγρξνλεο, κε ηαρχηαηα κεηαβαιιφκελεο ζπλζήθεο. 

Έλα απφ ηα θπξηφηεξα ραξαθηεξηζηηθά ησλ ζχγρξνλσλ αγνξψλ είλαη κηα 

γεληθφηεξε ηάζε πξνο ηε ιεγφκελε αηνκηθνπνίεζε. Οη θαηαλαισηέο δηακνξθψλνπλ ηνλ 

ηξφπν δσήο θαη ηελ αγνξαζηηθή ζπκπεξηθνξά ηνπο ζπκθσλά κε ηηο πξνζσπηθέο, 

εμαηνκηθεπκέλεο αλάγθεο θαη πεπνηζήζεηο ηνπο. ΢πκπεξαζκαηηθά, νη αγνξέο δελ πξέπεη 

λα αληηκεησπίδνληαη πιένλ σο καδηθέο αιιά κε ηελ πεπνίζεζε φηη απνηεινχληαη απφ 

πνηθηιία ηκεκάησλ, πνπ ραξαθηεξίδνληαη απφ πςειφ βαζκφ δηαθνξνπνίεζεο. 

Απ' φια ηα παξαπάλσ πξνθχπηεη φηη νη ζχγρξνλεο πξαθηηθέο κάξθεηηλγθ 

ζηεξίδνληαη (ή πξέπεη λα ζηεξίδνληαη) ζε δχν ζεκειηψδεηο αξρέο: πξψηνλ, ζηελ 

αληίιεςε φηη ηα πξντφληα ή νη ππεξεζίεο πξέπεη λα αληαπνθξίλνληαη απφιπηα ζηηο 

αλάγθεο ηνπ θαηαλαισηή (άξα ν θαηαλαισηήο θαη φρη ην πξντφλ είλαη πιένλ ην θέληξν 

νπνηαζδήπνηε πξαθηηθήο) θαη, δεχηεξνλ, φηη ν θαηαλαισηήο δελ είλαη απιά έλα κηθξφ 

θνκκάηη κηαο απξφζσπεο κάδαο αιιά κηα μερσξηζηή, κνλαδηθή νληφηεηα κε 

δηαθνξεηηθέο αλάγθεο θαη πξνζδνθίεο. 

΢ε απηφ ην ζεκείν πξέπεη λα ηνληζηεί θαη ην εμήο: δελ είλαη ηδηαίηεξα δχζθνιν 

ζηνπο αληαγσληζηέο λα κηκεζνχλ ηερλνινγίεο πνπ εθαξκφδνληαη ζηελ εηαηξεία ζαο, 

ραξαθηεξηζηηθά ησλ πξντφλησλ ζαο ή ζπκβαηηθέο πξαθηηθέο κάξθεηηλγθ. Απηφ πνπ δελ 

κπνξνχλ λα αληηγξάςνπλ είλαη ε ηδηαίηεξε θνπιηνχξα θαη ην ζχζηεκα αμηψλ ηεο 

επηρείξεζεο ζαο κέζσ ησλ νπνίσλ δηαθνξνπνηνχληαη νη κέζνδνη εμππεξέηεζεο ησλ 

πειαηψλ ζαο. Ζ λέα ηάζε ηνπ κάξθεηηλγθ επηθεληξψλεη αθξηβψο ζηελ αλάπηπμε κέζα 

ζηελ ίδηα ηελ εηαηξεία ζπκπεξηθνξψλ θαη πεπνηζήζεσλ ηέηνησλ πνπ ζα δεκηνπξγήζνπλ 

ην θιίκα εθείλν ζην νπνίν ε ηθαλνπνίεζε ηνπ πειάηε είλαη ν ιφγνο χπαξμεο ηνπ 
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νξγαληζκνχ. Πέξα φκσο απφ ηελ χπαξμε θαηάιιεινπ πξνζσπηθνχ πνπ αληηιακβάλεηαη 

ηε ζπγθεθξηκέλε ζέζε, είλαη απαξαίηεηε θαη ε χπαξμε ησλ αληίζηνηρσλ ζπζηεκάησλ, 

πνπ δηαθπιάζζνπλ ηελ απνηειεζκαηηθή ιεηηνπξγία ηνπ ηκήκαηνο Δμππεξέηεζεο 

Πειαηψλ. Σα ζπζηήκαηα απηά πξέπεη λα είλαη ζε ζέζε λα αληαπνθξίλνληαη κε επειημία 

ζηηο απαηηήζεηο θάζε πειάηε - θαη πάιη ε αηνκηθνπνίεζε είλαη ην θιεηδί γηα ηελ 

απφθηεζε αληαγσληζηηθνχ πιενλεθηήκαηνο. ΢χκθσλα ινηπφλ κε απηή ηελ αληίιεςε, ε 

θαηαλαισηηθή πίζηε δελ επηηπγράλεηαη κφλν κέζσ ελφο πνιχ θαινχ πξντφληνο αιιά ζε 

ζπλδπαζκφ κε έλα θαηά ην δπλαηφλ απνηειεζκαηηθφ ζχζηεκα εμππεξέηεζεο πειαηψλ, 

εθ ηνπ νπνίνπ αλαπηχζζνληαη πξαγκαηηθέο ζρέζεηο: απηή είλαη θαη ε θεληξηθή ζέζε ηνπ 

relationship marketing. 

Οη πξαγκαηηθέο ζρέζεηο, φκσο, δελ αλαπηχζζνληαη παξά κφλν κε ηελ επηθνηλσλία. 

Οη λέεο ηερλνινγίεο θαη αθφκε πεξηζζφηεξν ην Internet πξνζέδσζαλ ππφζηαζε ζηνλ 

θαηαλαισηή. Οη ηερληθέο κάξθεηηλγθ ζηε ζπκβαηηθή κνξθή ηνπο εθ ησλ πξαγκάησλ 

δελ ηνπ πξνζέθεξαλ ηε δπλαηφηεηα πξνζσπηθήο, ηδηαίηεξεο αληίδξαζεο. Γηα 

παξάδεηγκα, πψο ζα κπνξνχζε λα αληηδξάζεη ν αλαγλψζηεο θάπνηνπ εληχπνπ ζηε 

δηαθεκηζηηθή θαηαρψξηζε κηαο εηαηξείαο πνπ ζα ζηφρεπε ζηελ αχμεζε ηνπ θχξνπο ηεο; 

Αθφκε θη αλ ακθηζβεηνχζε ηελ εγθπξφηεηα ηνπ δηαθεκηζηηθνχ κελχκαηνο, ηελ 

αηζζεηηθή ή ηε ζθνπηκφηεηα ηνπ, ν αλαγλψζηεο ηνπ παξαδείγκαηνο ζα ην ζπδεηνχζε 

απιά κε θάπνηνπο αλζξψπνπο ηνπ πεξηβάιινληνο ηνπ ή, ζηελ «θαιχηεξε» πεξίπησζε, 

ζα επηθνηλσλνχζε κε ηελ εηαηξεία γηα λα εθθξάζεη ηε δπζαξέζθεηα ηνπ. Δπνκέλσο, νη 

ζπκβαηηθέο ηερληθέο κάξθεηηλγθ θξαηνχλ ηνλ θαηαλαισηή ζε απφζηαζε - αθξηβψο 

ιφγσ ηεο ίδηαο ηεο θχζεο ηνπ, ε νπνία απαγνξεχεη ηελ άκεζε επαθή κε ηελ παξαγσγφ 

εηαηξεία. 

Φαληαζηείηε ηνλ ίδην θαηαλαισηή λα βξίζθεηαη κπξνζηά ζηνλ ππνινγηζηή ηνπ θαη 

«ζεξθάξνληαο» λα αλαθαιχπηεη ηελ ίδηα θαηαρψξηζε ζηελ ειεθηξνληθή κνξθή ηεο. ΢ε 

πξψηε θάζε, γηα λα εθθξάζεη ηελ ηπρφλ δπζαξέζθεηα ηνπ, κπνξεί λα ζηείιεη e-mail ζην 

αξκφδην ζηέιερνο ηεο εηαηξείαο. Σα δχζθνια αξρίδνπλ εάλ ην e-mail ηνπ αγλνεζεί (γη’  

απηφ θαη κία απφ ηηο βαζηθφηεξεο αξρέο ηνπ κάξθεηηλγθ ζην Internet είλαη, φπσο ζα 

δείηε ζηε ζπλέρεηα, φηη, εθφζνλ παξέρεηε δπλαηφηεηα επηθνηλσλίαο, νθείιεηε λα 

απαληάηε κε ζαθήλεηα θαη ηαρχηεηα ζε φια ηα mails πνπ ιακβάλεηε απφ πειάηεο). 

Μπνξεί βέβαηα λα αλαξσηεζείηε: «κα θη έλα ηειεθψλεκα ηνπ ζηελ εηαηξεία ζα 

κπνξνχζε λα αγλνεζεί, αθφκα θη έλα θαμ». ΢σζηά! Όκσο απηά είλαη ηα κέζα 

επηθνηλσλίαο κηαο θιαζηθήο, αλαινγηθήο εηαηξείαο. Σν Internet δηαζέηεη ηε δηθή ηνπ, 

ηδηάδνπζα ινγηθή θαη θηινζνθία, ε νπνία πξέπεη λα είλαη γλσζηή θαη θαηαλνεηή ζε 
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φπνηνλ επηζπκεί λα δξαζηεξηνπνηεζεί ζε απηφ. Ο απνζηνιέαο ηνπ e-mail πεξηκέλεη, 

απαηηεί κηα απάληεζε θαη, αλ δελ ηε ιάβεη, είλαη ζίγνπξν φηη δε ζα αληηδξάζεη 

αλαινγηθά! 

Δπηζηξνθή φκσο ζηνλ αλαγλψζηε-ρξήζηε. Αλ είλαη ππνκνλεηηθφο, ζα ζηείιεη μαλά 

e-mail (γηα δεχηεξε, ην πνιχ ηξίηε θνξά). Αλ εμαθνινπζεί λα αγλνείηαη θαη, γηα θαθή 

ζαο ηχρε, ζπκκεηέρεη ζε θάπνηα ιίζηα ζπδήηεζεο, ηφηε είλαη πνιχ πηζαλφ λα 

θνηλνπνηήζεη ην ζέκα ζηα κέιε ηεο. Ξαθληθά, θαη απφ εθεί πνπ δελ ην πεξηκέλαηε, ε 

εηαηξεία ζαο βξίζθεηαη ζην θέληξν ηνπ ελδηαθέξνληνο θαη απνηειεί αληηθείκελν 

ζπδήηεζεο - δπζηπρψο φκσο, δελ είλαη γηα ην θαιφ ηεο. ΢θεθηείηε θαη ηελ άιιε 

πεξίπησζε: αλ ηπρφλ έρεηε αγλνήζεη θάπνηνλ ράθεξ; Μπνξεί έλα πξσί λα μππλήζεηε 

(πξηλ απφ εζάο, ελ ησ κεηαμχ, ην έρνπλ ήδε πάζεη, αλάκεζα ζε πνιινχο, ην ειιεληθφ 

Τπνπξγείν Δμσηεξηθψλ θαη ε Microsoft) θαη ε αζθάιεηα ηνπ site ζαο λα ηζνδπλακεί κε 

αλέθδνην! 

Σα παξαπάλσ ζελάξηα κπνξεί λ' αθνχγνληαη ειαθξψο θαηαζηξνθνινγηθά. Ο 

ζθνπφο ηνπο δελ είλαη λα ζαο παληθνβάινπλ ή λα ζαο θαηαζηήζνπλ θαρχπνπηνπο 

απέλαληη ζηνπο ίδηνπο ζαο ηνπο πειάηεο. ΢θεθηείηε φκσο φηη ηέηνηα πξνβιήκαηα απιά 

δε ζα πθίζηαλην θαλ, αλ είραηε κπεη ζηνλ θφπν λα απαληήζεηε κε επγέλεηα, ζαθήλεηα 

θαη ελδηαθέξνλ ζην e-mail ηνπ αλαγλψζηε - επηζθέπηε - αλ, δειαδή, είραηε αθηεξψζεη 

δέθα ιεπηά απφ ηνλ πνιχηηκν ρξφλν ζαο, πνπ κπνξεί, ζην κεηαμχ, λα ηνλ δηαζέηεηε 

ζηελ θαηάξηηζε marketing plans θαη ζηελ αλάιπζε πνιχπινθσλ ζηαηηζηηθψλ 

δεδνκέλσλ. 

΢ρεηηθά αθξηβψο κε απηφ ην ζέκα, ηα ζηαηηζηηθά δεδνκέλα, ν Πφζηκαλ θαηαζέηεη 

κηα πνιχ ελδηαθέξνπζα, αλ θαη ξηδνζπαζηηθή άπνςε: «Ζ δηαθνξεηηθφηεηα, ε 

πνιππινθφηεηα θαη ε πνιπζεκία ηεο αλζξψπηλεο θξίζεο είλαη ερζξνί ηεο ηερληθήο. 

Γεινηνπνηνχλ ηηο ζηαηηζηηθέο θαη ηηο δεκνζθνπήζεηο, ηα θαζηεξσκέλα ηεζη θαη ηνπο 

γξαθεηνθξάηεο.» Δδψ ν Πφζηκαλ δελ απνξξίπηεη, βεβαίσο, ζπιιήβδελ ηελ αμία ησλ 

πνζνηηθψλ δεδνκέλσλ, ηα νπνία ζε πνιιέο πεξηπηψζεηο απνηεινχλ ρξεζηκφηαην 

εξγαιείν ζην πιαίζην νπνηνπδήπνηε είδνπο έξεπλαο. Δμαίξεη φκσο ηε ρξήζε ησλ 

κεζφδσλ πνηνηηθήο αλάιπζεο, δειαδή εθείλσλ πνπ δελ ηνπνζεηνχλ ηνπο αλζξψπνπο ζε 

ζηελά «θνπηάθηα», ηα νπνία ζπκβνιίδνπλ θνηλά ραξαθηεξηζηηθά (ειηθία, θχιν, 

εηζφδεκα, θιπ.), αιιά αλαδεηνχλ ηελ ηδηαηηεξφηεηα κέζα ζην ζχλνιν. 

Σν Internet ελέρεη ηε δπλακηθή πνπ ζα ην θαηαζηήζεη σο ην πιένλ θαηάιιειν 

εξγαιείν πξνο απηή ηελ θαηεχζπλζε. Οη πνηνηηθέο εξεπλεηηθέο κέζνδνη, αλ θαη ην 

πξντφλ ηνπο είλαη ηδηαίηεξεο αμίαο, εηδηθά ζην πιαίζην ηνπ κάξθεηηλγθ, παξνπζηάδνπλ 
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ζεκαληηθά κεηνλεθηήκαηα: είλαη ρξνλνβφξεο θαη θνζηίδνπλ πνιχ πεξηζζφηεξν απφ ηηο 

πνζνηηθέο. Σν Γηαδίθηπν φκσο ζαο πξνζθέξεη ηε δπλαηφηεηα κε πνιχ ρακειφηεξν 

θφζηνο θαη ζε πνιχ ιηγφηεξν ρξφλν λα γλσξίζεηε ηνπο πειάηεο ζαο. Γη’ απηφ, ηελ 

επφκελε θνξά πνπ ζα ιάβεηε e-mail απφ πειάηε ζαο, δηαβάζηε ην θαη απαληήζηε 

εμίζνπ πξνζεθηηθά. Μπνξεί λα ζαο πξνζθέξεη πνιχ πην ρξήζηκεο πιεξνθνξίεο απφ ηα 

«θνπηάθηα». Δθείλν γηα ην νπνίν ζίγνπξα ζα ζαο πείζεη ζα είλαη γηα ηε κνλαδηθφηεηα 

θαη ηελ ηδηαηηεξφηεηα πνπ ραξαθηεξίδεη φινπο ηνπο ρξήζηεο -θαη θαζέλαλ μερσξηζηά- 

απηνχ ηνπ ραψδνπο, παγθφζκηνπ δηθηχνπ επηθνηλσλίαο πνπ νλνκάδεηαη Internet. 
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4. ΓΗΜΟ΢ΙΔ΢ ΢ΥΔ΢ΔΙ΢ ΢ΣΟ INTERNET 

 

 

Δθφζνλ νη δεκφζηεο ζρέζεηο έρνπλ λα θάλνπλ θπξίσο κε ηελ αλζξψπηλε 

επηθνηλσλία θαη ηελ αληαιιαγή πιεξνθνξίαο, ην Γηαδίθηπν θαίλεηαη ην ηδαληθφηεξν 

κέζν γηα ηελ πξαγκαηνπνίεζε ησλ ζηφρσλ ηνπο. ΢χκθσλα κε ην βξεηαληθφ Ηλζηηηνχην 

Γεκφζησλ ΢ρέζεσλ (IPR), δεκφζηεο ζρέζεηο είλαη «ε νξγαλσκέλε θαη δηαξθήο 

πξνζπάζεηα γηα ηε δεκηνπξγία θαη ηε δηαηήξεζε θαιήο ζέιεζεο θαη ακνηβαίαο 

θαηαλφεζεο κεηαμχ ελφο νξγαληζκνχ θαη ησλ δηάθνξσλ θαηεγνξηψλ ηνπ θνηλνχ ηνπ». 

Αθξηβψο επεηδή ην Internet πξνζθέξεη ηε δπλαηφηεηα ηαρείαο θαη ζπλερνχο ξνήο 

πιεξνθνξηψλ, κπνξεί λα απνηειέζεη πνιχ ηζρπξφ εξγαιείν γηα θάζε ιεηηνπξγία 

δεκφζησλ ζρέζεσλ. 

Γηα παξάδεηγκα, ην ειεθηξνληθφ ηαρπδξνκείν κπνξεί πξαγκαηηθά λα ιχζεη ηα ρέξηα 

ησλ ηκεκάησλ Γεκφζησλ ΢ρέζεσλ απφ άπνςε φρη κφλν απνηειεζκαηηθφηεηαο αιιά θαη 

θφζηνπο. Σα έγγξαθα πνπ απνζηέιινληαη ζε κεληαία βάζε απφ έλα ηκήκα δεκφζησλ 

ζρέζεσλ αθνξνχλ θπξίσο δειηία ηχπνπ αιιά θαη πξνζθιήζεηο γηα δηάθνξεο 

εθδειψζεηο. Καη νη δχν απηέο ιεηηνπξγίεο ζα κπνξνχζαλ λα εθηεινχληαη ζε ειάρηζην 

ρξφλν θαη ζε ςεθηαθή κνξθή. Δηδηθά γηα ηνπο δεκνζηνγξάθνπο, ηα ςεθηαθά δειηία 

ηχπνπ είλαη ηδηαίηεξα ρξήζηκα, θαζψο πξνζθέξνληαη γηα άκεζε επεμεξγαζία - ελψ ζηελ 

θιαζηθή κνξθή ηνπο ν δεκνζηνγξάθνο ζα έπξεπε λα ηα πιεθηξνινγήζεη ζηνλ 

ππνινγηζηή ηνπ θαη κεηά λα ηα δηακνξθψζεη ζε είδεζε. ΢ηελ πεξίπησζε ησλ 

ςεθηαθψλ πξνζθιήζεσλ, ζα ππήξρε ζεκαληηθή νηθνλνκία ρξφλνπ, θαζψο δε ζα 

κεζνιαβνχζε ε απνζηνιή ηνπο κε ην ηαρπδξνκείν. Ζ θαζπζηεξεκέλε απνζηνιή 

πξνζθιήζεσλ είλαη ζχλεζεο θαηλφκελν γηα ηε ζπληξηπηηθή πιεηνλφηεηα ησλ ηκεκάησλ 

Γεκφζησλ ΢ρέζεσλ, γηα ιφγνπο πνπ νθείινληαη θαη ζε δηθή ηνπο έιιεηςε νξγάλσζεο 

αιιά θαη ζε έιιεηςε νξγάλσζεο ησλ ηαρπδξνκείσλ. Ζ έγθαηξε απνζηνιή ηνπο κε 

ζπκβαηηθά κέζα ζα εμαζθαιηδφηαλ κφλν κε ηε ρξήζε θνχξηεξ, αιιά ζηελ πεξίπησζε 

πνπ νη παξαιήπηεο είλαη αξθεηνί, ην θφζηνο είλαη πξάγκαηη απαγνξεπηηθφ. 

Οη φπνηεο αληηξξήζεηο ζρεηηθά κε ηηο ςεθηαθέο πξνζθιήζεηο ίζσο εληνπίδνληαη ζην 

ζέκα ηεο αηζζεηηθήο ηνπο. Πνιιέο θνξέο νη έληππεο πξνζθιήζεηο είλαη πξάγκαηη κηθξά 

ζαχκαηα αηζζεηηθήο. Απηφ φκσο δε ζεκαίλεη φηη νη αληίζηνηρεο ςεθηαθέο ζα είλαη 

νπσζδήπνηε αθαιαίζζεηεο - αληίζεηα, ηα λέα εξγαιεία ζρεδίαζεο θαη animation ζάο 
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πξνζθέξνπλ φιεο ηηο δπλαηφηεηεο γηα ηε δεκηνπξγία πξσηφηππσλ θαη θαιαίζζεησλ 

πξνζθιήζεσλ. 

Ζ νξγάλσζε ηεο δνπιεηάο ζαο κε παξφκνην ηξφπν πξνυπνζέηεη ηελ θαηάξηηζε 

ιίζηαο κε φινπο φζνη δηαζέηνπλ e-mail address, μερσξηζηήο γηα θάζε πεξίπησζε 

(δειαδή κίαο φπνπ ζα αλαθέξνληαη φινη νη δεκνζηνγξάθνη κε ηνπο νπνίνπο 

ζπλεξγάδεζηε, άιιεο πνπ ζα πεξηιακβάλεη φινπο ηνπο αλζξψπνπο ζηνπο νπνίνπο 

ζπλήζσο ζηέιλεηε πξνζθιήζεηο, θ.ν.θ.). Όιεο απηέο νη ειεθηξνληθέο δηεπζχλζεηο 

κπνξνχλ λα ζπκπεξηιεθζνχλ ζην address book ηνπ browser ζαο, θαιφ φκσο είλαη λα 

ππάξρνπλ θαη ζηε κνξθή πνπ πξναλαθέξζεθε. Ζ θαηάξηηζε κηαο ιίζηαο ηέηνηνπ είδνπο 

πξνυπνζέηεη ζρεηηθή έξεπλα πξνθεηκέλνπ λα κάζεηε πνηνη απφ ηνπο ζπλεξγάηεο ζαο 

δηαζέηνπλ ειεθηξνληθή δηεχζπλζε. Δίλαη πνιχ πηζαλφ λα εθπιαγείηε, ηειηθά, κε ην 

πφζνη δελ έρνπλ ζθεθηεί λα ρξεζηκνπνηνχλ ην ειεθηξνληθφ ηαρπδξνκείν θαη' απηφ ηνλ 

ηξφπν. 

Σν e-mail κπνξεί λα ρξεζηκεχζεη θαη γηα ηελ απνζηνιή ελφο εβδνκαδηαίνπ (ή 

κεληαίνπ - εζείο ζα θξίλεηε ηελ πεξηνδηθφηεηα ηνπ) newsletter, πνπ ζα πεξηιακβάλεη ηηο 

δξαζηεξηφηεηεο θαη ηα λέα ηεο εηαηξείαο ζαο. To newsletter κπνξεί λα βξίζθεηαη θαη ζε 

απιή κνξθή text, γεγνλφο πνπ θαη εζάο δηεπθνιχλεη, εθφζνλ είλαη πνιχ εχθνιε ε 

ζχληαμε ηνπ, θαη δε κεηψλεη ηελ πιεξνθνξηαθή αμία ηνπ. Δπίζεο, θξνληίζηε ψζηε ε 

πξνζσπηθή e-mail address ή/θαη ε ειεθηξνληθή δηεχζπλζε ηεο εηαηξείαο ζαο λα 

αλαθέξνληαη ζηηο επαγγεικαηηθέο θάξηεο ζαο. Με απηφ ηνλ ηξφπν δηεπθνιχλεηε ηελ 

επηθνηλσλία κε φζνπο επηζπκνχλ λα έξζνπλ ζε επαθή καδί ζαο κε απηφ ηνλ ηξφπν, ελψ 

ηαπηφρξνλα δείρλεηε φηη ε εηαηξεία ζαο παξαθνινπζεί θαη ελεκεξψλεηαη ζρεηηθά κε ηηο 

εμειίμεηο ζηηο λέεο ηερλνινγίεο. 

Όζνλ αθνξά ηα ειεθηξνληθά δειηία ηχπνπ, πνιιέο εηαηξείεο αθνινπζνχλ κηα 

αθφκε θαιχηεξε ζηξαηεγηθή: δηαηεξνχλ μερσξηζηή ζειίδα αξρεηαθήο κνξθήο, 

δηαζέηνληαο φια ηα δειηία ηχπνπ ηνπο online. Έλα ηέηνην παξάδεηγκα είλαη ε ζρεηηθή 

ζειίδα ηεο OTEnet (εηθ. 4.1). 
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Δικόνα 4.1: Σα ςεθηαθά δειηία ηεο OTEnet. 

 

 

Ζ δηαηήξεζε ηεο ρξνλνινγηθήο ηεξάξρεζεο ησλ δειηίσλ είλαη πνιχ ζεκαληηθή, 

θαζψο δηεπθνιχλεη ηελ αλεχξεζε ηνπο θαη απνηειεί έλαλ ηξφπν παξνπζίαζεο ηεο 

ηζηνξίαο ηεο εηαηξείαο κέρξη ζήκεξα. Μηα ηέηνηα ζειίδα web δελ είλαη ρξήζηκε κφλν 

ζην εμσηεξηθφ αιιά θαη ην εζσηεξηθφ θνηλφ ζαο. Κάζε ππάιιεινο ηεο εηαηξείαο πνπ 

ρξεηάδεηαη λα αλαηξέμεη ζε θάπνην δειηίν ηχπνπ δε ρξεηάδεηαη λα απεπζπλζεί ζην 

ηκήκα Γεκφζησλ ΢ρέζεσλ, αιιά κπνξεί λα αλαθηήζεη ηελ πιεξνθνξία πνπ επηζπκεί 

απεπζείαο. 

Απφ ηε ζειίδα ηεο OTEnet ν επηζθέπηεο κπνξεί λα ελεκεξσζεί επίζεο γηα 

δηάθνξεο εθδειψζεηο (εθζέζεηο, ζπλέδξηα, νκηιίεο, θ.ά.) πνπ πξαγκαηνπνηνχληαη απφ 

πνηθίινπο θνξείο κε δηάθνξα ζέκαηα ζηελ Διιάδα θαη ζην εμσηεξηθφ (εηθ.4.2). Χο 
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θίλεζε δεκφζησλ ζρέζεσλ ε ζπγθεθξηκέλε είλαη πνιχ απνηειεζκαηηθή, γηαηί 

εμππεξεηεί ηελ αλάγθε ησλ ρξεζηψλ γηα επηπιένλ πιεξνθνξία. Ζ ελεκέξσζε πνπ 

παξέρεη είλαη αθφκα πην ρξήζηκε, γηαηί αθνξά ζηνηρεία πνπ είλαη πνιχ δχζθνιν λα 

βξεζνχλ ζπγθεληξσκέλα έηζη φπσο παξνπζηάδνληαη εδψ. 

 

  

 

  

Δικόνα 4.2: Δλεκεξσζείηε γηα δηάθνξεο εθδειψζεηο απφ ηε ζειίδα ηεο ΟΣΔnet. 
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Δικόνα 4.3: Οη θσηνγξαθίεο απφ ηα εγθαίληα ηνπ θέληξνπ. 

 

 

 

 

Μηα ζειίδα πνπ δηαζέηεη ηε δπλακηθή γηα απνηειεζκαηηθέο ειεθηξνληθέο δεκφζηεο 

ζρέζεηο – αιιά κάιινλ απνηπγράλεη – είλαη εθείλε ηνπ θέληξνπ Λφγνπ θαη Σέρλεο 104 

ησλ Δθδφζεσλ Καζηαληψηε. Χο πνιηηηζηηθφ ζηέθη ην Κέληξν πξαγκαηνπνηεί πνιιέο 

αμηφινγεο θαη ελδηαθέξνπζεο εθδειψζεηο, πνπ ζα άμηδε λα πξνβιεζνχλ κέζσ ηεο 

ζειίδαο ηνπ. Γπζηπρψο, ε ζειίδα δίλεη ηελ εληχπσζε φηη δεκηνπξγήζεθε απνθιεηζηηθά 

γηα ηα εγθαίληα ηνπ Κέληξνπ (θπξίσο γηαηί δελ έρεη ελεκεξσζεί απφ ηφηε) (εηθ. 4.3). 
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Όζνη, δε, πεξηκέλεηε λα βξείηε online ην πξφγξακκα εθδειψζεσλ (θαη είλαη 

θπζηθφ, εθφζνλ έρεηε ηε δπλαηφηεηα λα θάλεηε θιηθ ζηελ επηινγή «Πξφγξακκα») ζα 

βξεζείηε κπξνζηά ζην πξφγξακκα ηνπ κελφο Μαξηίνπ - πνηνπ έηνπο δε δηεπθξηλίδεηαη. 

Δάλ θάλεηε θιηθ ζηελ επηινγή «Γειηία Σχπνπ», εθείλν πνπ ζίγνπξα δελ ζα βξείηε 

είλαη δειηία ηχπνπ. Απηά πνπ έρνπλ θαηεγνξηνπνηεζεί σο δειηία είλαη ζθαλαξηζκέλα 

δεκνζηεχκαηα ηνπ ηχπνπ ζρεηηθά κε ηα εγθαίληα ηνπ Κέληξνπ. Σν αηζζεηηθφ 

απνηέιεζκα εηδηθά απηήο ηεο ζειίδαο είλαη κάιινλ απνγνεηεπηηθφ, εθηφο ηνπ φηη 

μαθληάδεη ηνλ επηζθέπηε κε ην ζνβαξφ ιάζνο ηεο «βάθηηζεο» ησλ δεκνζηεπκάησλ ζε 

δειηία (εηθ. 4.4). 

 

Δικόνα 4.4 : Σα δειηία πνπ δελ είλαη δειηία. 

 

Όπσο πξναλαθέξζεθε, ε ζπγθεθξηκέλε ζειίδα ελέρεη ηε δπλακηθή λα απνηειεί έλα 

πνιχ απνηειεζκαηηθφ «press kiosk», έλα ςεθηαθφ θέληξν πιεξνθνξίαο γηα 

δεκνζηνγξάθνπο. ΢ε ηδαληθέο ζπλζήθεο, ν δεκνζηνγξάθνο πνπ ζα ελδηαθεξφηαλ γηα 

θάπνηα εθδήισζε ηνπ Κέληξνπ ζα κπνξνχζε λα αλαηξέμεη ζηα ζρεηηθά δειηία ηχπνπ 

(πνπ ζα εκθαλίδνληαλ ζε κνξθή θαη δνκή παξφκνηα κε εθείλε ησλ αληίζηνηρσλ ηεο 

OTEnet), λα ελεκεξσζεί γηα ην πξφγξακκα ηνπ ηξέρνληνο κελφο, αθφκα θαη λα 
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θαηεβάζεη ζηνλ ππνινγηζηή ηνπ θσηνγξαθίεο απφ πξνεγνχκελεο εθδειψζεηο (πνπ ζα 

κπνξνχζαλ λα ήηαλ θαηεγνξηνπνηεκέλεο ζε ζεκαηηθέο ελφηεηεο, π.ρ. Stand Up 

Comedy, Παξνπζηάζεηο Βηβιίσλ, Θεαηξηθέο Παξαζηάζεηο, θιπ.). Σν αληηθείκελν ηνπ 

Κέληξνπ είλαη ηέηνην ψζηε πξαγκαηηθά παξέρεη πνιιέο δπλαηφηεηεο φζνλ αθνξά ηφζν 

ην ζρεδηαζκφ ηεο ζειίδαο φζν θαη ηελ παξνρή επηπιένλ πιεξνθνξίαο (π.ρ., ζθεθηείηε 

ην εχξνο ησλ αρατθψλ κε πνιηηηζκφ links πνπ ζα κπνξνχζαλ λα ζπκπεξηιεθζνχλ ζην 

site). 

Οη ηδέεο γηα δεκηνπξγηθέο δεκφζηεο ζρέζεηο ζην Internet είλαη πξάγκαηη πνιιέο θαη 

νη δπλαηφηεηεο ηνπ αθφκα πεξηζζφηεξν. Ήδε ην Γηαδίθηπν ρξεζηκνπνηείηαη γηα πνιχ 

πην ζχλζεηεο πξαθηηθέο δεκφζησλ ζρέζεσλ, φπσο είλαη νη ζπλεληεχμεηο ηχπνπ online. 

Άιιν έλα θνκκάηη ησλ δεκφζησλ ζρέζεσλ πνπ παξνπζηάδεη ηδηαίηεξν ελδηαθέξνλ, 

εηδηθά φηαλ ζπλδέεηαη κε ηελ πξαθηηθή ηνπ ζην Internet, είλαη ην crisis management, ην 

νπνίν ζα εμεηαζηεί μερσξηζηά. 

 

 

 

4.1 Crisis Management 

 

Ζ πνξεία ηεο εηαηξείαο ζαο είλαη ζίγνπξν φηη δε ζα είλαη ζπαξκέλε κε ξφδα. Απηφ 

ζεκαίλεη φηη θάπνηα ζηηγκή ζα αληηκεησπίζεη αλαπφθεπθηα κηθξέο ή κεγαιχηεξεο 

θξίζεηο, πνπ ζα έρνπλ λα θάλνπλ κε ην εμσηεξηθφ (πειάηεο, θαηαλαισηέο, 

πξνκεζεπηέο, θιπ.) ή κε ην εζσηεξηθφ (πξνζσπηθφ ηεο εηαηξείαο) θνηλφ ηεο. Με ηνλ 

φξν θξίζε λνείηαη θάζε ζπκβάλ ή θαηάζηαζε πνπ κπνξεί λα βιάςεη ηε ζπλνιηθή 

εηθφλα ηεο εηαηξείαο ζαο, ηε ζέζε ηεο ζηελ αγνξά, ην θχξνο θαη ηελ αμηνπηζηία ηεο 

απέλαληη ζηνπο πειάηεο, ηνπο ζπλεξγάηεο θαη πξνζσπηθφ ηεο. 

Οη αηηίεο ησλ θξίζεσλ πνηθίιινπλ θαη κπνξεί λα ζρεηίδνληαη κε νηθνλνκηθά 

πξνβιήκαηα ηεο εηαηξείαο, κε ζέκαηα πνηφηεηαο ησλ πξντφλησλ ηεο, κε αηηήκαηα ή 

θηλήζεηο ηνπ πξνζσπηθνχ ηεο πνπ πξνθαινχλ ή κπνξεί λα πξνθαιέζνπλ πξφβιεκα ζηε 

ζπλνιηθή ιεηηνπξγία ηεο εηαηξείαο, θ.ά. 

΢ε κεγάιν πνζνζηφ, νη κεγάιεο εηαηξείεο - ζπλήζσο νη πνιπεζληθέο- δηαζέηνπλ 

εμεηδηθεπκέλα ηκήκαηα γηα ην ρεηξηζκφ θξίζεσλ, ηα νπνία ππάγνληαη νξγαληθά ζην 

ηκήκα Γεκφζησλ ΢ρέζεσλ ή ζην ηκήκα Μάξθεηηλγθ. Σα ζπγθεθξηκέλα ηκήκαηα είλαη 

ππεχζπλα φρη κφλν γηα ηνλ απνηειεζκαηηθφ ρεηξηζκφ ησλ θξίζεσλ αιιά θαη γηα ηελ 
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πξφιεςε ηνπο. Γη' απηφ ην ιφγν ηα ζηειέρε ηνπο είλαη ζπλήζσο εμεηδηθεπκέλα αθξηβψο 

ζε απηφ ζηνλ ηνκέα θαη δηαζέηνπλ ηελ ηθαλφηεηα λα «νζκίδνληαη» ηηο θξίζεηο πξνηνχ 

αθφκε εθείλεο ζπκβνχλ. Δηδηθά ε ηειεπηαία ηθαλφηεηα απαηηεί βαζηά γλψζε ηεο 

θνπιηνχξαο ηεο εηαηξείαο θαη ησλ ιεηηνπξγηψλ ηεο, ηνπ αληαγσληζκνχ, ηεο αγνξάο θαη 

φισλ ησλ πηζαλψλ παξαγφλησλ πνπ κπνξεί λα επεξεάζνπλ ην status quo ηεο. 

΢χκθσλα κε ηνλ Marconi, ππάξρνπλ δέθα βαζηθέο αξρέο γηα ηνλ απνηειεζκαηηθφ 

ρεηξηζκφ κηαο θξίζεο: 

 

 

1) Γηαιέμηε έλαλ εθπξφζσπν. 

2) Μελ ππεξβαίλεηε ηελ αμηνπηζηία ζαο. 

3) Κνηλνπνηήζηε ην πξφβιεκα πξνηνχ θνηλνπνηεζεί απφ θάπνηνλ άιιν. 

4) Γλσζηνπνηήζηε ηη έρεηε θάλεη γη' απηφ. 

5) Πξνβιέςηε ηε ρεηξφηεξε δπλαηή εμέιημε. 

6) Γλσζηνπνηήζηε ηε ζέζε ζαο κε αλαθνηλψζεηο ζηνλ ηχπν, πιεξσκέλεο 

θαηαρσξίζεηο θαη ηε βνήζεηα ηνπ εθπξνζψπνπ ζαο. 

7) Μελ αθήλεηε ηνλ εθπξφζσπν ζαο λα θιέςεη ηελ παξάζηαζε απφ ην κήλπκα 

ζαο. 

8) Να βξίζθεζηε πάληα ζε θαιή θαηάζηαζε πξηλ απφ ηελ θξίζε. 

9) Γερηείηε ηε ζπκβνπιή επαγγεικαηηψλ. 

10)   Γξάςηε ηε δηθή ζαο εθδνρή ηεο ηζηνξίαο. 

 

 

Μέζσ ησλ αλσηέξσ αξρψλ κπνξεί θάπνηνο λα δηαπηζηψζεη φηη ην Internet είλαη ην 

πιένλ ηδαληθφ κέζν γηα ηελ αληηκεηψπηζε θξίζεσλ πξψηνλ θαη θπξηφηεξν, γηαηί 

πξνζθέξεη ηελ ακεζφηεηα πνπ απαηηείηαη ζε ηέηνηεο πεξηπηψζεηο. Ζ ειεθηξνληθή 

ζειίδα ζαο απνηειεί ην ηδαληθφ φρεκα γηα φιεο ηηο πιεξνθνξίεο πνπ επηζπκείηε λα 

θνηλνπνηήζεηε, θαζψο δελ ππάξρνπλ πεξηνξηζκνί ρψξνπ ή ρξφλνπ, φπσο ζηελ 

πεξίπησζε ησλ αλαινγηθψλ κέζσλ καδηθήο ελεκέξσζεο. Οη πιεξνθνξίεο απηέο 

κπνξνχλ λα δηνρεηεπηνχλ γξήγνξα θαη λα κεηαθέξνπλ πξνο ηα έμσ ηε «δηθή ζαο 

εθδνρή ηεο ηζηνξίαο», πξνηνχ απηή ηπρφλ δηαζηξεβισζεί απφ ηνλ αληαγσληζκφ ή ηα 

ΜΜΔ. Δπίζεο κπνξνχλ λα αλαλεσζνχλ εμίζνπ γξήγνξα, πξαγκαηηθά παξάιιεια κε 

ηελ εμέιημε ηεο θξίζεο. Οη άκεζα ζηγφκελνη (αλάινγα κε ηελ πεξίζηαζε, απηνί κπνξεί 

λα είλαη νη πειάηεο ζαο, νη ζπλεξγάηεο ζαο ή θαη φινη καδί) έρνπλ ηε δπλαηφηεηα 
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επηθνηλσλίαο κέζσ e-mail θαη ιήςεο εμαηνκηθεπκέλεο απάληεζεο. Σέινο, ν νξηζκφο 

εθπξνζψπνπ ζην Internet είλαη νπζηαζηηθά αλψθεινο, θαζψο ηελ θξίζε ζε απηή ηελ 

πεξίπησζε ηε ρεηξίδεηαη κηα νιφθιεξε νκάδα ζηειερψλ ηεο εηαηξείαο ζαο, απφ web 

masters κέρξη εηδηθνί δεκφζησλ ζρέζεσλ. ΢ην Γηαδίθηπν εθπξφζσπνο ηεο εηαηξείαο ζαο 

είλαη ε ειεθηξνληθή ζειίδα ηεο. ΢ην Γηαδίθηπν ε εηαηξεία ζαο εθηίζεηαη ζπλνιηθά θαη 

δνπιεχεη ζπιινγηθά. Γη' απηφ θαη ην πξφζσπν πνπ βγάδεη πξνο ηα έμσ αλ βέβαηα 

ρεηξίδεηαη κε ζσζηφ ηξφπν ηελ θξίζε- είλαη απηφ ηεο ελφηεηαο θαη ηνπ 

απνηειεζκαηηθνχ ζπληνληζκνχ. 
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5. ΛΟΓΟΙ ΠΟΤ ΓΗΜΙΟΤΡΓΗ΢ΑΜΔ ΣΗΝ Ι΢ΣΟ΢ΔΛΙΓΑ ΣΗ΢ 

«ΛΟΓΙ΢ΣΙΚΗ΢ ΒΟΡΔΙΟΤ ΔΛΛΑΓΟ΢» 

 

 

Ζ ηζηνζειίδα ηεο «Λνγηζηηθήο Βνξείνπ Διιάδνο» δεκηνπξγήζεθε δηφηη ηα 

πιενλεθηήκαηα ηνπ ειεθηξνληθνχ εκπνξίνπ θαη ηνπ Μάξθεηηλγθ κέζσ Γηαδηθηχνπ 

είλαη αζθαιψο επηθξαηέζηεξα απφ ηα κεηνλεθηήκαηα. 

Με απηφλ ηνλ ηξφπν επηηπγράλεηαη ε κέγηζηε δπλαηή πξνζέιθπζε πειαηψλ θαζψο 

ε εηαηξία κέζσ ηνπ Γηαδηθηχνπ ιεηηνπξγεί ζε 24σξε βάζε, 7 εκέξεο ηελ εβδνκάδα. 

Αξθεί κεησκέλνο αξηζκφο πξνζσπηθνχ θαζψο δελ πθίζηαηαη ε αλάγθε πξνζσπηθήο 

παξνπζίαο γηα ηε ιήςε πιεξνθνξηψλ θαη ηελ επεμεξγαζία ησλ πιεξσκψλ θαη ησλ 

ινηπψλ ππεξεζηψλ. Οη εληνιέο κπνξνχλ λα γίλνπλ αληηθείκελα επεμεξγαζίαο On – Line  

ζε πξαγκαηηθφ ρξφλν ή Off – Line νκαδνπνηεκέλεο. 

Δπίζεο, εθφζνλ νη πξαθηηθέο ειεθηξνληθνχ εκπνξίνπ δελ πεξηνξίδνληαη 

γεσγξαθηθά, ε επηρείξεζε κπνξεί λα ιεηηνπξγεί φρη κφλν ζε ηνπηθφ επίπεδν αιιά 

παλειιήληα. 

Ζ «Λνγηζηηθήο Βνξείνπ Διιάδνο» κπνξεί λα έρεη βειηησκέλε αληαγσληζηηθφηεηα, 

παξνρή εμεηδηθεπκέλσλ ππεξεζηψλ ζηνπο πειάηεο αιιά θαη λέεο επηρεηξεκαηηθέο 

επθαηξίεο άξα λέα θεθάιαηα θαη αχμεζε ησλ θεξδψλ θαη φια απηά άκεζα θαζψο ε 

επηρείξεζε «έξρεηαη» θνληά ζηνλ πειάηε. Οη αλάγθεο γηα ηελ εμππεξέηεζε ηνπ πειάηε 

θαιχπηνληαη ηαρχηαηα θαζψο ππάξρεη ζκίθξπλζε ηεο αιπζίδαο πιεξνθνξηψλ. 

Όια απηά δεκηνπξγνχλ κεγάιε εκπνξηθή πξφθιεζε θαζψο απηφο ν λένο ηξφπνο 

ζπλαιιαγψλ θαη επηθνηλσλίαο, πέξα απφ ην θέξδνο ρξφλνπ πνπ πξνζθέξεη, επηηξέπεη 

θαη ηε δπλαηφηεηα  εμππεξέηεζεο 2 ή θαη πεξηζζφηεξσλ πειαηψλ απεπζείαο. Οη 

ζπλαιιαγέο κπνξνχλ λα γίλνληαη κέζσ πηζησηηθψλ θαη ρξεσζηηθψλ θαξηψλ γεγνλφο 

πνπ ηηο θάλεη πην αζθαιείο. Σα πξαθηηθά ησλ ζπλαιιαγψλ δελ απνζεθεχνληαη ζε 

έγγξαθα αιιά απνζεθεχνληαη ζε ςεθηαθή κνξθή, θάηη πνπ έρεη ζαλ αληίθηππν ηελ 

εμνηθνλφκεζε ρψξνπ, ηε βειηίσζε ηνπ ειέγρνπ θαη ηελ άλνδν ηεο 

απνηειεζκαηηθφηεηαο.  

Δπί πξνζζέησο, ε ηζηνζειίδα απνηειεί κηα θαηλνηνκία ζην ρψξν ηεο ινγηζηηθήο 

θάηη πνπ δίλεη έλα θχξνο θαη κία βειηίσζε ηεο εηθφλαο θαη ηεο νξγάλσζεο ηεο 

επηρείξεζεο πνπ πξνθαιεί λένπο πειάηεο λα ζπλεξγαζηνχλ θαη αλ κείλνπλ 
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επραξηζηεκέλνη λα δηαδψζνπλ ηα ππέξ απηήο ηεο θαηλνηνκίαο ζε λένπο ππνςήθηνπο 

πειάηεο. 

Σέινο, ελλνείηαη φηη a priori ε επηρείξεζε ζα αλαπηπρζεί θαη ζηνλ ηνκέα δεκνζίσλ 

ζρέζεσλ θαζψο ζα επηηξέπεηαη ε αληαιιαγή απφςεσλ ησλ πειαηψλ θαη ζα ππάξρεη 

αλνηρηφο δηάινγνο γηα ηπρφλ βειηηψζεηο πνπ πξνηείλνπλ. Θα ππάξρεη δπλαηφηεηα λα 

ζηέιλνληαη νκαδηθά e – mail γηα λα πιεξνθνξήζνπλ ηνλ πειάηε (θαζψο ε εηαηξία ζα 

γλσξίδεη ην ειεθηξνληθφ ηαρπδξνκείν ησλ πειαηψλ ηεο) γηα ηελ θαηάζηαζε ησλ 

πιεξνθνξηψλ θαη ησλ ππεξεζηψλ πνπ ζέινπλ, ελψ ζα κπνξνχλ λα ιακβάλνπλ ηπρφλ 

πξνζθνξέο θαη αλαθνηλψζεηο ηφζν ηεο εηαηξίαο φζν θαη δηαθφξσλ θνξέσλ φπσο ιφγνπ 

ράξε ηνπ Τπνπξγείνπ Οηθνλνκηθψλ φηαλ ζα αιιάδεη θάηη ζην ζχζηεκα θνξνιφγεζεο ή 

ζηνλ Φ.Π.Α.  
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Μέπορ Β’ 
 

 

Γομή Σεσνικού Μέποςρ ηηρ Δπγαζίαρ. 

 

 

Σν ηερληθφ κέξνο απνηειείηαη απφ δχν θεθάιαηα. Ζ βηβιηνγξαθία θαη νη 

αλαθνξέο ζην δηαδίθηπν πνπ ρξεζηκνπνηήζεθαλ γηα ηε ζπγγξαθή ηνπ αλαθέξνληαη ζην 

ηέινο ηεο εξγαζίαο απηήο. (ζει. 91-93 ) 

 

Σν έθην θεθάιαην αλαθέξεηαη ζην Internet θαη ην World Wide Web. Παξέρεη 

πιεξνθνξίεο ζρεηηθέο κε ηελ ηζηνξία, ηελ ιεηηνπξγία ηνπο, ηα πξσηφθνιια πνπ 

ρξεζηκνπνηνχλ θαη ηηο ππεξεζίεο πνπ δηαζέηνπλ. 

 

  Αθφκα πεξηγξάθεη ηέζζεξα βαζηθά εξγαιεία πνπ ρξεζηκνπνηήζεθαλ γηα ηελ 

θαηαζθεπή ηεο ζπγθεθξηκέλεο εθαξκνγήο. Αξρηθά αλαθέξεηαη ζην Dreamweaver, έλα 

πξφγξακκα ηεο Macromedia, κε ηε βνήζεηα ηνπ νπνίνπ γίλεηαη εθηθηή ε θαηαζθεπή 

δηθηπαθψλ ηφπσλ. Πεξηιακβάλνληαη βαζηθέο νδεγίεο γηα ηελ θαηαζθεπή κηαο 

ηζηνζειίδαο κέζσ ηνπ πξνγξάκκαηνο απηνχ. ΢ηε ζπλέρεηα αθνινπζεί πεξηγξαθή ηνπ 

πξνγξάκκαηνο Flash θαη ησλ βαζηθψλ εξγαιείσλ ηνπ, ην νπνίν ρξεζηκνπνηείηαη γηα ηελ 

θαηαζθεπή animations θαη δηαινγηθψλ εθαξκνγψλ κε ηνλ ρξήζηε έρνληαο σο ζηφρν λα 

εκπινπηίζεη έλα δηθηπαθφ ηφπν. Σέινο παξαηίζεληαη πιεξνθνξίεο γηα ηα πξνγξάκκαηα 

Fireworks θαη Photoshop ηα νπνία ρξεζηκνπνηνχληαη γηα ηελ επεμεξγαζία θαη 

δηακφξθσζε γξαθηθψλ θαη εηθφλσλ.  

 

 

΢ην έβδνκν θεθάιαην ηνπ βηβιίνπ πεξηγξάθεηαη ε εθαξκνγή, ε νπνία είλαη έλαο 

δηθηπαθφο ηφπνο ελφο ινγηζηηθνχ γξαθείνπ κε ηελ επσλπκία “ΛΟΓΗ΢ΣΗΚΖ ΒΟΡΔΗΟΤ 

ΔΛΛΑΓΟ΢”. Παξνπζηάδνληαη νη βαζηθνί ζχλδεζκνη ηνπ δηθηπαθνχ ηφπνπ κε ηέηνην 

ηξφπν ψζηε λα γίλεηαη θαηαλνεηή ε δνκή ηνπ. 
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6.ΔΡΓΑΛΔΙΑ ΚΑΣΑ΢ΚΔΤΗ΢ Ι΢ΣΟ΢ΔΛΙΓΩΝ 

 

 

6.1 Dreamweaver 

 

 

 

 

Σν Macromedia Dreamweaver είλαη επαγγεικαηηθφο ζπληάθηεο HTML γηα ην 

ζρεδηαζκφ, ηελ θσδηθνπνίεζε, θαη ηε αλάπηπμε δηθηπαθψλ ρψξσλ, ηζηνζειίδσλ θαη 

δηαδηθηπαθψλ εθαξκνγψλ. Σν Dreamweaver είλαη θαηάιιειν θαη γηα εθείλνπο πνπ 

απνιακβάλνπλ ηελ δηα ρεηξφο θσδηθνπνίεζε αιιά θαη γηα φινπο ηνπο ππφινηπνπο πνπ 

πξνηηκνχλ ην νπηηθνπνηεκέλν  πεξηβάιινλ. Σν Dreamweaver παξέρεη ρξήζηκα 

εξγαιεία ηα νπνία εληζρχνπλ ηελ εκπεηξία ηεο δεκηνπξγίαο δηαδηθηπαθψλ εθαξκνγψλ. 

Πξνζθέξεη έλα ζχζηεκα επεμεξγαζίαο ην νπνίν ζπλδπάδεη ηελ παξαγσγηθφηεηα ηεο 

WYSIWYG (What You See Is What You Get/Απηφ πνπ βιέπεηο είλαη απηφ πνπ 

παίξλεηο) ζρεδίαζεο κε ηνλ έιεγρν ηεο εχθνιεο δεκηνπξγίαο HTML θψδηθα.  

 

Απηφο ν ζπλδπαζκφο ήηαλ κνλαδηθφο ζηελ δεθαεηία ηνπ '90 θαη βνήζεζε ζηελ 

γξήγνξε θαη δηαδεδνκέλε  πηνζέηεζε ηνπ. ΢ήκεξα είλαη δηαζέζηκν γηα ηε MAC θαη ηα 

Windows θαη θξαηά πεξίπνπ ην 80% ηεο επαγγεικαηηθήο αγνξάο ζπληαθηψλ HTML. 

Σν Dreamweaver ζπρλά επηιέγεηαη γηα ηελ δεκηνπξγία αιιά θαη ηελ επεμεξγαζία 

πξνηχπσλ (templates). Δθηφο απφ ηελ εγγελή ππνζηήξημε γηα ηo MAC OS Υ θαη ηα 
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Windows, ην Dreamweaver κπνξεί επίζεο λα ηξέμεη ζε Unix-like πιαηθφξκεο κέζσ 

ηεο ρξήζεο ελφο εηδηθνχ ινγηζκηθνχ. 

 

Χο έλαο ζπληάθηεο πνπ πξνζθέξεη WYSIWYG ζρεδίαζε ην Dreamweaver 

κπνξεί λα θξχςεη ηηο ιεπηνκέξεηεο ηνπ HTML θψδηθα ησλ ζειίδσλ απφ ηνλ ρξήζηε, 

γεγνλφο πνπ θαζηζηά πηζαλή, γηα ηνπο κε εηδηθνχο, ηελ εχθνιε δεκηνπξγία 

ηζηνζειίδσλ. ΢πρλά απηή ε πξνζέγγηζε επηθξίλεηαη δεδνκέλνπ φηη παξάγνληαο ζειίδεο 

HTML πνπ είλαη πνιχ κεγαιχηεξεο απφ φηη ζα έπξεπε, κπνξεί λα πξνθιεζνχλ 

πξνβιήκαηα απφδνζεο ζηνπο web browsers. Απηφ κπνξεί λα ηζρχεη ελ κέξεη ηδηαίηεξα 

επεηδή ε εθαξκνγή θαζηζηά πνιχ εχθνιε ηελ δεκηνπξγία ελφο layout βαζηζκέλν ζηνπο 

πίλαθεο. Δπηπιένλ, ζην παξειζφλ ην Dreamweaver  έρεη επηθξηζεί γηα ην φηη παξάγεη 

θψδηθα πνπ ζπρλά δελ ζπκκνξθψλεηαη κε ηα W3C πξφηππα.  

 

Σν Dreamweaver ππνζηεξίδεη ηνπο πεξηζζφηεξνπο web browsers γηα ηελ 

πξνεπηζθφπεζε ησλ ζειίδσλ. Έρεη επίζεο θάπνηα θαιά εξγαιεία δηαρείξηζεο γηα 

αξράξηνπο φπσο γηα παξάδεηγκα ηελ δπλαηφηεηα λα βξεζνχλ θαη λα αληηθαηαζηαζνχλ 

νη γξακκέο θεηκέλνπ ή θψδηθα κε νπνηεζδήπνηε θαζνξηζκέλεο παξακέηξνπο, ζε 

νπνηνδήπνηε ζεκείν ηεο εθαξκνγήο. Αθφκε παξέρεη ηελ δπλαηφηεηα γηα δεκηνπξγία 

βαζηθνχ JavaScript ρσξίο νπνηαδήπνηε γλψζε θσδηθνπνίεζεο.  

 

Με ηελ εκθάληζε ηεο έθδνζεο MX, ε Macromedia ελζσκάησζε ζην 

Dreamweaver εξγαιεία δεκηνπξγίαο δπλακηθνχ πεξηερνκέλνπ. ΢ην πλεχκα ησλ HTML 

WYSIWYG εξγαιείσλ, επηηξέπεηε ζηνπο ρξήζηεο ε ζχλδεζε κε βάζεηο δεδνκέλσλ, κε 

θίιηξα θαη ε εκθάληζε πεξηερνκέλσλ  ρξεζηκνπνηψληαο ηερλνινγίεο φπσο νη PHP, 

ASP, θαη ASP.net, ρσξίο νπνηαδήπνηε πξνεγνχκελε εκπεηξία πξνγξακκαηηζκνχ. 

 

΢ην Dreamweaver, ε ιέμε site  ρξεζηκνπνηείηαη σο ζηελνγξαθία γηα λα αλαθεξζεί 

ζε νπνηνδήπνηε απφ ηα αθφινπζα:  

 

 Έλαο δηαδηθηπαθφο ηφπνο (website): έλα ζχλνιν ζειίδσλ ζε έλαλ θεληξηθφ 

ππνινγηζηή, πνπ πξνζπειαχλνληαη απφ έλαλ επηζθέπηε κε ηελ ρξήζε ελφο web 

browser. 
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 Έλαο απνκαθξπζκέλνο δηαδηθηπαθφο ηφπνο: ηα αξρεία ζε έλαλ  θεληξηθφ 

ππνινγηζηή πνπ απνηεινχλ έλαλ δηαδηθηπαθφ ηφπν, απφ ηελ  νπηηθή γσλία ηνπ 

ζρεδηαζηεί παξά απφ απηή ηνπ επηζθέπηε. 

 Έλαο ηνπηθφο δηαδηθηπαθφο ηφπνο: ηα αξρεία ζε έλαλ ηνπηθφ δίζθν πνπ 

αληηζηνηρνχλ ζηα αξρεία ζηνλ απνκαθξπζκέλν  δηαδηθηπαθφ ηφπν. ΢πλήζσο ζην 

Dreamweaver  πξψηα επεμεξγάδνληαη ηα αξρεία ζηνλ ηνπηθφ δίζθν θαη ζηελ 

ζπλέρεηα θνξηψλνληαη ζηνλ απνκαθξπζκέλν δηαδηθηπαθφ ηφπν. 

 Έλαο δηαδηθηπαθφο ηφπνο θαζνξηζκψλ ηεο Dreamweaver : έλα ζχλνιν 

ραξαθηεξηζηηθψλ θαζνξηζκνχ γηα έλαλ ηνπηθφ δηαδηθηπαθφ ηφπν, ζπλ ηηο 

πιεξνθνξίεο γηα ηνλ ηξφπν κε ηνλ νπνίν ν ηνπηθφο δηαδηθηπαθφο ηφπνο 

αληηζηνηρεί ζηνλ απνκαθξπζκέλν δηαδηθηπαθφ ηφπν.  

 

6.1.1 Δπιλέγονηαρ σώπο επγαζίαρ 

΢ηα Windows, ηελ πξψηε θνξά πνπ αλνίγνπκε ην Dreamweaver, εκθαλίδεηαη ην 

θάησζη παξάζπξν δηαιφγνπ ζην νπνίν επηιέγνπκε ηνλ ρψξν εξγαζίαο.  
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Δάλ ζέινπκε λα επηιέμνπκε αξγφηεξα κπνξνχκε λα ην θάλνπκε επηιέγνληαο Edit > 

Preferences > General > Change WorkSpace. 

 

 

 

 

Γηα λα επηιέμνπκε ρψξν εξγαζίαο επηιέγνπκε κηα απφ ηηο παξαθάησ επηινγέο: 

 

Designer : Δίλαη έλαο ελζσκαησκέλνο ρψξνο εξγαζίαο πνπ ρξεζηκνπνηεί MDI 

(Multiple Document Interface), ηα Document windows θαη ηα panels είλαη 

ελζσκαησκέλα κέζα ζε έλα κεγαιχηεξν παξάζπξν εθαξκνγψλ, κε ηα panel groups 

ηνπνζεηεκέλα ζηελ δεμηά πιεπξά ηνπ. Απηή ε επηινγή πξνηείλεηε γηα ηνπο 

πεξηζζφηεξνπο ρξήζηεο. 
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Coder : Πξφθεηηαη γηα ηνλ ίδην ελζσκαησκέλν ρψξν εξγαζίαο, κε ηελ δηαθνξά φηη ηα 

panel groups είλαη ηνπνζεηεκέλα ζηα αξηζηεξά, κία εκθάληζε παξφκνηα κε απηή πνπ 

ρξεζηκνπνηείηαη ζην Macromedia HomeSite θαη ζην Macromedia ColdFusion Studio, 

επίζεο ζην Document window ε εμνξηζκνχ επηινγή εκθάληζεο είλαη ε code view. 

Απηή ε επηινγή  ζπληζηάηαη ζε ρξήζηεο ηνπ HomeSite ή ηνπ ColdFusion Studio θαη ζε 

εθείλνπο ηνπο ρξήζηεο πνπ ρξεζηκνπνηνχλ ηελ δηα ρεηξφο  θσδηθνπνίεζε έηζη ψζηε λα 

είλαη πην εμνηθεησκέλνη κε ην πεξηβάιινλ. 

 

6.1.2 Δπιζκόπηζη ηος Menu  

Σν File κελνχ θαη ην Edit κελνχ πεξηέρνπλ ηηο ζπλήζεηο επηινγέο πνπ πεξηέρνπλ 

απηά ηα menu, φπσο New (Νέν), Open (Άλνηγκα), Save (Απνζήθεπζε), Save All 

(Απνζήθεπζε Όισλ), Cut (Απνθνπή), Copy (Αληηγξαθή), Paste (Δπηθφιιεζε), Undo 

(Αλαίξεζε), and Redo (Δπαλάιεςε). Σν κελνχ File πεξηέρεη επίζεο δηάθνξεο άιιεο 

εληνιέο, φπσο ε  Preview in Browser (Πξνεπηζθφπεζε ζε Browser) θαη ε Print Code 

(Δθηχπσζε Κψδηθα ). Σν κελνχ Edit πεξηιακβάλεη εληνιέο επηινγήο θαη εχξεζεο, φπσο 

Select Parent Tag (Δπηινγή Σξέρνπζαο Δηηθέηαο) θαη Find and Replace (Δχξεζε θαη 

Αληηθαηάζηαζε). ΢ηα Windows, ην κελνχ Edit παξέρεη επίζεο πξφζβαζε ζην 

Preferences (Πξνηηκήζεηο). 

 

 

 

Σν View κελνχ καο παξέρεη επηινγέο ζε ζρέζε κε ηελ εκθάληζε ηνπ εγγξάθνπ 

καο (φπσο ην Design view θαη ην Code view) αθφκε κέζσ απηνχ ηνπ κελνχ κπνξνχκε 

λα ελεξγνπνηνχκε (έηζη ψζηε λα είλαη νξαηά) ή λα απελεξγνπνηνχκε (έηζη ψζηε λα κελ 

είλαη νξαηά) δηάθνξα ζηνηρεία ηεο ζειίδαο φπσο γηα παξάδεηγκα ηηο εξγαιεηνζήθεο. 

Απφ ην Insert κελνχ  κπνξνχκε λα εηζάγνπκε αληηθείκελα. 

 

Σν Modify κελνχ  καο επηηξέπεη λα αιιάδνπκε ηηο ηδηφηεηεο ηεο επηιεγκέλεο 

ζειίδαο, ζηνηρείνπ ή αληηθεηκέλνπ. Υξεζηκνπνηψληαο απηφ ην κελνχ κπνξνχκε λα 

επεμεξγαζηνχκε ηηο ηδηφηεηεο ησλ εηηθεηψλ, λα αιιάμνπκε ηνπο πίλαθεο θαη ηα ζηνηρεία 

ησλ πηλάθσλ θαη λα εθηειέζνπκε δηάθνξεο άιιεο ελέξγεηεο πνπ λα ζρεηίδνληαη κε ηα 

αληηθείκελα ησλ βηβιηνζεθψλ θαη ηα πξφηππα. 
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Σν Text κελνχ καο επηηξέπεη λα δηακνξθψλνπκε κε επθνιία θείκελν. 

 

Σν Commands κελνχ παξέρεη πξφζβαζε ζε κία πνηθηιία εληνιψλ φπσο ηεο 

δηακφξθσζεο ηνπ θψδηθα βάζε ησλ πξνηηκήζεσλ δηακφξθσζεο, ηεο δεκηνπξγίαο 

θσηνγξαθηθνχ άικπνπκ θαη ηεο βειηηζηνπνίεζεο κίαο εηθφλαο κε ηελ ρξήζε ηνπ 

Macromedia Fireworks. 

 

Μέζσ ηνπ Site κελνχ κπνξνχκε λα δηαρεηξηζηνχκε ηνλ δηαδηθηπαθφ ηφπν λα 

θνξηψζνπκε θαη λα θαηεβάζνπκε αξρεία. 

 

Μέζσ ηνπ Window κελνχ έρνπκε πξφζβαζε ζηα panels, ζηνπο inspectors, θαη 

ζηα windows ηνπ Dreamweaver.  

 

Σν Help κελνχ παξέρεη πξφζβαζε ζηελ ηεθκεξίσζε ηνπ Dreamweaver, 

ζπκπεξηιακβαλνκέλσλ ησλ ζπζηεκάησλ βνήζεηαο γηα ηελ ρξήζε ηνπ Dreamweaver, 

γηα ηελ δεκηνπξγία επεθηάζεσλ ζην Dreamweaver θαη πιηθφ αλαθνξάο γηα πνηθίιεο 

γιψζζεο. 

 

6.1.3 Έναπξη 

΢πληζηάηαη ν θαζνξηζκφο ηεο αξρηηεθηνληθήο ηνπ δηαδηθηπαθνχ ηφπνπ πξηλ ηελ 

δεκηνπξγία ησλ ηζηνζειίδσλ.  Οη εηθφλεο θαη ηα θνπκπηά πινήγεζεο πξέπεη λα είλαη 

έηνηκα έηζη ψζηε λα κπνξνχλ λα εηζαρζνχλ ζηελ ηζηνζειίδα. Δπηπιένλ, γηα ηελ 

δεκηνπξγία ελφο δηαδηθηπαθνχ ηφπνπ απφ ηελ αξρή, πξέπεη ην ζρεδηάγξακκα / ζρέδην 

ησλ ζειίδσλ θαη ε νξγάλσζε ησλ αξρείσλ λα έρνπλ θαζνξηζηεί εθ ησλ πξνηέξσλ. Όιεο 

νη εηθφλεο είλαη ρξήζηκν λα ηνπνζεηεζνχλ ζε έλαλ θάθειν αξρείσλ έηζη ψζηε φηαλ 

ζέινπκε λα εηζάγνπκε κηα εηθφλα λα μέξνπκε πνχ λα ηελ βξνχκε. Οη ζρεδηαζηέο   

ζπρλά ηνπνζεηνχλ ηα κε-HTML ζηνηρεία ζε έλαλ ρσξηζηφ θάθειν. Μηα αθφκε 

ρξήζηκε ζπκβνπιή είλαη λα δεκηνπξγήζνπκε έλα πξφηππν (ηζηνζειίδαο), αλνίγνπκε ην 

πξφηππν θαη ην απνζεθεχνπκε σο λέα ζειίδα, θαηφπηλ πξνζζέηνπκε ην λέν θείκελν ή / 

θαη ηελ εηθφλα ζηε λέα ζειίδα.  
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6.1.4 Οδηγόρ πεπιήγηζηρ 

Σν Dreamweaver παξέρεη έλαλ νδεγφ πεξηήγεζεο γηα λα καο βνεζήζεη λα 

θαηαλνήζνπκε ηηο βαζηθέο έλλνηεο.  Απηή ε πεξηήγεζε είλαη έλαο άξηζηνο ηξφπνο γηα 

ηελ γξήγνξε θαηαλφεζε ησλ ιεπηνκεξεηψλ.  Πξηλ αξρίζνπκε,  θαιφ ζα είλαη λα 

παξαθνινπζήζνπκε ηα video ηεο πεξηήγεζεο γηα λα εμνηθεησζνχκε κε ηε δηαδηθαζία 

αλάπηπμεο Ηζηνχ θαη κε ηα ραξαθηεξηζηηθά γλσξίζκαηα ηνπ Dreamweaver.  

 

6.1.5 Δπγαλεία 

Οη δχν ζπλεζέζηεξα ρξεζηκνπνηνχκελεο νκάδεο εξγαιείσλ είλαη ην Object panel 

θαη ην Properties inspector. Γηα ηελ γξήγνξε εκθάληζε θαη απνκάθξπλζε ηνπο απφ ηελ 

νζφλε πηέδνπκε ην πιήθηξν F4.     
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 Start page : καο επηηξέπεη λα αλνίμνπκε έλα πξφζθαηα πξνζπειαζκέλν αξρείν 

ή λα δεκηνπξγήζνπκε έλα θαηλνχξην αξρείν. 

 Insert bar πεξηιακβάλεη θνπκπηά γηα ηελ εηζαγσγή δηαθφξσλ αληηθεηκέλσλ 

φπσο εηθφλεο. Κάζε αληηθείκελν είλαη έλα θνκκάηη HTML θψδηθα θαη 

κπνξνχκε λα θαζνξίζνπκε δηάθνξεο ηδηφηεηεο αθνχ ην εηζάγνπκε.   

 Document toolbar : πεξηιακβάλεη θνπκπηά θαη pop-up κελνχ πνπ καο παξέρεη 

δηαθνξεηηθέο ζεάζεηο ηνπ Document window (φπσο Design view θαη Code 

view) θαη θάπνηεο θνηλέο δηαδηθαζίεο, φπσο ε πξνεπηζθφπεζε. 

 Document window : εκθαλίδεη ην ηξέρνλ έγγξαθν φπσο ην δεκηνπξγνχκε θαη 

ην επεμεξγαδφκαζηε. 

 Property inspector : κπνξνχκε λα βιέπνπκε θαη λα αιιάδνπκε ηηο ηδηφηεηεο 

ηνπ επηιεγκέλνπ αληηθεηκέλνπ ή θεηκέλνπ. Κάζε είδνο αληηθεηκέλνπ έρεη 

δηαθνξεηηθέο ηδηφηεηεο. 

 Panel groups : πξφθεηηαη γηα ζχλνια ζρεηηθψλ κεηαμχ ηνπο πάλει 

νκαδνπνηεκέλα θάησ απφ έλαλ θνηλφ ηίηιν. 

 Files panel : Μαο επηηξέπεη λα δηαρεηξηζηνχκε ηα αξρεία θαη ηνπο θαηαιφγνπο, 

είηε απνηεινχλ ηκήκα ηνπ δηαδηθηπαθνχ καο ηφπνπ είηε φρη.  Δπίζεο έρνπκε ηε 

δπλαηφηεηα λα έρνπκε πξφζβαζε ζε φια ηα αξρεία ηνπ ηνπηθνχ καο δίζθνπ.  

  

Σν Dreamweaver παξέρεη κία πνηθηιία άιισλ panels, inspectors, θαη windows ηα 

νπνία δελ εκθαλίδνληαη ζηελ παξαπάλσ απεηθφληζε, φπσο ην CSS Styles panel θαη ηνλ 

Tag inspector. Γηα λα αλνίμνπκε φια ηα παξαπάλσ εξγαιεία, ρξεζηκνπνηνχκε ην κελνχ 

Window. 

 

 

 

6.1.5.1 Σίηλορ - Όνομα ζελίδαρ 

Μία θαιή ζπλήζεηα πξνο πηνζέηεζε είλαη λα δίλνπκε ακέζσο ηίηιν/φλνκα ζηε 

λέα  ζειίδα. Γηα λα νξίζνπκε ηνλ ηίηιν: 

 

1. Δάλ ε εξγαιεηνζήθε ηνπ εγγξάθνπ (Document toolbar) δελ είλαη νξαηή 

επηιέγνπκε View > Toolbars > Document θαη ζα εκθαληζηεί ζην επάλσ κέξνο 

ηνπ Document window. 
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2. ΢ην παξάζπξν θεηκέλνπ ηνπ Title, επηιέγνπκε ην θείκελν “Untitled Document”. 

Σν δηαγξάθνπκε θαη ζηε ζπλέρεηα πιεθηξνινγνχκε ην φλνκα πνπ ζέινπκε.  

3. Απνζεθεχνπκε ηελ ζειίδα. 

 

 

 

 

6.1.5.2 Ιδιόηηηερ ζελίδαρ 

Γηα λα αιιάμνπκε ηελ εηθφλα ή ην ρξψκα ηνπ background ζε κία ζειίδα, επηιέγνπκε  

Modify > Page Properties (Ctrl+J). 

 

 

 

 

Δικόνα Background 

Αο ππνζέζνπκε φηη έρνπκε κία εηθφλα θαη ζέινπκε λα ηελ ρξεζηκνπνηήζνπκε σο 

Background ζηελ ζειίδα καο, ηελ επηιέγνπκε απφ ην "browse". Ζ εηθφλα ζα 

επαλαιεθζεί ζε φιε ηελ ζειίδα.  

 

Υπώμα Background 

Γηα ηελ επηινγή ρξψκαηνο σο Background, κπνξνχκε είηε λα εηζάγνπκε ηελ 

δεθαεμαδηθή ηηκή ηνπ ρξψκαηνο ζην πιαίζην είηε λα επηιέμνπκε θάπνην ρξψκα απφ ηελ 

παιέηα ρξσκάησλ ηνπ Dreamweaver.  
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6.1.5.3 Πίνακερ 

Οπηηθά ζθεθηείηε ηνπο πίλαθεο ζαλ κία εθεκεξίδα κε γξακκέο θαη ζηήιεο λα 

δηαρσξίδνπλ ηηο πιεξνθνξίεο ή /θαη ηηο εηθφλεο. Όπσο είλαη γλσζηφ νη εκθσιεπκέλνη 

πίλαθεο κπνξεί λα ρξεηάδνληαη πεξηζζφηεξν ρξφλν γηα λα θνξησζνχλ, ζε θάπνηεο 

πεξηπηψζεηο. Δίλαη πξνηηκφηεξν λα αλαπηχμνπκε ηελ ζειίδα καο κέζα ζε έλαλ πίλαθα 

585 pixel θαη λα ρξεζηκνπνηνχκε εκθσιεπκέλνπο πίλαθεο κφλν φηαλ είλαη πξαγκαηηθά 

αλαγθαίν. Δάλ είλαη δπλαηφλ πξνηηκάκε λα ρξεζηκνπνηήζνπκε πίλαθεο 585 pixel ηνλ 

έλα πάλσ ζηνλ άιιν παξά ηνλ έλαλ κέζα ζηνλ άιινλ. Δάλ ε παιέηα αληηθεηκέλσλ δελ 

είλαη νξαηή, επηιέμηε Window > Objects. Σνπνζεηνχκε ηνλ θέξζνξα ζην ζεκείν ζην 

νπνίν ζέινπκε λα εκθαλίδεηαη ν πίλαθαο κέζα ζηελ ζειίδα θαη επηιέμηε ην θνπκπί  

"Insert Table" ή επηιέμηε  Insert > Table. 

 

΢ην πιαίζην δηαιφγνπ φπνπ εκθαλίδεηαη: 

 Table rows – Ο αξηζκφο ησλ γξακκψλ ηνπ πίλαθα. 

 Columns – Ο αξηζκφο ησλ ζηειψλ ηνπ πίλαθα. 

 Cell Padding – Πξνζδηνξίδεη ην δηάζηεκα πνπ ζα ππάξρεη αλάκεζα ζην 

πεξηερφκελν ηνπ θειηνχ θαη ζηα φξηα ηνπ πίλαθα. 

 Cell Spacing – Πξνζδηνξίδεη ην δηάζηεκα πνπ ζα ππάξρεη αλάκεζα ζε θάζε θειί 

ηνπ πίλαθα εμαηξεκέλσλ ησλ νξίσλ ηνπ πίλαθα. 

 Width – Καζνξίδεη ην πιάηνο ηνπ πίλαθα ζε pixels ή ζε πνζνζηφ (ζε ζρέζε κε 

ην παξάζπξν ηνπ browser). Γηα αθξηβέζηεξε εκθάληζε ηνπ θεηκέλνπ θαη ησλ 

εηθφλσλ είλαη πξνηηκφηεξν λα νξίδνπκε ην πιάηνο ζε pixels. Γηα ηνπ πίλαθεο 

πνπ εκπεξηέρνληαη κέζα ζε άιινπο πίλαθεο ηα πνζνζηά πξνηηκψληαη 

πεξηζζφηεξν απφ φηη ηα  pixels. 

 Border – Καζνξίδεη ην πιάηνο ησλ νξίσλ (πεξίγξακκα) ελφο πίλαθα. ΢πλήζσο 

ην επηζπκεηφ πεξίγξακκα είλαη ην κεδεληθφ, πνπ ζεκαίλεη πσο ην πεξίγξακκα 
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ηνπ πίλαθα δελ ζα είλαη νξαηφ. Δάλ ζέινπκε λα είλαη νξαηφ ηφηε εηζάγνπκε 

έλαλ αξηζκφ.  

 

 

 

6.1.5.4 Γημιοςπγία ζςνδέζεων και ζςνδέζεων ηλεκηπονικού 

ηασςδπομείος 

Γηα λα δεκηνπξγήζνπκε ζπλδέζεηο επηιέγνπκε ην θείκελν ή ηελ εηθφλα θαη αλνίγνπκε 

ηνλ Property inspector (Window > Properties):  

 

 

 

 

1. Δπηιέγνπκε ην εηθνλίδην ηνπ θαθέινπ πνπ βξίζθεηαη ζηα δεμηά ηνπ πεδίνπ 

ζχλδεζεο (Link) θαη δηαιέγνπκε ην αξρείν πνπ ζέινπκε. Ζ δηαδξνκή (path) ζην 

ζπλδεδεκέλν αξρείν εκθαλίδεηαη ζην πεδίν ηνπ URL.   

2. Γηα λα ζπλδέζνπκε έλα αξρείν κέζα ζηνλ δηαδηθηπαθφ καο ηφπν, εηζάγνπκε κία 

ζρεηηθή δηαδξνκή.  

3. Γηα λα ζπλδέζνπκε έλα αξρείν εθηφο ηνπ δηαδηθηπαθνχ καο ηφπνπ, εηζάγνπκε 

κία απφιπηε δηαδξνκή ζπκπεξηιακβαλνκέλνπ ηνπ http://.  

 

 

Γημιοςπγία ζςνδέζεων ηλεκηπονικού ηασςδπομείος (Email Links)  

Μία ζχλδεζε ειεθηξνληθνχ ηαρπδξνκείνπ αλνίγεη έλα λέν παξάζπξν κελπκάησλ 

(ρξεζηκνπνηψληαο έλα πξφγξακκα ειεθηξνληθνχ ηαρπδξνκείνπ ην νπνίν ζπλδέεηαη κε 

ηνλ browser πνπ ρξεζηκνπνηνχκε). ΢ην παξάζπξν κελπκάησλ ην πεδίν “To” (πξνο) 

ελεκεξψλεηαη απηφκαηα κε ηελ δηεχζπλζε ε νπνία νξίδεηαη ζηελ ζχλδεζε. 

 

Γηα λα δεκηνπξγήζνπκε κηα ζχλδεζε ειεθηξνληθνχ ηαρπδξνκείνπ ρξεζηκνπνηψληαο 

ηελ εληνιή “Insert email Link”:  
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1. Σνπνζεηνχκε ην ζεκείν εηζαγσγήο εθεί πνπ ζέινπκε λα εκθαλίδεηαη ε ζχλδεζε, 

ή επηιέγνπκε ην θείκελν πνπ ζέινπκε λα εκθαλίδεηαη σο ζχλδεζε.  

2. ΢ηελ παιέηα αληηθεηκέλσλ επηιέγνπκε ην Common panel θαη ζηελ ζπλέρεηα 

επηιέγνπκε “Insert email Link”.  

3. ΢ην πεδίν Text ηνπ παξαζχξνπ πνπ καο εκθαλίδεηαη, πιεθηξνινγνχκε ην 

θείκελν πνπ ζέινπκε λα εκθαλίδεηαη σο ζχλδεζε ειεθηξνληθνχ ηαρπδξνκείνπ.  

4. Σν πεδίν E-mail, πιεθηξνινγνχκε ηελ ειεθηξνληθή δηεχζπλζε ζηελ νπνία ην 

κήλπκα ζα απεπζχλεηαη.  

5. Παηάκε OK.  

 

 

6.1.5.5 Διζαγωγή εικόνων 

Γηα θσηνγξαθηθέο εηθφλεο ή γηα εηθφλεο ζπλερφκελσλ ηφλσλ ζα πξέπεη λα 

πξνηηκήζνπκε ηελ δηακφξθσζε JPEG (ή JPG), γηα εηθφλεο κε ζπλερφκελσλ ηφλσλ ή 

γηα εθείλεο κε κεγάιεο πεξηνρέο επίπεδσλ ρξσκάησλ π.ρ. εηθφλεο κφλν κε θείκελν φπσο 

ηα θνπκπηά πινήγεζεο, ζα πξέπεη λα πξνηηκήζνπκε ηελ δηακφξθσζε GIF. Μία εηθφλα 

ηχπνπ PSD δελ ζα εκθαληζηεί ζηνλ browser θαη φηαλ ζα πξνζπαζήζνπκε λα ηελ 

εηζάγνπκε ζην Dreamweaver δελ ζα εκθαληζηεί ζην πιαίζην δηαιφγνπ. Πξηλ εηζάγνπκε 

ηελ εηθφλα πξέπεη λα κεηψζνπκε ηελ αλάιπζε ηεο ζηα 72 dpi θαη λα θάλνπκε 

νπνηεζδήπνηε άιιεο αιιαγέο ρξεζηκνπνηψληαο έλα πξφγξακκα επεμεξγαζίαο 

εηθφλσλ(π.ρ. Fireworks, Photoshop). Ζ εηθφλα πξέπεη λα έρεη ην κέγεζνο κε ην νπνίν 

ζέινπκε λα εκθαλίδεηαη ζηελ ηζηνζειίδα καο θαη φρη λα ηελ κεγαιψλνπκε θαη λα ηελ 

κηθξαίλνπκε κέζα ζην Dreamweaver.   

 

Γηα λα εηζάγνπκε κία εηθφλα: 

1. Σνπνζεηνχκε ηνλ θέξζνξα ζην ζεκείν πνπ ζέινπκε λα εκθαλίδεηαη ε εηθφλα 

θαη ζηε ζπλέρεηα επηιέγνπκε “Insert Image button” απφ ην Common panel.  

2. ΢ην παξάζπξν δηαιφγνπ πνπ εκθαλίδεηαη παηάκε “Browse” γηα λα επηιέμνπκε 

ηελ εηθφλα.  
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6.1.5.6 Διζαγωγή ημεπομηνίαρ 

Σνπνζεηνχκε ηνλ θέξζνξα ζην ζεκείν πνπ ζέινπκε λα εκθαλίδεηαη ε 

εκεξνκελία. ΢ην Common panel, επηιέγνπκε "insert date". ΢ην παξάζπξν δηαιφγνπ 

πνπ εκθαλίδεηαη, επηιέγνπκε "update automatically on save".  

 

 

 

 

 

6.1.5.7 Διζαγωγή Rollovers 

Έλα rollover είλαη κία εηθφλα ε νπνία αιιάδεη φηαλ ν θέξζνξαο θηλείηαη επάλσ 

ηεο. ΢ηελ πξαγκαηηθφηεηα πξφθεηηαη γηα δχν εηθφλεο. Σελ αξρηθή εηθφλα, ε νπνία 

εκθαλίδεηαη φηαλ θνξηψλεηαη ε ζειίδα θαη ηελ εηθφλα αλαηξνπήο (rollover), ε νπνία 

εκθαλίδεηαη φηαλ ν θέξζνξαο θηλείηαη πάλσ απφ ηε αξρηθή εηθφλα.  

 

Γηα λα δεκηνπξγήζνπκε έλα rollover ζε κία ηζηνζειίδα: 

Αξρηθά ζα πξέπεη λα έρνπκε δηακνξθψζεη ηηο δχν εηθφλεο κε ηελ ρξήζε ελφο 

πξνγξάκκαηνο επεμεξγαζίαο εηθφλσλ . Δίλαη απαξαίηεην θαη νη δχν εηθφλεο λα έρνπλ 

αθξηβψο ηηο ίδηεο δηαζηάζεηο αιιηψο δελ ζα εκθαληζηνχλ ζσζηά. 

 

 

 

 

΢ην Dreamweaver: 

1. Σνπνζεηνχκε ηνλ θέξζνξα ζην ζεκείν ζην νπνίν ζέινπκε λα εκθαλίδεηαη ην 

rollover.  

2. Δπηιέγνπκε Window > Objects γηα λα αλνίμνπκε ηελ παιέηα ησλ αληηθεηκέλσλ 

θαη κεηά παηάκε ην θνπκπί ηνπ Rollover.  
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3. ΢ην παξάζπξν δηαιφγνπ πνπ εκθαλίδεηαη, εηζάγνπκε ηα παξαθάησ:  

4. Πιεθηξνινγνχκε ηελ δηαδξνκή θαη ην φλνκα ηεο αξρηθήο εηθφλαο ζην πεδίν 

“original image” ή παηάκε “browse” θαη επηιέγνπκε ηελ εηθφλα.  

5. Πιεθηξνινγνχκε ηελ δηαδξνκή θαη ην φλνκα ηεο εηθφλαο αλαηξνπήο (rollover) 

ζην πεδίν “Rollover Image”, ή παηάκε “browse” θαη επηιέγνπκε ηελ εηθφλα. 

6. Γηα λα δεκηνπξγήζνπκε κία ζχλδεζε (link), αληηθαζηζηνχκε ην ζχκβνιν # ζην 

πεδίν Link κε ηελ δηαδξνκή θαη ην φλνκα ηνπ αξρείνπ ή παηάκε “browse” θαη 

επηιέγνπκε ην αξρείν.  

7. Παηάκε OK.  

 

Γηα λα δνθηκάζνπκε έλα rollover: 

 

1. Δπηιέγνπκε File > Preview in Browser ή παηάκε ην πιήθηξν F12.  

2. ΢ηνλ browser, κεηαθηλνχκε ην θέξζνξα πάλσ απφ ηελ εηθφλα θαη βιέπνπκε εάλ 

γίλεηαη ε ελαιιαγή κε ηελ δεχηεξε εηθφλα.  

 

 

6.1.5.8 Άγκςπερ 

΢ύνδεζη με μία άγκςπα 

Οη Άγθπξεο (anchors) επηζεκαίλνπλ ζπγθεθξηκέλα ζεκεία ζε έλα έγγξαθν. 

Υξεζηκνπνηνχκε ηηο άγθπξεο γηα λα κεηαθεξζνχκε ζε έλα επηζεκαζκέλν ζεκείν ζην 

ηξέρνλ έγγξαθν ή γηα ζπλδεζνχκε κε έλα επηζεκαζκέλν ζεκείν ζε έλα δηαθνξεηηθφ 

έγγξαθν.  

 

Γηα λα δεκηνπξγήζνπκε κία Άγθπξα (anchor): 

1. Σνπνζεηνχκε ηνλ θέξζνξα ζην ζεκείν ζην νπνίν ζέινπκε λα εκθαλίδεηαη ε 

Άγθπξα (anchor). 

2. Δπηιέγνπκε Window > Objects, ζηε ζπλέρεηα επηιέγνπκε Invisibles ζην pop-up 

κελνχ ζηελ θνξπθή ηεο παιέηαο αληηθεηκέλσλ θαη παηάκε ην θνπκπί Anchor.  

3. Δηζάγνπκε ην φλνκα ζην παξάζπξν δηαιφγνπ πνπ εκθαλίδεηαη. Δάλ ην ζχκβνιν 

ηεο άγθπξαο δελ εκθαληζηεί ζην ζεκείν πνπ είρακε ηνπνζεηήζεη ηνλ θέξζνξα, 

επηιέγνπκε View > Invisible Elements.  

4. Γηα λα ζπλδεζνχκε κε κία άγθπξα (anchor): 
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5. Δπηιέγνπκε ην θείκελν ή ηελ εηθφλα.  

6. ΢ηνλ Property inspector, εηζάγνπκε ην ζχκβνιν # θαη ην φλνκα ηεο άγθπξαο  

ζην πεδίν ηνπ Link. 

 

 

 

 

6.2  Flash 

 

 

 

Σν Macromedia Flash, ή απιά Flash, αλαθέξεηαη θαη ζε πξνγξάκκαηα 

δεκηνπξγίαο πνιπκέζσλ θαη ζηνλ Macromedia Flash Player, ν νπνίνο ρξεζηκνπνηεί 

γξαθηθή παξάζηαζε δηαλχζκαηνο, κηα scripting γιψζζα πνπ νλνκάδεηαη ActionScript 

θαη ακθίδξνκε ξνή βίληεν θαη ήρνπ. Σν Macromedia Flash είλαη ην πεξηβάιινλ 

δεκηνπξγίαο θαη ν Flash Player είλαη ε εηθνληθή κεραλή εθαξκνγψλ  πνπ 

ρξεζηκνπνηείηαη γηα λα ηξέμεη ηα αξρεία Flash. Σα αξρεία Flash, πνπ έρνπλ ζπλήζσο 

κηα SWF επέθηαζε αξρείνπ, κπνξνχλ λα εκθαληζηνχλ ζε κηα ηζηνζειίδα ή σο "ην 

παηρλίδη" ζηνλ Flash Player. Σα αξρεία Flash εκθαλίδνληαη ζπρλφηεξα σο animations, 

δηαθεκίζεηο ή ζηνηρεία ζρεδίνπ ηζηνζειίδαο θαη, πην πξφζθαηα, σο πινχζηεο 

εθαξκνγέο ηνπ δηαδηθηχνπ. Έλα αξρείν Flash κπνξεί λα πεξηέρεη πεξηζζφηεξεο 

δηαθνξεηηθέο πιεξνθνξίεο απφ έλα αξρείν GIF ή JPEG ηνπ ίδηνπ κεγέζνπο.  
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6.2.1 Γλώζζα ππογπαμμαηιζμού  

Σν Flash MX 2004 ρξεζηκνπνηεί ηελ ActionScript 2,0 πνπ έρεη ζχληαμε παξφκνηα 

κε ηελ JavaScript, αιιά έλα πνιχ δηαθνξεηηθά πιαίζην πξνγξακκαηηζκνχ θαη ζχλνιν 

θιάζεσλ βηβιηνζεθψλ. Ζ ActionScript 2,0 είλαη κηα scripting γιψζζα 

πξνγξακκαηηζκνχ πνπ ζηεξείηαη ηζρπξνχο ηχπνπο ρξφλνπ εθηέιεζεο. Ζ Pre-2.0 

ActionScript κπνξεί λα ρξεζηκνπνηεζεί κφλε ή καδί κε ηελ ActionScript 2,0 γηα ηελ 

πξφζβαζε ζηα ίδηα αληηθείκελα θαη ηνπο πφξνπο κέζα ζην Flash MX 2004. Δλψ ε 

ActionScript 2,0 πξνζθέξεη κεξηθά αληηθεηκελνζηξαθή ραξαθηεξηζηηθά γλσξίζκαηα, 

φπσο γεγνλφηα, δηεπαθέο θαη θιεξνλνκηθφηεηα, ην κεγαιχηεξν κέξνο ηεο 

αληηθεηκελνζηξαθνχο ηθαλφηεηαο ηνπ Flash MX 2004 βξίζθεηαη κέζα ζην 

κεηαγισηηηζηή ηνπ.  

 

6.2.2 Αζθάλεια 

Ο Flash Player ρξεζηκνπνηεί έλα sandbox πξφηππν αζθάιεηαο, ην νπνίν ζεκαίλεη 

φηη νη Flash εθαξκνγέο πνπ ηξέρνπλ ζε έλαλ θπιινκεηξεηή έρνπλ δηαζέζηκνπο πνιχ 

αθξηβείο θαη πεξηνξηζκέλνπο πφξνπο. Οη εθαξκνγέο δελ κπνξνχλ, παξαδείγκαηνο ράξηλ, 

λα δηαβάζνπλ αξρεία απφ ην ζθιεξφ δίζθν. Μπνξνχλ κφλν λα επηθνηλσλήζνπλ κε ηελ 

πεξηνρή απφ φπνπ πξνήιζαλ, εθηφο αλ επηηξέπεηαη απφ κηα άιιε πεξηνρή. Ο Flash 

Player είλαη επαίζζεηνο ζε επηζέζεηο, φπσο νπνηαδήπνηε εθαξκνγή πνπ ρεηξίδεηαη 

αξρεία πνπ παξαιακβάλνληαη απφ ην Γηαδίθηπν. Δηδηθά επεμεξγαζκέλα αξρεία ζα 

κπνξνχζαλ ελδερνκέλσο λα πξνθαιέζνπλ δπζιεηηνπξγία ζηελ εθαξκνγή επηηξέπνληαο 

ηελ εθηέιεζε επηβιαβή θψδηθα. Ζ ζχλδεζε ηνπ Player είρε ξσγκέο αζθάιεηαο πνπ 

κπνξεί λα εθζέζνπλ έλαλ ππνινγηζηή ζε καθξηλέο επηζέζεηο.  

 

 

6.2.3 ΢σήμα και plug-in 

΢ε ζρέζε κε άιια plugins φπσο Java, QuickTime ή Windows Media Player, ν 

Flash Player έρεη πνιχ κηθξφ κέγεζνο εγθαηάζηαζεο θαη γξήγνξν ρξφλν έλαξμεο. Όπσο 

ην CSS κε ηελ HTML, PostScript, SVG θαη PDF, ην Flash κπνξεί λα ρξεζηκνπνηεζεί 
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γηα λα δηεπθξηλίζεη ηνλ αθξηβή πξνζδηνξηζκφ ηεο ζέζεο ησλ δηάθνξσλ ζηνηρείσλ 

ζειίδαο. Απηφ δίλεη ζην ζρεδηαζηή έλαλ κεγάιν βαζκφ ειέγρνπ ζην πψο θαίλεηαη ε 

δηεπαθή ζηνλ ρξήζηε. Σν ζρεδηάγξακκα κπνξεί επίζεο λα ξπζκηζηεί πξνγξακκαηηζηηθά 

ζην ρξφλν εθηέιεζεο. Ζ ρξήζε δηαλπζκαηηθήο γξαθηθήο παξάζηαζεο - εηδηθά φηαλ 

ζπλδπάδεηαη κε θψδηθα πξνγξάκκαηνο - επηηξέπεη ζηα Flash αξρεία λα κεηαιιαρζνχλ 

ζε αξρεία κηθξνχ κεγέζνπο πνπ ρξεηάδνληαη ιηγφηεξν εχξνο δψλεο γηα λα δηαβηβαζηνχλ 

απφ φηη ηα bitmap αξρεία εηθφλαο ή ηα video clips. ΢ε πνιιέο πεξηπηψζεηο, ην Flash 

είλαη κηα πνιχ ειθπζηηθή ιχζε γηα ηελ παξάδνζε κηθηνχ πεξηερνκέλνπ. Δάλ ην 

πεξηερφκελν είλαη έλα ζρήκα, άιιεο ελαιιαθηηθέο ιχζεηο κπνξνχλ λα παξέρνπλ 

θαιχηεξν απνηέιεζκα. Δπίζεο, αλάινγα κε ηνλ ηχπν ηεο εθαξκνγήο ή ηνπ animation 

πνπ δεκηνπξγήζεθε, κηα ηαηλία Flash κπνξεί λα ρξεηαζηεί πεξηζζφηεξε δχλακε ηεο 

ΚΜΔ απφ ηηο ελαιιαθηηθέο ιχζεηο. 

 

6.2.4 Υπήζη ηος ΢κηνικού   

Σν ΢θεληθφ είλαη κηα νξζνγψληα πεξηνρή φπνπ ηνπνζεηείηαη γξαθηθφ 

πεξηερφκελν, ζπκπεξηιακβαλνκέλεο ηεο δηαλπζκαηηθήο ηέρλεο, παξαζχξσλ θεηκέλνπ, 

θνπκπηψλ, εηζαγφκελεο γξαθηθήο παξάζηαζεο bitmap αξρείσλ εηθφλαο ή video clips, 

θαη ηα ινηπά. Σν ΢θεληθφ ζην πεξηβάιινλ δεκηνπξγίαο Flash αληηπξνζσπεχεη ην 

νξζνγψλην δηάζηεκα ηνπ Macromedia Flash Player, φπνπ ην Flash έγγξαθν 

επηδεηθλχεηαη θαηά ηε δηάξθεηα ηεο αλαπαξαγσγήο.  
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6.2.5 Υπήζη ηος Υπονοδιαγπάμμαηορ  

 Σν Υξνλνδηάγξακκα νξγαλψλεη θαη ειέγρεη ην πεξηερφκελν ηνπ εγγξάθνπ θαηά 

ηε δηάξθεηα ηνπ ρξφλνπ ζε layers θαη ηα πιαίζηα. Σα Flash έγγξαθα δηαηξνχλ ηα 

ρξνληθά δηαζηήκαηα ζε πιαίζηα. Σα layers ζπζζσξεχνληαη ην έλα πάλσ ζην άιιν, θαη 

θάζε έλα πεξηέρεη κηα δηαθνξεηηθή εηθφλα πνπ εκθαλίδεηαη ζην ΢θεληθφ. Σα 

ζεκαληηθφηεξα ζπζηαηηθά ηνπ Υξνλνδηαγξάκκαηνο είλαη ηα layers, ηα πιαίζηα, θαη ην 

playhead. Σα layers ζε έλα έγγξαθν παξαηίζεληαη ζε κηα ζηήιε ζηελ αξηζηεξή πιεπξά 

ηνπ Υξνλνδηαγξάκκαηνο. Σα πιαίζηα πνπ πεξηιακβάλνληαη ζε θάζε layer εκθαλίδνληαη 

ζε κηα ζεηξά δεμηά ηνπ νλφκαηνο ηνπ layer. Ζ επηγξαθή ηνπ ρξνλνδηαγξάκκαηνο ζηελ 

θνξπθή ηνπ Υξνλνδηαγξάκκαηνο δείρλεη ηνπο αξηζκνχο ησλ πιαηζίσλ. Σν playhead 

δείρλεη ην ηξέρνλ πιαίζην πνπ επηδεηθλχεηαη ζην ζθεληθφ. Ζ επίδεημε ζέζεο ηνπ 

ρξνλνδηαγξάκκαηνο ζην θαηψηαην ζεκείν ηνπ Υξνλνδηαγξάκκαηνο δείρλεη ηνλ 

επηιεγκέλν αξηζκφ πιαηζίσλ, ην ηξέρνλ πνζνζηφ πιαηζίσλ, θαη ηελ παξεξρφκελε 

πεξίνδν ηνπ ηξέρνληνο πιαηζίνπ.  

 

 

 

 

 

6.2.5.1 Κίνηζη ηος playhead   

 

Σν playhead θηλείηαη κέζσ ηνπ Υξνλνδηαγξάκκαηνο  γηα λα ππνδείμεη ην ηξέρνλ 

πιαίζην πνπ επηδεηθλχεηαη ζην ΢θεληθφ. Ζ επηγξαθή ηνπ Υξνλνδηαγξάκκαηνο 

παξνπζηάδεη ηνπο αξηζκνχο πιαηζίσλ ηνπ animation. Γηα ηελ επίδεημε ελφο πιαηζίνπ 

ζην ζθεληθφ, ην playhead κεηαθηλείηαη ζην πιαίζην ηνπ Υξνλνδηαγξάκκαηνο. Όηαλ 

θαλείο εξγάδεηαη κε έλαλ κεγάιν αξηζκφ πιαηζίσλ πνπ δελ κπνξνχλ λα εκθαληζηνχλ 
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φια ζην Υξνλνδηάγξακκα ηελ ίδηα ζηηγκή, κπνξεί λα κεηαθηλήζεη ην playhead θαηά 

κήθνο ηνπ Υξνλνδηαγξάκκαηνο γηα λα εληνπίζεη εχθνια ην ηξέρνλ πιαίζην.   

 

 

 

 

 

6.2.5.2 Υπήζη ηων πλαιζίων και ηων keyframes 

 

Σν keyframe είλαη έλα πιαίζην ζην νπνίν θαζνξίδεηαη κηα αιιαγή ζε έλα 

animation ή πεξηιακβάλεη ελέξγεηεο πιαηζίσλ λα ηελ ηξνπνπνίεζε ηνπ εγγξάθνπ. Σν 

Flash κπνξεί λα δεκηνπξγήζεη tween ή λα γεκίζεη ηα πιαίζηα κεηαμχ ησλ keyframes 

ψζηε λα παξάγεη animations. Δπεηδή ηα keyframes επηηξέπνπλ ηελ παξαγσγή animation 

ρσξίο λα απαηηείηαη ζρεδηαζκφο ηνπ θάζε πιαηζίνπ, θάλνπλ ηε δεκηνπξγία ηνπ 

animation επθνιφηεξε. Σν κήθνο ελφο animation κπνξεί λα αιιάμεη κε ην ζχξζηκν ελφο 

keyframe ζην Υξνλνδηάγξακκα. Ζ ζεηξά κε ηελ νπνία ηα πιαίζηα θαη ηα keyframes 

εκθαλίδνληαη ζην Υξνλνδηάγξακκα θαζνξίδεη ηε ζεηξά κε ηελ νπνία επηδεηθλχνληαη ζε 

κηα Flash εθαξκνγή.  

 

 

6.2.5.3 Δπγαζία με ηα πλαίζια ζηο Υπονοδιάγπαμμα  

 

΢ην Υξνλνδηάγξακκα, εξγαδφκαζηε κε πιαίζηα θαη keyframes, ηα νπνία 

ηνπνζεηνχληαη ζηε ζεηξά κε ηελ νπνία ζέινπκε λα εκθαληζηνχλ ηα αληηθείκελα ησλ 

πιαηζίσλ. Σν Υξνλνδηάγξακκα παξέρεη κηα φςε ησλ πιαηζίσλ ζε έλα animation. Σν 

Flash πξνζθέξεη δχν δηαθνξεηηθέο κεζφδνπο γηα ηελ επηινγή ησλ πιαηζίσλ ζην 

Υξνλνδηάγξακκα. ΢ηελ βαζηζκέλε-ζην-πιαίζην επηινγή επηιέγνληαη κεκνλσκέλα 

πιαίζηα ζην Υξνλνδηάγξακκα. ΢ηελ βαζηζκέλε-ζε-έθηαζε επηινγή, νιφθιεξε ε 

αθνινπζία ησλ πιαηζίσλ, απφ ην έλα keyframe ζην επφκελν, επηιέγεηαη φηαλ θάλνπκε 

θιηθ ζε νπνηνδήπνηε πιαίζην ηεο αθνινπζίαο.   
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6.2.6 Υπήζη ηων layers  

Σα layers είλαη ζαλ δηαθαλή θχιια πνπ ζπζζσξεχνληαη ην έλα πάλσ ζην άιιν. 

Σα layers βνεζνχλ ζηελ νξγάλσζε ηνπ εγγξάθνπ. ΢ε έλα layer κπνξεί λα ζρεδηαζηνχλ 

αληηθείκελα ρσξίο λα επεξεάδνπλ ηα αληηθείκελα ελφο άιινπ layer. Γηα λα ζρεδηάζεη, 

λα δσγξαθίζεη ή λα ηξνπνπνηήζεη θαλείο έλα layer ή έλαλ θάθειν, πξέπεη λα επηιέμεη 

ην ζπγθεθξηκέλν layer ψζηε λα ην θαηαζηήζεη ελεξγφ. Ζ εηθφλα ελφο κνιπβηνχ δίπια 

ζε έλα layer ή ζην φλνκα ελφο θαθέινπ δείρλεη φηη ην layer ή ν θάθεινο είλαη ελεξγά. 

Μφλν έλα layer κπνξεί λα είλαη ελεξγφ θάζε θνξά. Όηαλ δεκηνπξγείηαη έλα λέν 

Flash έγγξαθν, πεξηέρεη έλα layer. Μπνξνχκε λα πξνζζέζνπκε πεξηζζφηεξα layers γηα 

λα νξγαλψζνπκε ηα animations θαη άιια ζηνηρεία ηνπ εγγξάθνπ. Ο αξηζκφο ησλ layers 

πνπ κπνξεί λα δεκηνπξγεζνχλ πεξηνξίδεηαη κφλν απφ ηε κλήκε ηνπ ππνινγηζηή, θαη ηα 

layers δελ απμάλνπλ ην κέγεζνο ησλ δεκνζηεπκέλσλ SWF αξρείσλ. Μπνξεί θαλείο λα 

θξχςεη, λα θιεηδψζεη ή λα ξπζκίζεη εθ λένπ ηα layers. Μπνξεί επίζεο λα νξγαλψζεη θαη 

λα δηαρεηξηζηεί ηα layers κε ηε δεκηνπξγία θαθέισλ θαη ηελ ηνπνζέηεζε ησλ layers 

κέζα ζε απηνχο. Μπνξεί λα επεθηείλεη ή λα θαηαζηξέςεη ηα layers ζην 

Υξνλνδηάγξακκα ρσξίο λα επεξεάδεηαη απηφ πνπ θαίλεηαη ζην ΢θεληθφ.   

 

 

6.2.6.1 Βλέπονηαρ ηα layers και ηοςρ θακέλοςρ ηων layers 

 

Καηά ηε δηάξθεηα ηεο εξγαζίαο ηα layers ή νη θάθεινη ζέινπκε είηε λα είλαη 

νξαηά είηε φρη. Έλα θφθθηλν Υ δίπια ζην φλνκα ηνπ layer ή ηνπ θαθέινπ δείρλεη φηη 

είλαη θξπκκέλν. Όηαλ δεκνζηεχνπκε έλα SWF αξρείν Flash, φζα layers ήηαλ θξπκκέλα 

ζην έγγξαθν FLA δηαηεξνχληαη θαη είλαη νξαηά ζην αξρείν SWF.  
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6.2.6.2 Οπγάνωζη ηων layers και ηων θακέλων ηων layers 

 

Σα layers θαη νη θάθεινη κπνξνχλ λα ξπζκηζηνχλ εθ λένπ  ζην Υξνλνδηάγξακκα 

έηζη ψζηε λα νξγαλσζεί ην έγγξαθν. Οη θάθεινη βνεζνχλ ζηελ νξγάλσζε ηεο ξνήο ηεο 

εξγαζίαο κε ηελ ηνπνζέηεζε ησλ layers ζε δνκή δέληξνπ. Οη θάθεινη κπνξεί λα 

πεξηέρνπλ θαη layers θαη άιινπο θαθέινπο, επηηξέπνληαο ηελ νξγάλσζε ησλ layers κε 

ηνλ ίδην ζρεδφλ ηξφπν πνπ ζα νξγάλσλε θαλείο αξρεία ζε έλαλ ππνινγηζηή. Οη έιεγρνη 

ησλ layers ζην Υξνλνδηάγξακκα έρνπλ επηπηψζεηο ζε φια ηα layers κέζα ζε έλαλ 

θάθειν. 

 

6.2.7 Κύπια μπάπα επγαλείων και η μπάπα edit 

Ζ θχξηα κπάξα εξγαιείσλ πνπ βξίζθεηαη ζην πάλσ ηκήκα ηνπ ρψξνπ εξγαζίαο 

πεξηιακβάλεη κελνχ κε εληνιέο γηα ηνλ έιεγρν ηεο ιεηηνπξγίαο ηνπ Flash. Σα κελνχ 

πεξηιακβάλνπλ ηηο επηινγέο File, Edit, View, Insert, Modify, Text, Commands, 

Control, Window θαη Help. Ζ κπάξα edit, πνπ βξίζθεηαη αθξηβψο θάησ απφ ηελ θχξηα 

κπάξα εξγαιείσλ, πεξηέρεη ειέγρνπο θαη πιεξνθνξίεο γηα ηελ έθδνζε ησλ ζθελψλ θαη 

ησλ ζπκβφισλ, θαη γηα ηελ αιιαγή ηνπ επηπέδνπ ελίζρπζεο ηνπ ΢θεληθνχ.   

 

 

 

 

 

6.2.7.1 Υπήζη ηηρ παλέηαρ Tools  

 

Σα εξγαιεία ζηελ παιέηα Tools επηηξέπνπλ ηε ζρεδίαζε, ηελ επηινγή θαη ηελ 

ηξνπνπνίεζε ηεο εξγαζίαο θαζψο επίζεο θαη ηελ αιιαγή ηεο φςεο ηνπ ΢θεληθνχ. Ζ 

παιέηα Tools δηαηξείηαη ζε ηέζζεξα ηκήκαηα:  

 

 Ζ πεξηνρή εξγαιείσλ πεξηέρεη ζρεδίαζε, δσγξαθηθή θαη εξγαιεία επηινγήο.   

 Ζ πεξηνρή φςεο πεξηέρεη εξγαιεία γηα κεγέζπλζε ζην παξάζπξν εθαξκνγήο.   
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 Ζ πεξηνρή ρξσκάησλ πεξηέρεη κεηαηξνπείο γηα ρξσκαηηζκφ.   

 Ζ πεξηνρή επηινγψλ πεξηέρεη κεηαηξνπείο γηα ην επηιεγκέλν εξγαιείν, νη νπνίνη 

επεξεάδνπλ ηηο ιεηηνπξγίεο ηνπ εξγαιείνπ 

 

 

6.2.7.2 Υπήζη ηων παλεηών και ηος Property inspector  

 

Σν Flash πξνζθέξεη πνιινχο ηξφπνπο ψζηε ν ρψξνο εξγαζίαο λα πξνζαξκνζηεί 

ζηηο αλάγθεο ηνπ ρξήζηε. Υξεζηκνπνηψληαο ηηο παιέηεο θαη ηνλ Property inspector, 

κπνξεί θαλείο λα δεη, λα νξγαλψζεη θαη λα αιιάμεη ηηο ηδηφηεηέο ηνπ. Μπνξεί λα 

εκθαλίζεη, λα θξχςεη θαη λα επαλαηαμηλνκήζεη ηηο παιέηεο. Μπνξεί επίζεο λα 

νκαδνπνηήζεη παιέηεο ή λα δεκηνπξγήζεη ζχλνια παιεηψλ ψζηε ε δηαρείξηζε ηνπ 

ρψξνπ εξγαζίαο λα γίλεη επθνιφηεξε. Ο Property inspector αιιάδεη έηζη ψζηε λα 

απεηθνλίζεη ην εξγαιείν κε ην νπνίν εξγάδεηαη ν ρξήζηεο, παξέρνληαο γξήγνξε 

πξφζβαζε  ζηα ραξαθηεξηζηηθά γλσξίζκαηα πνπ ρξεζηκνπνηνχληαη ζπρλφηεξα.  

 

 

6.2.7.3 Property inspector  

 

Ο Property inspector απινπνηεί ηε δεκηνπξγία εγγξάθσλ κε λα θαηαζηήζεη 

εχθνιε ηελ πξφζβαζε ζηηο πην ζπρλά ρξεζηκνπνηνχκελεο ηδηφηεηεο ηεο ηξέρνπζαο 

επηινγήο, είηε ζην ΢θεληθφ είηε ζην Υξνλνδηάγξακκα. Μπνξεί θαλείο λα θάλεη αιιαγέο 

ζην αληηθείκελν ή ζηηο ηδηφηεηεο ηνπ εγγξάθνπ κε ηνλ Property inspector ρσξίο λα 

απεπζπλζεί ζηα κελνχ ή ζηηο παιέηεο πνπ πεξηέρνπλ απηά ηα ραξαθηεξηζηηθά. Αλάινγα 

κε απηφ πνπ επηιέγεηαη θάζε θνξά, ν Property inspector εκθαλίδεη πιεξνθνξίεο θαη 

ξπζκίζεηο γηα ην ηξέρνλ έγγξαθν, θείκελν, ζχκβνιν, κνξθή, bitmap αξρείν εηθφλαο, 

video, group, πιαίζην ή εξγαιείν. Όηαλ επηιέγνληαη δχν ή πεξηζζφηεξνη δηαθνξεηηθνί 

ηχπνη αληηθεηκέλσλ, ν Property inspector εκθαλίδεη ην ζπλνιηθφ αξηζκφ ησλ 

επηιεγκέλσλ αληηθεηκέλσλ.   
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6.2.7.4 Παλέηα Library  

 

Ζ παιέηα Library είλαη ην κέξνο φπνπ απνζεθεχνληαη θαη νξγαλψλνληαη ηα 

ζχκβνια πνπ δεκηνπξγνχληαη ζην Flash, θαζψο επίζεο θαη ηα εηζαγφκελα αξρεία φπσο 

bitmap αξρείσλ εηθφλαο, αξρεία ήρνπ, θαη video clips. Ζ παιέηα Library επηηξέπεη ηελ 

νξγάλσζε ησλ ζηνηρείσλ βηβιηνζήθεο ζε θαθέινπο, εκθαλίδεη ηε ζπρλφηεηα ρξήζεο 

ελφο ζηνηρείνπ κέζα ζε έλα έγγξαθν θαη ηαμηλνκεί ηα ζηνηρεία αλά ηχπν.   

 

 

6.2.7.5 Παλέηα Actions  

 

Ζ παιέηα Actions επηηξέπεη ηε δεκηνπξγία ελεξγεηψλ γηα έλα αληηθείκελν ή έλα 

πιαίζην. Ζ επηινγή ελφο πιαηζίνπ, θνπκπηνχ, ή movie clip ζηηγκηφηππνπ θαζηζηά ηελ 

παιέηα Actions ελεξγή. Ο ηίηινο ηεο παιέηαο Actions αιιάδεη ζε Button Actions, 

Movie Clip Actions ή Frame Actions, αλάινγα κε ην ηη επηιέγεηαη.   

 

 

6.3 Fireworks 

 

 

 

Σν Macromedia Fireworks είλαη ε θαιχηεξε επηινγή γηα επαγγεικαηηθή ζρεδίαζε 

θαη παξαγσγή γξαθηθψλ γηα δηαδηθηπαθέο εθαξκνγέο. Δίλαη ην πξψην πεξηβάιινλ πνπ 

εμεηάδεη θαη ιχλεη ηηο εηδηθέο πξνθιήζεηο πνπ κπνξεί θαλείο λα αληηκεησπίζεη θαηά ηελ 

δηάξθεηα ηεο ζρεδίαζεο θαη ηεο αλάπηπμεο ησλ γξαθηθψλ.  
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Μπνξνχκε λα ρξεζηκνπνηήζνπκε ην Fireworks  γηα λα δεκηνπξγήζνπκε, λα 

επεμεξγαζηνχκε, λα δψζνπκε θίλεζε ζε κία γξαθηθή παξάζηαζε, λα πξνζζέζνπκε 

πξνεγκέλε αιιειεπίδξαζε, θαη λα βειηηζηνπνηήζνπκε εηθφλεο ζε έλα επαγγεικαηηθφ 

πεξηβάιινλ. ΢ην Fireworks, κπνξνχκε λα δεκηνπξγήζνπκε θαη λα επεμεξγαζηνχκε  

δπαδηθά αξρεία εηθφλαο (bitmap) θαη δηαλπζκαηηθά (vector) γξαθηθά ζε κία εληαία 

εθαξκνγή. Σα πάληα είλαη επεμεξγάζηκα, ζπλερψο. Μπνξνχκε λα απηνκαηνπνηήζνπκε 

ηελ ξνή ησλ εξγαζηψλ γηα λα ηθαλνπνηήζνπκε ηηο απαηηήζεηο ησλ ρξνλνβφξσλ 

αλαπξνζαξκνγψλ θαη ησλ αιιαγψλ.  

 

Σν Fireworks ελζσκαηψλεηε κε άιια πξντφληα ηεο Macromedia φπσο ην 

Dreamweaver, ην Flash, ην FreeHand θαη ην  Director, θαζψο επίζεο θαη κε άιια 

πξνγξάκκαηα γξαθηθψλ εθαξκνγψλ θαη HTML ζπληάθηεο, γηα λα παξέρεη κηα 

πξαγκαηηθά ελζσκαησκέλε επηινγή γηα ηελ δεκηνπξγία δηαδηθηπαθψλ εθαξκνγψλ.  

Μπνξνχκε εχθνια λα εμάγνπκε απφ ην Fireworks γξαθηθά κε HTML θαη JavaScript 

θψδηθα πξνζαξκνζκέλν γηα ηνλ HTML ζπληάθηε πνπ ρξεζηκνπνηνχκε.  

 

6.3.1 Σο πεπιβάλλον επγαζίαρ ηος Fireworks 

Όηαλ αλνίγεηε έλα έγγξαθν ζην Fireworks γηα πξψηε θνξά, ελεξγνπνηείηαη ην 

πεξηβάιινλ εξγαζίαο ζπκπεξηιακβαλνκέλσλ ησλ Tools panel, Property inspector, 

menus, θαη άιισλ panels. Σν Tools panel, ζηα αξηζηεξά ηεο νζφλεο, πεξηέρεη 

νκαδνπνηεκέλεο θαηεγνξίεο, bitmap, vector, web, color θαη view. Ο Property inspector 

εκθαλίδεηαη θαηά κήθνο ηνπ θαηψηαηνπ ζεκείνπ ηνπ εγγξάθνπ εμ νξηζκνχ θαη αξρηθά 

επηδεηθλχεη ηηο ηδηφηεηεο ησλ εγγξάθσλ. ΢ηε ζπλέρεηα επηδεηθλχεη ηηο ηδηφηεηεο ησλ 

εξγαιείσλ ή ησλ αληηθεηκέλσλ πνπ επηιέγνπκε. Σα panels είλαη αξρηθά ηνπνζεηεκέλα 

ζε νκάδεο θαηά κήθνο ηεο δεμηάο πιεπξάο ηεο νζφλεο. Σν document window 

εκθαλίδεηαη ζην θέληξν ηεο εθαξκνγήο. 
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6.3.2 Υπηζιμοποιώνηαρ ηο Tools panel 

Σν Tools panel είλαη νξγαλσκέλν ζε έμη θαηεγνξίεο: Select, Bitmap, Vector, 

Web, Colors, θαη View, πεξηέρεη ζπλνιηθά 34 θνπκπηά. Κάπνηα απφ ηα θνπκπηά 

εκθαλίδνπλ ππν-κελνχ κε παξαιιαγέο ηνπ εξγαιείνπ.  Όηαλ επηιέγνπκε θάπνην 

εξγαιείν, ν Property inspector εκθαλίδεη ηηο επηινγέο ηνπ εξγαιείνπ. Κάπνηεο επηινγέο 

ησλ εξγαιείσλ παξακέλνπλ εκθαλήο ελψ εκείο ρξεζηκνπνηνχκε ην εξγαιείν. Γηα άιια 

εξγαιεία φπσο ην basic shape, ην Pen, θαη ην Line tool, ν Property inspector εκθαλίδεη 

ηηο ηδηφηεηεο ησλ επηιεγκέλσλ αληηθεηκέλσλ. 

 

 

 

 

 

 



 74 

 

 

 

 

 

 

 

 

6.3.2.1 Αλλαγή ηος καμβά (canvas) 

Όηαλ δεκηνπξγνχκε γηα πξψηε θνξά έλα έγγξαθν ζην Fireworks, πξέπεη λα 

θαζνξίζνπκε ηα ραξαθηεξηζηηθά ηνπ. Μπνξνχκε λα ηξνπνπνηήζνπκε ην κέγεζνο θαη ην 

ρξψκα ηνπ θακβά θαη λα αιιάμνπκε ηελ αλάιπζε ηεο νζφλεο ρξεζηκνπνηψληαο ην 

κελνχ Modify ή ηνλ Property inspector. ΢ην Fireworks είλαη εχθνιν λα αιιάμνπκε ην 

κέγεζνο, ην ρξψκα ηνπ θακβά θαη ηελ αλάιπζε κίαο εηθφλαο. Γηα λα αιιάμνπκε ην 

κέγεζνο ηνπ θακβά : 

 

1. Κάλνπκε έλα απφ ηα αθφινπζα : 

 Δπηιέγνπκε Modify > Canvas > Canvas Size. 

 Δπηιέγνπκε Select > Deselect, παηάκε ην Pointer tool γηα λα 

εκθαληζηνχλ ηα ραξαθηεξηζηηθά ηνπ έγγξαθνπ ζηνλ Property inspector, 

κεηά παηάκε ην θνπκπί Canvas Size. 

2. Δηζάγνπκε ηηο λέεο δηαζηάζεηο ηνπ πιάηνπο θαη ηνπ χςνπο. 

3. Παηάκε έλα θνπκπί  Anchor γηα λα δηεπθξηλίζνπκε πνηεο πιεπξέο ηνπ θακβά ζα 

πξνζηεζνχλ ή ζα δηαγξαθνχλ θαη παηάκε ΟΚ.  

 

Γηα λα αιιάμνπκε ην ρξψκα ηνπ θακβά κέζσ ηνπ κελνχ Modify : 

 

1. Δπηιέγνπκε Modify > Canvas > Canvas Color. 

2. Δπηιέγνπκε White, Transparent, ή Custom. Δάλ επηιέμνπκε Custom επηιέγνπκε 

έλα ρξψκα απφ ηελ παιέηα πνπ εκθαλίδεηαη. 
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Γηα λα επηιέμνπκε ην ρξψκα ηνπ θακβά απφ ηνλ Property inspector : 

 

1. Δπηιέγνπκε Select > Deselect, παηάκε ην Pointer tool Κάλνπκε έλα απφ ηα 

αθφινπζα: 

2. Δπηιέγνπκε έλα ρξψκα απφ ηελ παιέηα πνπ εκθαλίδεηαη ή δηαιέγνπκε ην 

εξγαιείν eyedropper κε ην νπνίν επηιέγνπκε ρξψκα απφ νπνηνδήπνηε ζεκείν 

ηεο. 

 

Γηα λα αιιάμνπκε ην κέγεζνο ηνπ εγγξάθνπ θαη ησλ πεξηερνκέλσλ ηνπ : 

 

1. Κάλνπκε έλα απφ ηα αθφινπζα: 

 Δπηιέγνπκε Select > Deselect, παηάκε ην Pointer tool γηα λα 

εκθαληζηνχλ ηα ραξαθηεξηζηηθά ηνπ έγγξαθνπ ζηνλ Property inspector, 

κεηά παηάκε ην θνπκπί Image Size ζηνλ Property inspector. 

 Δπηιέγνπκε Modify > Canvas > Image Size.  

 

Σν παξάζπξν δηαιφγνπ ηνπ Image Size αλνίγεη. 

 

 

 

 

 

2. Δηζάγνπκε ηηο νξηδφληηεο θαη θάζεηεο δηαζηάζεηο, ζηα text boxes ησλ pixel. 

Μπνξνχκε λα αιιάμνπκε ηελ κνλάδα κέηξεζεο.. Δάλ ην “Resample Image” δελ 
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είλαη επηιεγκέλν, κπνξνχκε λα αιιάμνπκε ηελ αλάιπζε ή ην “print size” αιιά 

φρη ηηο δηαζηάζεηο ησλ pixel. 

3. ΢ηα text boxes ηνπ Print Size, Δηζάγνπκε ηηο νξηδφληηεο θαη θάζεηεο δηαζηάζεηο 

πνπ ζα έρεη ε εηθφλα φηαλ ζα εθηππσζεί. 

4. ΢ην text box, ηνπ Resolution εηζάγνπκε ηελ αλάιπζε πνπ ζέινπκε λα έρεη ε 

εηθφλα. Μπνξνχκε λα επηιέμνπκε  αλάκεζα ζε pixels/inch θαη pixels/cm σο 

κνλάδεο, ή επηιέμηε ην ”Resample Image”. Ζ αιιαγή ηεο  αλάιπζεο αιιάδεη ηα 

pixel.  

5. Κάλνπκε έλα απφ ηα αθφινπζα: 

 Γηα λα δηαηεξήζνπκε ηελ ίδηα αλαινγία κεηαμχ ησλ νξηδφληησλ θαη 

θάζεησλ δηαζηάζεσλ ηνπ εγγξάθνπ, επηιέγνπκε “Constrain 

Proportions”.  

 Γηα λα αιιάμνπκε ηηο δηαζηάζεηο ηνπ πιάηνπο θαη ηνπ χςνπο 

αλεμάξηεηα ε επηινγή “Constrain Proportions” δελ πξέπεη λα είλαη 

επηιεγκέλε. 

6. Δπηιέγνπκε “Resample Image” γηα λα πξνζζέζνπκε ή λα αθαηξέζνπκε pixels 

φηαλ αλαπξνζαξκφδνπκε ην κέγεζνο ηεο εηθφλαο γηα λα πξνζεγγίζνπκε ηελ ίδηα 

εκθάληζε ζε δηαθνξεηηθφ κέγεζνο.  

7. Παηάκε OK. 
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6.4 Photoshop 

 

 

 

Σν πξφγξακκα PhotoShop ηεο εηαηξείαο Adobe είλαη έλα πνιχ δπλαηφ θαη 

δεκνθηιέο πξφγξακκα επεμεξγαζίαο εηθφλαο. Μαο επηηξέπεη λα ηξνπνπνηνχκε 

ζθαλαξηζκέλεο θσηνγξαθίεο, slides, θαη απζεληηθά έξγα ηέρλεο κε πνιινχο ηξφπνπο. 

Μπνξνχκε λα θάλνπκε πεξηζηξνθή, δηακφξθσζε ηνπ κεγέζνπο λα δεκηνπξγνχκε εηδηθέ 

εθέ θαη λα ρξεζηκνπνηνχκε κηα πιεζψξα θίιηξσλ. Σν Photoshop ζπλδπάδεη κία πιήξε 

γθάκα απφ εξγαιεία ζρεδίαζεο θαη επεμεξγαζίαο, πεξίπινθα εξγαιεία επηινγήο θαη 

κεζφδνπο γηα ηελ ξχζκηζε ησλ γθξη θαη ησλ ζπλερφκελσλ ηφλσλ κίαο εηθφλαο. ΢ην 

PhotoShop ηζρχεη ν θαλφλαο φηη πξέπεη πάληα λα θάλνπκε δνθηκέο θαη αλ δελ καο 

αξέζεη ην απνηέιεζκα ηεο επεμεξγαζίαο κηαο εηθφλαο, κπνξνχκε λα θάλνπκε αλαίξεζε 

ή λα κελ απνζεθεχζνπκε ηηο αιιαγέο. Αξρηθά θαηαζθεπάζηεθε γηα λα επεμεξγάδεηαη 

εηθφλεο νη νπνίεο ε βαζηθή ηνπο ρξήζε ζα ήηαλ ε ζε ραξηί εθηχπσζε, ζηελ πνξεία 

φκσο ην  Photoshop ρξεζηκνπνηείηαη κε απμαλφκελνπο ξπζκνχο γηα ηελ παξαγσγή 

εηθφλσλ γηα ηνλ δηαδίθηπν.  

Σν Photoshop έρεη επίζεο δπλαηέο δηαζπλδέζεηο κε ινγηζκηθφ  επεμεξγαζίαο 

πνιπκέζσλ θαη δεκηνπξγίαο animation. Λεηηνπξγεί κε ην  Adobe ImageReady, ην 
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Adobe Illustrator, ην Adobe Premiere, ην Adobe After Effects & Adobe Encore DVD. 

Οη ηχπνη αξρείσλ πνπ δεκηνπξγεί ην Photoshop είλαη PSD ή PDD θαη κπνξνχκε λα 

ηνπο ρξεζηκνπνηήζνπκε απφ θαη πξνο ην  Adobe ImageReady, ην Adobe Illustrator ,  ην 

Adobe Premiere , ην After Effects  θαη ην Adobe Encore DVD.  

 

6.4.1 Σι μποπούμε να κάνοςμε με ηο Photoshop  

 Γηνξζψλνπκε εηθφλεο κε “θησρά” ρξψκαηα θαη θαθφ θσηηζκφ.  

 Βειηηψλνπκε ηηο ιεπηνκέξεηεο θαη ηελ ζαθήλεηα ζε μεζσξηαζκέλεο εηθφλεο 

ή απνθαιχπηνπκε κέξε ηεο εηθφλαο πνπ δελ είλαη εκθαλή ιφγσ ζθηάο.  

 Αθαηξνχκε ηα "θφθθηλα κάηηα."  

 Γηνξζψλνπκε παιηέο θσηνγξαθίεο.  

 Γεκηνπξγνχκε ζχλζεηεο θσηνγξαθίεο.  

 ΢πλδπάδνπκε πνιιαπιέο θσηνγξαθίεο γηα λα δεκηνπξγήζνπκε κία 

παλνξακηθή θσηνγξαθία.  

 Μπνξνχκε εχθνια λα εθηππψζνπκε έλα θχιιν επαθψλ ην νπνίν λα πεξηέρεη 

φζν ην δπλαηφλ πεξηζζφηεξεο θσηνγξαθίεο.  

 Γεκηνπξγνχκε επαγγεικαηηθέο θάξηεο, επηθεθαιίδεο, ινγφηππα, θπιιάδηα, 

ελεκεξσηηθά δειηία, θαη αθίζεο ρξεζηκνπνηψληαο εηθφλεο θαη θείκελν.  

 Υξεζηκνπνηνχκε ελζσκαησκέλα θίιηξα γηα λα εθαξκφζνπκε δηάθνξα εθε 

ζηηο εηθφλεο θαη ζην θείκελν.  
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6.4.2 Δπγαλεία 

 

 

 

 

Κοςμπί Όνομα Δπγαλείος Δνέπγεια 

 
Rectangular 

Marquee 

Κάλνπκε κία νξζνγψληα επηινγή θαη κέζσ ηνπ ππν-κελνχ 

ηνπ, έρνπκε πξφζβαζε ζηα εμήο εξγαιεία  Elliptical 

Marquee, Single Row Marquee, and Single Column 

Marquee.  

 
Move  Μεηαθηλνχκε ηηο επηινγέο θαη ηα layers. 

 
Lasso  Μαο επηηξέπεη λα θάλνπκε ειεχζεξε ζρεδίαζε ηκεκάησλ 

θαη κέζσ ηνπ ππν-κελνχ ηνπ, έρνπκε πξφζβαζε ζηα 

εξγαιεία Polygonal θαη Magnetic Lasso.  

 
Magic Wand  Μπνξνχκε λα επηιέμνπκε κε αθξίβεηα κία ρξσκαηηζκέλε 

πεξηνρή ρσξίο λα επηζεκάλνπκε ηα φξηα.  

 
Crop  Μπνξνχκε λα εζηηάζνπκε ζε θάπνην ζπγθεθξηκέλν ηκήκα 

κηαο εηθφλαο θαη επηιέγνληαο ηκήκαηα απηήο ηεο εηθφλαο 
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λα αθαηξέζνπκε ηελ ππφινηπε. 

 
Slice  Μπνξνχκε λα δεκηνπξγήζνπκε ηκήκαηα έηζη ψζηε λα 

ρσξίζνπκε ην έγγξαθν καο ζε πεξηνρέο, ην νπνίν ην 

θαζηζηά πην ιεηηνπξγηθφ. Δπίζεο, έρνπκε πξφζβαζε ζην 

εξγαιείν Slice Select.  

 
Healing Brush  Γηνξζψλνπκε ηηο αηέιεηεο ζε κία εηθφλα θάλνληαο ηεο λα   

εμαθαληζηνχλ ζηα πεξηβάιινληα ηκήκαηα ηεο εηθφλαο. 

Δπίζεο, έρνπκε πξφζβαζε ζηα εξγαιεία Path θαη Color 

Replacement.  

 
Brush  Μπνξνχκε λα ρξσκαηίζνπκε επάλσ ζε κία εηθφλα θαη 

έρνπκε πξφζβαζε ζην εξγαιείν Pencil.  

 
Clone Stamp  Γεκηνπξγεί / ζρεδηάδεη ηνλ θιψλν κηαο εηθφλαο ή ηεο 

πεξηνρήο κηαο εηθφλαο ηελ νπνία έρνπκε ήδε επηιέμεη. 

Δπίζεο, έρνπκε πξφζβαζε ζην εξγαιείν Pattern Stamp.  

 
History Brush  Μπνξνχκε λα ρξσκαηίζνπκε ην αληίγξαθν ελφο 

ζηηγκηφηππνπ κηαο εηθφλαο κέζα ζην παξάζπξν ηεο 

ηξέρνπζαο εηθφλαο. Δπίζεο, καο παξέρεη πξφζβαζε ζην 

εξγαιείν Art History Brush.  

 
Eraser  ΢βήλνπκε pixels γηα λα απνθαηαζηήζνπκε ηελ εηθφλα, 

ζηελ πξνεγνχκελε απνζεθεπκέλε ηεο θαηάζηαζε.  

Δπίζεο, καο παξέρεη πξφζβαζε ζηα εξγαιεία Background 

Eraser θαη Magic Eraser.  

 
Gradient  Γεκηνπξγνχκε έλα βαζκηαίν ρξψκα κεηαμχ ησλ 

ρξσκάησλ θαη έρνπκε πξφζβαζε ζην εξγαιείν Paint 

Bucket.  

 
Blur  Ακβιχλεη ηηο άθξεο κηαο εηθφλαο. Αθφκε, καο παξέρεη  

πξφζβαζε ζηα εξγαιεία Sharpen θαη Smudge.  

 
Dodge  κπνξνχκε λα ζθνπξαίλνπκε ή λα θσηίδνπκε ηκήκαηα κηαο 

εηθφλαο. Αθφκε, έρνπκε πξφζβαζε ζηα εξγαιεία Burn θαη 

Sponge.  
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Path Selection  Κάλνπκε ζρεκαηηθέο επηινγέο ή επηινγέο ηκεκάησλ ηα 

νπνία δείρλνπλ ζεκεία anchor Makes shape or segment 

selections that show anchor points, γξακκέο θαηεχζπλζεο  

θαη ζεκεία θαηεχζπλζεο. Δπίζεο, καο δίλεη πξφζβαζε ζην 

εξγαιείν Direct Selection. 

 
Horizontal Type  Δηζάγνπκε θείκελν κέζα ζε κία εηθφλα. Δπίζεο, έρνπκε 

πξφζβαζε ζηα εξγαιεία Vertical Type, Horizontal Type 

Mask θαη Vertical Type Mask.  

 
Pen  Μπνξνχκε λα δεκηνπξγήζνπκε, λα επεμεξγαζηνχκε ή λα 

ιεηάλνπκε γξακκέο θαη ζρέδηα. Αθφκε, έρνπκε πξφζβαζε 

ζηα εξγαιεία Freeform Pen, Add Anchor Point, Delete 

Anchor Point θαη Convert Point.  

 
Rectangle  Μπνξνχκε λα ζρεδηάζνπκε δηάθνξα ζρήκαηα. Δπίζεο, 

έρνπκε πξφζβαζε ζηα έμεο εξγαιεία. Rounded Rectangle, 

Ellipse, Polygon, Line, θαη Custom Shape.  

 
Notes  Δηζάγνπκε ζεκεηψζεηο ζε θάζε εηθφλα θαη έρνπκε 

πξφζβαζε ζην εξγαιείν Audio Annotation.  

 
Eyedropper  Δπηιέγνπκε ρξψκα απφ θάπνην ζεκείν ηεο εηθφλαο σο 

ππφδεημε γηα έλα λέν ρξψκα ηνπ ππφβαζξνπ (background) 

ή ηνπ πξψηνπ πιάλνπ (foreground). Αθφκε, έρνπκε 

πξφζβαζε ζηα εξγαιεία Color Sampler θαη Measure.  

 
Hand  Μεηαθηλνχκε κία εηθφλα. 

 
Zoom  Απμάλνπκε ή κεηψλνπκε ην κέγεζνο πνπ βιέπνπκε κία 

εηθφλα. 
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6.4.3 Δπεξεπγαζία Κειμένος με ηο PhotoShop 

Σν PhotoShop είλαη ηδαληθφ γηα ηε δεκηνπξγία γξακκάησλ κεγάινπ κεγέζνπο κε 

εηδηθά εθέ. Όκσο, κεηά ηελ εηζαγσγή ηνπ θεηκέλνπ ζηελ εηθφλα, δελ κπνξνχκε λα 

ρξεζηκνπνηήζνπκε ην εξγαιείν θεηκέλνπ γηα λα ην επηιέμνπκε θαη λα ην δηνξζψζνπκε, 

φπσο γίλεηαη κε άιια πξνγξάκκαηα. Σα εξγαιεία θεηκέλνπ ηνπ PhotoShop είλαη 

ηέζζεξα : ην θαλνληθφ εξγαιείν θεηκέλνπ (Horizontal Type), ην εξγαιείν κάζθαο 

θεηκέλνπ (Horizontal Type Mask), θαη δχν αληίζηνηρα εξγαιεία γηα λα γξάςνπκε 

θαηαθφξπθν θείκελν (Vertical Type και Vertical Type Mask ). Με ην θαλνληθφ 

εξγαιείν θεηκέλνπ κπνξνχκε λα δεκηνπξγήζνπκε θείκελν κε ην ρξψκα πξνζθελίνπ ζε 

κηα λέα ζηξψζε. Με ηνλ ξννζηάηε Opacity ηεο παιέηαο Layers κπνξνχκε λα θάλνπκε 

ην θείκελν πεξηζζφηεξν ή ιηγφηεξν δηαθαλέο θαη κπνξνχκε λα ρξεζηκνπνηήζνπκε ηελ 

πηπζζφκελε ιίζηα ησλ θαηαζηάζεσλ αλάκημεο γηα λα αλακίμνπκε ην θείκελν κε ηηο 

ζηξψζεηο πνπ βξίζθνληαη απφ θάησ. 

 

Με ην εξγαιείν κάζθαο θεηκέλνπ, ην θείκελν δεκηνπξγείηαη ζαλ πεξίγξακκα 

επηινγήο, πνπ ιεηηνπξγεί παξφκνηα κ’ νπνηνδήπνηε άιιν εξγαιείν επηινγήο θαη 

κπνξνχκε λα ην ρξεζηκνπνηήζνπκε γηα λα πξνζζέζνπκε ή λα αθαηξέζνπκε ζηνηρεία 

απφ έλα ζπγθεθξηκέλν πεξίγξακκα επηινγήο. ΢’ έλα ππάξρνλ εξγαιείν επηινγήο, 

κπνξνχκε λα ρξεζηκνπνηήζνπκε ην πιήθηξν Shift θαη ην εξγαιείν κάζθαο θεηκέλνπ γηα 

λα πξνζζέζνπκε ζηελ ππάξρνπζα επηινγή πεξηγξάκκαηα κε ζρήκα ραξαθηήξσλ, ην 

πιήθηξν Alt γηα λα αθαηξέζνπκε απφ ηελ ππάξρνπζα επηινγή πεξηγξάκκαηα κε ζρήκα 

ραξαθηήξσλ θαη ηα πιήθηξα Shift+Alt γηα λα βξνχκε ηελ ηνκή αλάκεζα ζηελ επηινγή 

θεηκέλνπ θαη ζηελ ππάξρνπζα επηινγή. 

 

Αλ ζέινπκε ηα γξάκκαηα λα είλαη αδηαθαλή, ζα πξέπεη λα ρξεζηκνπνηήζνπκε ην 

θαλνληθφ εξγαιείν θεηκέλνπ, ελψ αλ ρξεζηκνπνηήζνπκε ην εξγαιείν κάζθαο θεηκέλνπ, 

ζα πξέπεη κεηά λα δψζνπκε ηελ εληνιή Stroke ηνπ κελνχ Edit γηα λα δεκηνπξγεζεί έλα 

πεξίγξακκα. Με ηα πιήθηξα Alt+Backspace κπνξνχκε λα γεκίζνπκε ην πεξίγξακκα 

επηινγήο θεηκέλνπ κε ην ρξψκα πξνζθελίνπ. 

 

Γελ ζα πξέπεη λα μερλάκε ηε βαζηθή δηαθνξά αλάκεζα ζηα δχν εξγαιεία 

δεκηνπξγίαο θεηκέλνπ : ην έλα δεκηνπξγεί πάλσ ζε λέα ζηξψζε ραξαθηήξεο κε ην 

ρξψκα πξνζθελίνπ, ελψ ην άιιν εκθαλίδεη απιψο έλα πεξίγξακκα επηινγήο κε ηε 
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κνξθή ραξαθηήξσλ. Δίλαη θαιή ηαθηηθή λα δεκηνπξγνχκε κηα λέα ζηξψζε πξηλ 

ρξεζηκνπνηήζνπκε ην εξγαιείν κάζθαο θεηκέλνπ. 

 

Αθνχ επηιέμνπκε έλα απφ ηα εξγαιεία εηζαγσγήο θεηκέλνπ θαη θάλνπκε θιηθ ζε 

θάπνην ζεκείν ηεο εηθφλαο, ην PhotoShop ζα ηνπνζεηήζεη ην θείκελν ζην ζεκείν φπνπ 

θάλακε θιηθ, αιιά πξψηα εκθαλίδεη ην πιαίζην δηαιφγνπ Type Tool, φπνπ κπνξνχκε 

λα γξάςνπκε ην θείκελν πνπ ζέινπκε θαη λα ην κνξθνπνηήζνπκε πξηλ ην εηζάγνπκε 

νξηζηηθά ζηελ εηθφλα. Αθνχ εηζάγνπκε ην θείκελν ζηελ εηθφλα, κπνξνχκε λα ην 

κεηαθηλήζνπκε κε ην εξγαιείν κεηαθίλεζεο ή κε ηα βειάθηα, φπσο ζα κεηαθηλνχζακε 

νπνηνδήπνηε άιιν αληηθείκελν ζε κηα ζηξψζε. Γηα λα κεηαθηλήζνπκε έλα πεξίγξακκα 

επηινγήο θεηκέλνπ πνπ ην δεκηνπξγήζακε κε ην εξγαιείν κάζθαο θεηκέλνπ, κπνξνχκε 

λα ρξεζηκνπνηήζνπκε ην εξγαιείν απηφ ή θάπνην απφ ηα εξγαιεία επηινγήο, αθνχ 

φκσο πξψηα ν δείθηεο ηνπ πνληηθηνχ πάξεη ην θαηάιιειν ζρήκα. Μπνξνχκε λα 

ρξεζηκνπνηήζνπκε θαη ηα βειάθηα. Αλ ζχξνπκε ην θείκελν κε ην εξγαιείν κεηαθίλεζεο 

θαη θξαηάκε ηαπηφρξνλα παηεκέλν θαη ην πιήθηξν Alt, ην θείκελν ζα θισλνπνηεζεί. 

Με ηα πιήθηξα Alt+Backspace κπνξνχκε λα γεκίζνπκε ην θείκελν κε ην ρξψκα 

πξνζθελίνπ θαη κε ηα πιήθηξα Control+Backspace κπνξνχκε λα γεκίζνπκε ην θείκελν 

κε ην ρξψκα παξαζθελίνπ. Γηα λα επεμεξγαζηνχκε έλα θείκελν πνπ έρνπκε ήδε εηζάγεη 

ζηελ εηθφλα, θάλνπκε πξψηα ελεξγή ηε ζηξψζε πνπ ην πεξηέρεη θαη θάλνπκε θιηθ πάλσ 

ηνπ γηα λα εκθαληζζεί ην πιαίζην δηαιφγνπ Type Tool. 

 

6.4.4 Σα Φίληπα (Filters) ηος PhotoShop 

Σα θίιηξα ηνπ PhotoShop θάλνπλ κηα ιεηηνπξγία αλάινγε κ’ απηή ησλ 

θσηνγξαθηθψλ θίιηξσλ : θηιηξάξνπλ ή δηαζινχλ ην θσο, κε απνηέιεζκα λα 

ηξνπνπνηνχλ ηελ εηθφλα. Όια ηα θίιηξα ηνπ PhotoShop βξίζθνληαη ζην κελνχ Filter 

θαη κπνξνχκε λα αθπξψζνπκε (αλαηξέζνπκε) ακέζσο ηε ρξήζε θάπνηνπ θίιηξνπ, αλ ην 

απνηέιεζκα δελ καο αξέζεη. Μπνξνχκε λα δνχκε πξνθαηαβνιηθά (ζε πξνεπηζθφπεζε) 

ηα απνηειέζκαηα ησλ πην βαζηθψλ θίιηξσλ θαη κπνξνχκε λα εθαξκφζνπκε πνιιά 

θίιηξα ζηε ζεηξά ή θαη λα ρξεζηκνπνηήζνπκε ην ίδην θίιηξν πνιιέο θνξέο. Όηαλ είλαη 

επηιεγκέλν θάπνην ηκήκα ηεο εηθφλαο, ην θίιηξν επηδξά κφλν ζηελ επηιεγκέλε 

πεξηνρή, ελψ φηαλ δελ είλαη επηιεγκέλν θάπνην ηκήκα ηεο εηθφλαο, ην θίιηξν επηδξά ζ’ 

νιφθιεξε ηελ εηθφλα. Γηα λα δεκηνπξγήζνπκε νκαιέο κεηαβάζεηο κεηαμχ ησλ 
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θηιηξαξηζκέλσλ θαη ησλ αθηιηξάξηζησλ πεξηνρψλ κηαο εηθφλαο, κπνξνχκε λα 

ζνιψζνπκε ην πεξίγξακκα επηινγήο κε ηελ εληνιή Feather ηνπ κελνχ Select. Γηα λα 

εθαξκφζνπκε μαλά ην ηειεπηαίν θίιηξν, κπνξνχκε λα επηιέμνπκε Last Filter απφ ην 

κελνχ Filter. Γηα λα αλακίμνπκε κηα θηιηξαξηζκέλε εηθφλα κε ηελ αθηιηξάξηζηε αξρηθή 

εηθφλα, κπνξνχκε λα ρξεζηκνπνηήζνπκε ηελ εληνιή Fade απφ ην κελνχ Filter. ΢ην 

πιαίζην δηαιφγνπ Fade κπνξνχκε λα ξπζκίζνπκε ηελ αδηαθάλεηα κε ηνλ ξννζηάηε 

(πιαίζην θεηκέλνπ) Opacity θαη ηνλ ηξφπν αλάκημεο απφ ηελ πηπζζφκελε ιίζηα Mode. 

Γηα λα βιέπνπκε ην απνηέιεζκα ηεο εθαξκνγήο ηνπ θίιηξνπ ζε πξνεπηζθφπεζε, πξέπεη 

λα είλαη επηιεγκέλν ην πιαίζην ειέγρνπ Preview. Ζ εληνιή απηή πξέπεη λα 

ρξεζηκνπνηείηαη ακέζσο κεηά ηελ εθαξκνγή ηνπ θίιηξνπ. Πξέπεη λα έρνπκε ππφςε καο 

φηη ε πξαγκαηηθή νκνξθηά ησλ θίιηξσλ ηνπ PhotoShop βξίζθεηαη ζηνλ ζπλδπαζκφ θαη 

ηελ εθαξκνγή ηνπο ζε κηθξά, επηιεγκέλα ηκήκαηα ηεο εηθφλαο. 
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7. ΠΔΡΙΓΡΑΦΗ ΔΦΑΡΜΟΓΗ΢ 

 

7.1 Κενηπική ΢ελίδα. 

΢ην επάλσ κέξνο ηεο θεληξηθήο ζειίδαο ππάξρεη έλα animation θαηαζθεπαζκέλν 

κε ηε βνήζεηα ηνπ πξνγξάκκαηνο Macromedia Flash MX 2004 πνπ πεξηέρεη ην 

ινγφηππν ηεο εηαηξείαο. Κάλνληαο θιηθ ζηε ιέμε “Αξρηθή ΢ειίδα” ν ρξήζηεο ζα 

κεηαθέξεηαη πάληα ζηελ θεληξηθή ζειίδα, απφ νπνηαδήπνηε ηνπνζεζία ηνπ δηθηπαθνχ 

ηφπνπ. Ζ θεληξηθή ζειίδα πεξηέρεη ηνπο θχξηνπο ζπλδέζκνπο ηνπ δηθηπαθνχ ηφπνπ πνπ 

είλαη νη εμήο:  

 

1. Ηζηνξηθφ 

2. Τπεξεζίεο 

3. ΢χλδεζκνη 

4. Πιεξνθνξίεο 

 

Οη θχξηνη ζχλδεζκνη δεκηνπξγεζήθαλ κε ηε βνήζεηα ηνπ πξνγξάκκαηνο 

Macromedia Flash MX 2004 γηα ηελ εχθνιε θαη γξήγνξε πξφζβαζε ζηα πεξηερφκελα 

ηνπ δηθηπαθνχ ηφπνπ. ΢ην θεληξηθφ ηκήκα ηεο ζειίδαο ππάξρεη έλα αθφκε animation 

θαηαζθεπαζκέλν κε ηε βνήζεηα ηνπ Macromedia Flash MX 2004 κε ζθνπφ λα 

εκπινπηίζεη αηζζεηηθά ηνλ δηθηπαθφ ηφπν. 
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7.2 Ιζηοπικό 

 

Δπηιέγνληαο ηνλ ζχλδεζκν “Ηζηνξηθφ” κεηαθεξφκαζηε ζηε  αληίζηνηρε ζειίδα 

φπνπ παξαζέηνληαη πιεξνθνξίεο ζρεηηθά κε ηελ εηαηξεία. 
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7.3 Τπηπεζίερ. 

 

Δπηιέγνληαο ηνλ ζχλδεζκν “Τπεξεζίεο” κεηαθεξφκαζηε ζηε  αληίζηνηρε ζειίδα 

φπνπ παξαζέηνληαη νη ππεξεζίεο πνπ πξνζθέξεη ε εηαηξεία. 
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7.4 ΢ύνδεζμοι. 

 

Δπηιέγνληαο ηνλ ζχλδεζκν “΢χλδεζκνη” κεηαθεξφκαζηε ζηε  αληίζηνηρε ζειίδα 

φπνπ παξαζέηνληαη δηάθνξνη ρξήζηκνη ζχλδεζκνη. Ο ρξήζηεο κε έλα “θιηθ“ κπνξεί λα 

κεηαθεξζεί άκεζα ζε έλαλ απφ ηνπο πεξηερφκελνπο ζπλδέζκνπο. 
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7.5 Πληποθοπίερ. 

Δπηιέγνληαο ηνλ ζχλδεζκν “Πιεξνθνξίεο” κεηαθεξφκαζηε ζηε  αληίζηνηρε 

ζειίδα φπνπ παξαζέηνληαη ηα ζηνηρεία ηεο εηαηξείαο πξνθεηκέλνπ λα επηθνηλσλήζεη ν 

ρξήζηεο κε απηήλ. 
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